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Congratulations on your purchase of the Bushnell® Compact Instant Replay™! The Compact
Instant Replay is ideal for all sporting events and nature observation, as it combines a high
quality 8 power compact binocular with a versatile 3.2 megapixel digital camera featuring
amazing video capability. The Compact Instant Replay has a “dual personality”, capable of
taking high resolution digital still photos as well as shooting video clips that automatically
“loop”, or refresh, every 8 to 60 seconds (depending on quality settings). This ensures that
you will always capture the peak of the action. The photos and videos are both automatically
stored in the internal memory, or on an optional SD (Secure Digital) card, and can be
instantly reviewed on the flip-up LCD, played back on a TV set, or downloaded to your
computer without the need to install any special software (With Windows 2000, XP or Mac.
Software is provided for Windows 98/98SE).

Before using your new Compact Instant Replay, please read the instructions contained in
this manual and take time to familiarize yourself with the camera’s operation and many great
features.

QUICK GUIDE: BUSHNELL COMPACT INSTANT REPLAY 11-8323
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Install Batteries
& (optional) SD
Card

Insert 2 AAA batteries (see “Specifications”) into the battery compartment on the bottom of the camera
pod (Note polarity indication inside). An SD memory card (optional) for increased photo storage capac-
ity may also be installed in the card slot, located at the back of the camera pod (Pull the rubber card slot
cover down. Insert card with label side facing down until it clicks, and replace the rubber cover).

Turn On the

Camera

Raise the LCD display, using the tab at the rear. Press and release the POWER button. The display
start screen will flash on, then go out, and the red power LED stays on. Press “LCD/Mode” to turn the
display back on -you will see a “live” preview of the image from the camera lens, located between the
binocular objective lenses. The display will automatically turn off after 2 minutes to conserve battery
power when the camera is inactive. You can also manually turn the display off by pressing the LCD/
Mode button-it does not need to be on to take a photo. The entire camera will automatically turn off
after 5 minutes if it has been inactive (no buttons pressed). To turn power off manually, press and release
the POWER button. The default camera settings will provide optimum quality under most conditions.
However, we recommend reading the fill manual to take advantage of the many available options available
in the various menus for different photographic situations and personal preferences.

Format the SD
Card (optional)

If you inserted an SD card earlier, format it before using the camera. Press the Menu/OK button in the
center of the silver keypad. Press the Down arrow key 4 times to select “Format”. Press the Right arrow
key, then Left arrow key to select “Yes”. Press Menu/OK, you will see a warning that all images will be
deleted, select “Yes” and press OK again. Use the Down arrow key to select “Exit” and press OK.

Set the
Binocular
Optics for Your
Eyes

Roll down the rubber eyecups if you are wearing glasses. Adjust the spacing between the left and right
binocular tubes while looking through the binocular until the view appears as a single circular image.
Then, find a distant object with fine detail, and adjust the center focus knob until the object appears
sharp through the left eyepiece . Now look through the right eyepiece only. If the object does not ap-
pear equally sharp, rotate the right eyepiece (diopter adjustment) until it is also sharp. Once set, you no
longer need to move this diopter adjustment, and may simply focus using the center focus knob.
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QUICK GUIDE: BUSHNELL COMPACT INSTANT REPLAY 11-8323
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Take A Photo
or Shoot A
Video Clip

Hold the camera steady with both hands and press the SNAP button to take a still photo. You will hear
a “beep” (this can be turned off), followed by a brief pause (file icon displayed) as the camera stores the
photo in memory. To shoot a video, press Menu/OK once, then the Right arrow key, to see the Camera
menu video options. Use the Up & Down keys to select either Replay (loop) or Normal (continuous)
video, then press Menu/OK. You will be back to the live preview display, and can start shooting the
video at any time by pressing SNAP. To stop recording video, press SNAP again. Please read the section
“Video Modes” for a detailed explanation of how Normal and Replay video modes differ, including how the
video recording time is determined.

Review and
Delete Photos/
Videos

To review or playback a still photo or video, press the LCD/Mode button (press twice if the display was
not already active). You will see the most recent still photo or video (first frame). To review previous
photos or videos one at a time, press the Left arrow key. The icon at the bottom right corner of the
display will indicate whether the current review file is a still photo, normal or “instant replay” video.
The numbers above this icon show the current file number/total files (2 of 3, etc). To play back a stored
video, press the Down arrow key (press again to stop playback). To see “thumbnail” images of several
stored photos/videos at once, press the Up arrow key after entering review mode. Use the arrow keys to
select an individual file, then press up again to see it full frame. To delete a photos/videos, press Menu/
OK, then the Down arrow once (Trash icon). Press the Right arrow key, select Delete One or Delete All,
then press the Right key and select Yes. Go back to the Menu column, select Exit and press Menu/OK
to return to the Review display.

Connect To
A Computer
& Transfer
Photos

Before connecting the camera, install the driver from the CD-ROM if you use Windows 98/98SE, and
install PhotoSuite if you do not already have photo editing software. Connect the supplied USB cable
from the camera’s USB socket (on the back of the camera pod) to a USB port on your PC. If you have
Windows XP, just follow the onscreen directions/options that automatically appear. If you have Win
98 or 2000, open “My Computer” on your PC. The camera is identified as a “Removable Disk” -your
photos are in the folders inside, simply drag them or copy/paste into any folder on your hard drive. Refer
to the “Transferring Photos” section of this manual.
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Technical Specifications

Magnification 8x Still Photo File Size (Resolution) 2048x1536, 1600x1200, 640x480
Objective 30mm File Compression Ratio (Quality) | 1:4 (FQ), 1:8 (NQ), 1:16 (EQ)

Diameter

Exit Pupil 3.75 Internal Memory 16MB Flash Memory

Field of View 320 ft @ 1000 yds Memory Expansion Secure Digital Card , up to 1 GB capacity
Eye Relief 13mm File Format (Still/Video) JPEG /MJPEG (AVI)

Lens Coating

Fully Coated

File Management

DCEF (version 1.0), FAT 16 Format

Prism Type

Roof, BK-7

LCD

1.5” TFT, 120,480 pixels

Focusing Range
(binocular)

18’ ~ infinity

Video Resolution/Frame Rate

620x480 or 320x240 pixels per frame / 30 or 15 fps. Replay
mode loop length: 8/15/30/60 seconds (per resolution/fps

selected)

Weight 14.3 02/ 406.5 g Video Out NTSC/PAL, via 8-pin USB port with special cable (included)
Sensor Type CMOS Exposure Value Range +/-2 EVin 0.5 EV steps
Effective Pixels 3.2 Megapixels White Balance Options Auto, Daylight, Cloudy, Fluorescent, Incandescent

Color

24-bit color

Preset Scenes

Program, Sports, Landscape, Portrait, Night

Shutter

Electronic, 1/16 to
1/1000 seconds

Menu Languages

English, Spanish, French, German, Italian, Portuguese, Japanese

Focusing Range
(camera)

Fixed, approx 60” ~
infinity

Auto Power Off (after inactivity)

LCD Display: 2 Min. / All Power Off: 5 Min.

Lens Aperture

f/5.6

Power Supply

2xAAA Batteries, Alkaline/Lithium/NiMh type
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Parts Identification

LCD Display

Power
Button

LCD/Mode Button

5-way Keypad w/
Menu/OK Button

Center
Focus

Knob

& (Binocular)

Snap
Button

LCD Preview Display lcons

DEE ORE

Still Photo Preview Display

Normal Video _Replay Video

Movie (Video)Display

USB Port/
Video Out Power
Beeper

SD Card Slot

# | Icon # | Icon

1 | Battery Indicator (2/3 power shown) 1 | Battery Indicator (full)

2 | # of Photos Remaining (based on available memory) 2 | Total Seconds of Video

3 | Still Photo Mode Ava_ilable (based on
available memory)

4 | Quality (File Compression) Fine/Normal/Economy 3 | Movie Mode

5 | Resolution (File Size) Large/MediumiSmall 4 | Resolution (FQ-620+480/

6 | White Balance Not displayed unless changed from default “Auso” in Exposure NQ=320x240)

7 | Scene Not displayed unless changed from default “Program” in Mode menx 5 | Frame Rate (30 or 15 fps)

8 | Sequence Shooting Mode Nor displayed unles selected in Mode mens
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Turn the Compact Instant Replay over, and slide open the battery cover in the
direction as shown on the right. Insert 2 AAA Alkaline or Lithium batteries into
the compartment in the direction indicated by the diagrams inside, then slide the
battery cover back in place until it clicks. Note: Rechargeable NiMh type batteries
may also be used, but some models may not deliver adequate current to power
the Instant Replay. NiMb batteries with a current rating of 2300 mAh or higher
are recommended.

Inserting An SD Card

The camera can store from about 15 up to 642 photos in the 16 MB internal
memory, depending on resolution and quality settings (refer to the chart at the back
of this manual). To expand the available storage, you may add an optional Secure
Digital (SD) type memory card, with any capacity up to 1 GB. The card is inserted
into the slot on the back of the camera pod, as shown in the last diagram. Insert
the SD card with the label side facing down. Note: be sure the power is turned off
before inserting or removing cards to prevent possible loss of files or damage to the
card. A new card will not require formatting, but a card that has been previously used
in other devices should be formatted by the Compact Instant Replay before storing
photos on it (See “Setup Menu” in the following section). Note that this will erase all
files previously stored on the card, so be sure they have been downloaded or copied

first if you wish to keep them.
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Battery Compartment
Cover

Card Slot
(lift cover)

Basic Binocular and Camera Setup

Before taking photos or videos, take a few moments to set up the Compact Instant Replay for your individual eyesight and user prefer-
ences. Leave the rubber eyecups in their “up”position if you are not wearing glasses, or roll them down if you are. Grasp the left and
right sides of the binocular, and pull them apart or push them together while looking through the binocular to adjust the eyepiece
spacing until your view is a single circular image. Find a distant object with fine detail (tree, sign, brick wall, etc), and adjust the center
focus knob until the object appears sharp when viewed through the left binocular eyepiece only. Then, looking at the same object
through just the right side of the binocular, simply rotate the right eyepiece until the image is equally sharp for your right eye. This is
called the diopter adjustment, and compensates for any difference in sight between your left and right eyes. Once set by following this
initial procedure, you may leave the diopter adjustment alone and just use the center focus knob to bring objects at any distance into
sharp focus through the binoculars (the minimum focus distance is about 16 feet).

Your digital photos and videos are not affected by the center focus knob, as the camera lens located between the binocular objective
lenses does not require focusing. It is preset so that objects ranging from approximately 60 feet to infinity will be in focus. Note that
the binocular is capable of focusing closer than the camera. Check the live preview image on the LCD display to make sure you are
far enough away to ensure sharp photos. The camera lens provides 8x magnification, which is the same as the binocular’s optics, and is
aligned so that and object centered in the binocular’s view will also be centered in your photos or videos. Therefore, it is not necessary
to have the LCD turned on or even raised while you are shooting photos or videos. Reducing use of the LCD will extend battery life
significantly.

You may want to go into the camera’s menu and set the correct date before using the camera for the first time. Raise the LCD display
and press the power button. After the red power light is on, press LCD/Mode to turn on the display. Press the Menu/OK button in
the center of the keypad, then press the Down arrow 3 times to get to the “Setup” menu. Press the Right arrow once, followed by the
Down arrow to get to “Date”. Then press the Right arrow key twice to enter the Date setup. Use the Left/Right arrow keys to select the
part of the date you want to change, then press Up or Down to change it. To change the date format so Month, Day, and Year are in the
desired order, move to the “arrows” icon on the upper left of the date display and press the Up/Down keys. Set the time (24 hr format)
with the 4 numbers at the bottom of the date display, so that the date will automatically change at midnight for your location. Once
date & time are set, press the Menu/OK button once, then again to save your setting and exit. You can then press the Down arrow key
and chose whether you want the date to appear on the display and your photos or not (“Show Date On/Off”). Then keep pressing the
Left arrow until you are back to “Setup”, move down to “Exit” and press Menu/OK. 9
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Taking Still Photos

After following the initial setup as described in the previous pages, you are ready to take a photo:

1) Raise the LCD and press the Power button briefly (red LED lights). Press the LCD/Mode button to turn on the LCD display if you
want to see a preview of the image or check menu settings, battery condition, etc.

2) The Compact Instant Replay will default to the highest resolution and quality settings, as well as “everything on automatic” when
it is turned on for the first time, so you can take excellent photos right away. If you prefer to use different settings, refer to the section
“Using the Main Menu” for directions regarding how to find and change settings such as resolution and exposure, using scene presets
for common subjects and other options.

3)You may compose your photo while looking through the binocular (the LCD does not need to be on to take a photo). However, for
the most accurate framing, checking the LCD preview is recommended.

4) Be sure you are not closer than approximately 60 feet from your subject. The binocular optics will focus closer than this, but the
camera focus is preset for best results with distant subjects (no focusing is necessary for the camera). The LCD may be used to verify
that the subject is not too close for sharp results.

5) Hold the camera as steady as possible with both hands and slowly squeeze the SNAP button. The display will go dark briefly while
the file is stored (folder icon is displayed), then you are ready to take another photo. The counter in the lower right corner will change
to display the remaining photo capacity, which depends on the amount of internal or card memory available, as well as the resolution
and quality settings (you may switch to lower settings at any time to “fit” more photos in the remaining memory). Note: the counter
will not always go down by one number afier each photo is taken, depending on these settings and actual file content per photo. When the
counter reaches “000”, you are out of memory (storage space) and should download photos you wish to keep so they may be deleted, or you may
remove and install another SD card.

6) Digital zoom up to 6x is available. Press the Right arrow key to zoom in (you will see the result on the LCD). Press the Left arrow
key to zoom back out.

7) Press the LCD/Mode button if you wish to check the photo after you take it, then press it again to return to a live preview. See the
section “Review Menu” for more regarding reviewing and deleting previously taken photos.
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Shooting Normal or “Instant Replay” Videos

1) Follow steps 1-4 on the previous page, “Taking Still Photos”

2) To change from still photo to either video mode, press the Menu/OK button. The first menu group is “Camera”-press the Right ar-
row key, the use the Up or Down arrow keys to select Normal or Replay video mode (the camera will return to the live preview display
after selecting a video mode, so you are ready to shoot immediately. In either mode, press SNAP to start recording a new video clip, and
press it again to stop recording and store the video in memory. Here is how the two video modes differ:

Normal video mode will simply shoot a continuous video clip beginning when you press the Snap button, and ending when you press
it again. The recording time is limited only by the amount of internal or card memory currently available. You may record a single long
video until you run out of memory, or multiple shorter videos by stopping and starting recording whenever you wish by pressing Snap.
The counter shows the aproximate available remaining recording time (in seconds) when stopped, and counts down the remaining
time when a Normal video recording is started.

Replay video mode operates differently-at the end of a predetermined time limit (determined by the video resolution and frame rate
set in the Setup menu), the video clip begins to “loop”, or re-record, erasing and replacing the previous events. This is ideal for captur-
ing sports action, as you may begin recording at anytime, then just stop recording right after a touchdown, goal or other highlight.
You'll be sure you got the peak moment, and won't have to search through a lot of previous video or keep rewinding to see it again and
again. The available loop lengths are 8, 15, 30 or 60 seconds-the higher the resolution and frames per second, the shorter the loop. In
Replay mode, the counter shows available total recording time (in seconds) when stopped, and counts up from zero to the end of the
loop time limit when recording starts. At the end of the loop, when re-recording begins, the counter automatically resets and starts
over at zero again. Note that if you stop recording part way through a “fresh” loop, your video will contain the last part of the previous
loop segment and the first part of the new one- the camera always saves a full 8, 15, 30 or 60 seconds worth of the most recent events.
Practice a little and experiment with the replay mode to get the feel of how this works before you go to the big game.

3) Press the LCD/Mode button if you wish to check a video after you shoot it. Press the Down arrow key to begin playback, press it
again to stop playback. Press the Left or Right arrow keys to review your previous video or still photo files. Pressing the top arrow key
will display a “thumbnail” review of multiple files-use the arrow keys to highlight the file you wish to review, then press Menu/OK
to select and view it. When you are ready to return to the live preview display to shoot more videos (or stills), press the LCD/Mode
button.

4) See the section “Review Menu” for more regarding reviewing and deleting previously taken videos.

11
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Using The Main Menu

As mentioned earlier in this manual, the Compact Instant Replay is already set for its highest available resolution and
quality right out of the box. Exposure, white balance, and other variables are set automaticallly. This means that you
will get good results for most subjects and lighting without the need to go into the menus and change any settings.
However, we recommend that you become familiar with the available options so that you can improve your photos
if, for example, you decide they are coming out too dark (common for snow scenes with most cameras), or too green
(under some fluorescent lights). The main, or recording, menu is organized into six groups. Press the “Menu/OK”
button to see these groups. Use the up and down arrow buttons to select a group, then use the Right arrow key and
Up/Down keys to see the items or options that are available within the group. Here is a general description of the
menu groups and their functions:

Using The Main Menu continved

Menu Group | Icon Purpose

Provides options for setting: Resolution (file size), Quality (file compression),
EV (exposure value), WB (white balance), and ISO (light sensitivity).

Setup @

Menu Group | Icon Purpose

Prepares a new or previously used SD memory card for use. Erases (deletes)
all files contained on the card. Can also be used to quickly delete all internal
memory contents if an SD card has not been inserted.

Format —
(]
Exit @l

Exits the main menu and returns to the live preview image.

Allows you to select still photo or one of two video (movie) modes of opera-
| n tion. The menu options here always show the two modes that are not currently
: being used. For example, if you are already in “Replay” video mode, the other
@ options will be displayed in the Camera menu: Still Photo mode (camera icon)

or Normal Video mode (movie camera w/straight arrow icon).

Camera Mode

Exposure [ Provides options for setting WB (White Balance) and EV (Exposure Value) to
| | ,l fine tune color rendition and exposure for different conditions if the standard
automatic settings do not produce the desired quality or results.

Mode il Allows choice of preset “Scenes” which optimize camera settings for sports ac-
ey tion, landscape and other common photo subjects. Self Timer and Rapid Se-
quence still photo options are also provided in this menu group.

12

The next few pages provide a complete list of all the items and settings available in the Main Menu groups, along with

descriptions of their function. Follow the same procedures you used in the example above to move around in the menu

screens to highlight and change any of these settings to suit your personal preferences or needs. The Review menu is

different, but simpler, with only four groups (Slide Show, Delete, Editor, and Exit). See the “Review Menu” section
p y group:

later in this manual for a complete description.

13
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Main Menu System (Dcfault Scttings in Bold)

*Scene and Sequence settings in “Mode” are not available when “Camera” is set for Normal or Replay Video

Main Menu System continved

Group Settings Description
CAMERA Still Photo Camera Icon Photographs 3.2 megapixel still frames
Video Clip Normal Video Shoots standard continuous video, with time limited only by avail-
(Movie icon w/ able remaining internal or SD card memory
straight arrow)
Replay Video (Movie | Shoots video “loops”, rerecording over earlier video. Loops are fixed
icon w/circling length (from 8 to 60 seconds), as determined by video resolution
arrow and frame rate (FPS).
EXPOSURE WB (White Auto White Balance is automatically set for correct color reproduction
Balance)
Daylight Manual setting for outdoor sunny conditions
Light Bulb Manual setting for indoor tungsten (light bulb) lighting
Fluorescent Manual setting for indoor fluorescent lighting
Cloudy Manual setting for outdoor overcast or shade conditions
EV -2.0 - +2.0 Provides manual under/over exposure adjustment in 0.5 EV steps.

Minus values produce darker photos, plus values lighter.
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Group | Item Settings Description
MODE Scene * Program Standard auto exposure for most subjects or general purpose
Sports Uses higher shutter speeds to help freeze motion
Landscape Deeper zone of focus for extended sharpness from foreground to background
Portrait Shallow zone of focus for photos of people-helps isolate subject from background
Night Uses lower shutter speeds for better low light exposures
Self Timer Yes / No Photo taken after a delay time when Snap button is pressed
Sequence * 3 or 5 Shot 3 or 5 frames taken in rapid sequence when Snap is pressed
SETUP Size/ Image Size 3 options for image size: L(2048x1536 pixels), M (1600x1200 pixels), or S (640x480 pixels)
Quality (Resolution) Higher resolution settings produce sharper/larger prints but reduce total storage space available.
(Still Photo) Use lower settings to store more in memory, or for email,etc. L=3.1MP / M=2.1MP / $=0.35MP
Quality Sets amount of jpg file compression. Settings are: Fine-FQ (1:4 compression), Normal-NQ (1:8)
(File Compres- and Economy-EQ (1:16). This can be used independently of Image Size to help store more photos
sion Ratio) in exchange for slightly reduced quality.
In Normal Quality 640x480 pixels per frame (Resolution)> at 30 or 15 frames per second (Frame Rate)
Video Mode (Resolution 320x240 pixels per frame >at 30 or 15 frames per second
only & FPS (Afier selecting resolution, press Right arrow key to select frame rate (fps))
In Replay Video | Quality 640x480 pixels per frame (Resolution)> at 30 or 15 frames per second (Frame Rate)
Mode only (Resolution 320x240 pixels per frame >at 30 or 15 frames per second
& FPS 8, 15, 30 or 60 seconds loop duration dependant on resolution/fps

Download from Www.Somanuals.com. All Manuals Search And Download.
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Main Menvu System continved

Group Item Settings Description
Date Setup, Allows setting the correct date/time for your area. If “On” is selected, the date
On/Off will appear on the display and be imprinted on all photos.
Storage Auto Files are stored on SD card if inserted, internal RAM if not
SD Files are stored on the SD card only (must be inserted)
Internal Files are stored in internal memory only, never on card
Language 7 available Selects preferred language for all menu display screens
Rec View Off/1-3 sec Selects time limit of automatic review display after photo is taken
File Name Reset/Series Sets file numbering system. If Reset is selected, after all files in internal or card
memory are deleted, file numbers for new photos will start over at “000”. If
Series is selected, the file numbers for new photos will resume at the next number
after the last number used for previous files.
Beep On / Off Turns beep alert sound on or off
Reset All Yes / No Selecting “Yes” restores all settings to original defaults (shown in Bold)
FORMAT | Format Yes / No Formats card for Compact Instant Replay files. Erases all contents.
EXIT Exits menu system and returns to live preview
16

Review Display Icons

# | Icon

Date of photo or video file (Date feature must be setup and turned on)

Location of current review file (INternal memory or $D Card)

Resolution of current review file

Quality (File Compression) of current review file

Current file number (left numeral) : Total files in memory (right numeral)

Indicates file type (Still Photo, Normal Video, Replay Video)

Bl RN R VS RUCR [INEY

Battery Indicator

Review Menu

Reviewing and Deleting Your Photos and Videos

Press “LCD/Mode” to enter Review mode. Use the Left/Right arrow buttons to cycle through the stored photos/vid-
eos. Once you are in review mode , pressing the Menu/OK button will enter the review set of menus. These operate
in the same way previously described in the main menu system instructions (use the arrow keypad to navigate to the
desired menu group and options, press OK to confirm a setting), but with different menu items as shown here:

Group Item Settings | Description

SLIDE Yes / No | Selecting “Yes” will begin to show a review of all images currently

SHOW in the internal or card memory, automatically changing to the next
image every few seconds.

17

Download from Www.Somanuals.com. All Manuals Search And Download.



Review Menus continved

Group Item Setting Description
DELETE Delete Yes / No Deletes the currently displayed photo or video from memory. Use
One Up/Down arrows to find the file you want to delete. To delete, high-
light the “Delete One” icon and press “OK”. Then highlight “Yes”
and press “OK” to delete the file.
Delete Yes / No Deletes all stored files. To delete all files, (except locked-see below)
All highlight the “Delete All” icon and press “OK”. Then highlight
“Yes” and press “OK” to delete all files currently in memory.
EDITOR Protect Lock / Locking a photo or video file prevents accidental erasure. Can be
Unlock used together with “Delete All” to quickly delete all but one or two
photos. To lock the currently displayed photo or video, highlight
the “Lock” icon and press “OK”. To unlock a previously locked file,
select it using the Up/Down arrows, highlight the “Lock” icon again,
and press “OK”.
Rotate -90 Degree Rotates view of the current image by 90 degrees in cither direction.
or +90
Degree
EXIT Exit Exits the review menu and returns to the last selected review image.
18

System Requirements (Minimum)

OS: Windows® 98/98SE/2000/ME/XP

CPU: MMX Pentium® 200MHZ equivalent or faster (Pentium® III 500 MHz for PhotoSuite5™)
Memory: 32MB minimum (64MB recommended for PhotoSuite)

SVGA video card w/2MB VRAM, 800x600 screen display, 16 bit High color

200 MB available hard disk space (if installing PhotoSuite)

Internal USB Port

Software Installation

If you are using Windows 98, you must install drivers before connecting the camera to your PC. Insert the CD-ROM
into your computer’s CD drive; it will auto-run and the install screen will be displayed. Select “Install Driver”, then
follow the directions. After installation, restart your computer. Windows 2000, ME, and XP do not require drivers,
as the camera uses the USB mass storage standard , allowing the photo files to be accessed as if they were stored on
an external hard drive. For any Windows OS, if you are not already using photo editing software you prefer, you may
install Roxio PhotoSuite® from the CD-ROM. Be sure to read the “Release Notes” completely, noting any tips or
potential issues relevant to your PC configuration and OS.

Transferring The Photos & Videos to Your PC - Step by Step
1. Be sure the driver has been installed first if you are on Windows 98/98SE.
2. Make sure the Instant Replay power is on and connect the supplied cable to the camera’s USB port (open the
connector cover on the left side of the Replay), then directly to a main USB port on your computer-do not use front
panel/keyboard USB ports or unpowered “hubs”.
3. The LCD display will turn off to conserve battery power, and the Instant Replay will be recognized as a standard
“USB Mass Storage” device. This means that the camera files can be easily viewed, edited, or copied to your hard
drive, just as if they were stored on an external hard drive or a CD-ROM.

19
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Transferring The Photos & Videos to Your PC continved

4. (This step is not required with Windows XP, simply use the on-screen options to view, copy or edit your photos).
Open My Computer or Windows Explorer. The camera will be seen as a new “Removable Disk” with an unused
drive letter assigned to it. Double click this new “Disk” icon, open the “DCIM” folder inside, then the folder(s)
inside that (“I00BNxxx” ,etc). Your photos/videos are the files inside-they have the prefix “PICT__” followed by a
number, same as seen earlier on the camera’s display when you review photos. Single clicking any file should show
a small preview image.

5. Click “Edit>Select All” (or click on one photo, contol+click to select multiple photos), then “Edit>Copy to
Folder” (in Windows menus). Select an existing folder on your hard drive, such as “My Pictures”, or create a new
folder (“Hawaii Vacation”, etc), then click “OK” to transfer copies of the photo files you want.

6. After the photos are transferred to your hard drive, you can disconnect the camera. Windows 2000 may produce
a screen warning that you have disconnected a USB device without stopping or ejecting the “disk” first (your
photo files will not be harmed). If so, check the box that adds an icon to your system tray or taskbar. Then next
time you finish transferring photos, you can click that icon first, and “Stop the USB Mass Storage Device” before
disconnecting the camera.

Note: If your PC will not play the .avi movie files in Windows Media Player, you may need to
download a newer version of Media Player or Direct X from Microsoft.com. The movie files can also
be played back with the QuickTime Player, included with many computers, or available as a free
download from Apple.com.
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Transferring The Photos & Videos to Your PC continved

7. You're now ready to open the photo files in any photo editing software. Just use File>Open and go to the
folder where you stored the photos earlier. If you are using PhotoSuite, select File>Open Photo, then use the
“Look in” pull down menu at the top of the Open window, select “My Computer”, select your hard drive, and
double click any photo in the folder where you copied the files from the camera. It is also possible to open and
work with your photos directly from the Instant Replay while it is still connected.To do this with PhotoSuite,
first follow steps 1-3, then open PhotoSuite, select File>xOpen Photo and use the “Look in” menu to select My
Computer, then select the “Removable Disk”, and open the folders inside until you get to the JPEG photo files.
If you choose to work this way, from a connected camera, be sure that you save the photo (when you are done
editing) to your hard drive, and not the camera’s memory or card. To do this in PhotoSuite, after clicking “Done”,
answer “Save Changes?” with “Yes”, but then answer “Replace Existing File”? with “No” and use the “Save As”
dialog box to save the edited photo in a folder on your hard drive (“Save In>Local Disk”), not the “Removable
Disk” (camera).

8. If you are new to photo editing on a computer, consult your software’s Help menu (PhotoSuite has extensive
built-in Help) for tips on using its features. Along with adjusting the brightness, contrast, sharpness and color of
your photos, you can resize the photo to fit the paper if you are printing, or save a smaller, low or medium resolu-
tion version for email or inserting into documents. When you are ready to save your edited file, you may want to
use “Save As” and give it a more descriptive name than “100BN___". Doing this also preserves the original file
as a backup to reopen and re-edit later. Make sure you have successfully transferred all the photos you wanted to
save before using “Delete All” on your camera to make room for new images .
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Photo Storage Capacity Reference (max capacity, +/- 2 photos)
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* Selects amount of file compres-

Image Size Megapixels Quality * Internal 64 MB SD | gion (jpg racio)
approx Memory** Card (FQ=low/EQ-=high)
( pp ) Y FQ: Fine Quality (1:4)
L 2048x1536 3.1 FQ 15 photos 60 photos | NQ: Normal Quality (1:8)
EQ: Economy Quality (1:16)
NQ 31 124
**Internal RAM available for
EQ 62 248 photo files: 16 MB
M 1600x1200 2.1 FQ 25 100 Image Size refers to the pixel
dimensions, or resolution, of the
NQ 51 204 digital file.
EQ 102 408 Actual storage capacity will vary
based on content of each photo
§ 640x480 035 FQ 160 640 file. You may be able to take a few
NQ 321 1284 photos more or less than the listed
average capacity.
EQ 642 2568
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Use large size and high quality set-
tings for photos you may want to
enlarge or crop later. If required,
they may also be reduced to a
smaller file size using your photo
software. Use small size and/or
low quality settings if you will
only email, insert into documents,
or make small prints, and do not
want to resize the file later.

TWO-YEAR LIMITED WARRANTY

Your Bushnell® product is warranted to be free of defects in materials and workmanship for
two years after the date of purchase. In the event of a defect under this warranty, we will,
at our option, repair or replace the product, provided that you return the product postage
prepaid. This warranty does not cover damages caused by misuse, improper handling, in-
stallation, or maintenance provided by someone other than a Bushnell Authorized Service
Department.

Any return made under this warranty must be accompanied by the items listed below:
1) A check/money order in the amount of $10.00 to cover the cost of postage and handling
2) Name and address for product return
3) An explanation of the defect
4) Proof of Date Purchased
5) Product should be well packed in a sturdy outside shipping carton, to prevent damage in transit,
with return postage prepaid to the address listed below:

IN CANADA Send To:

Bushnell Performance Optics
Attn.: Repairs

25A East Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

IN U.S.A. Send To:
Bushnell Performance Optics
Attn.: Repairs

8500 Marshall Drive
Lenexa, Kansas 66214

For products purchased outside the United States or Canada please contact your local dealer
for applicable warranty information. In Europe you may also contact Bushnell at:

BUSHNELL Performance Optics Gmbh

European Service Centre

MORSESTRASSE 4

D- 50769 KOLN

GERMANY

Tél: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

This warranty gives you specific legal rights.
You may have other rights which vary from country to country.

©2005 Bushnell Performance Optics

FCC Note:

This equipment has been tested and found to comply
with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful
interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy
and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio
or television reception, which can be determined by
turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the
following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

- Consult the dealer or an experienced radio/TV

technician for help.

The shielded interface cable must be used with the

equipment in order to comply with the limits for a digital

device pursuant to Subpart B of Part 15 of FCC Rules.

Specifications and designs are subject to change without
any notice or obligation on the part of the manufacturer.
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Félicitations et merci d’avoir acheté le Compact Instant Replay™ Bushnell® ! Le Compact
Instant Replay est idéal pour tous les événements sportifs et U'observation de la nature car
il associe des jumelles compactes, de haute qualité, & grossissement de 8 fois, & un appareil
photo numérique polyvalent, 4 3,2 mégapixels, doué d’une étonnante capacité vidéo. Le
Compact Instant Replay présente une « double personnalité » car il sait prendre des photos
fixes numériques, 2 haute résolution, aussi bien que des clips vidéo qui se « recyclent » ou
se rafraichissent automatiquement, toutes les 8 4 60 secondes (selon les réglages de qualité).
Vous étes ainsi toujours sr de saisir le vif de I'action! Vos photos et clips vidéo sont
automatiquement enregistrés dans la mémoire interne ou sur une carte SD (Secure Digital)
optionnelle et peuvent étre visionnés instantanément sur I'écran LCD relevable, visionnés
sur un écran de TV, ou téléchargés sur un ordinateur, sans avoir a installer de logiciel spécial.
(Avec Windows 2000, XP ou Mac. Le logiciel est fourni pour Windows 98/98SE).

Avant d’utiliser votre nouveau Compact Instant Replay, veuillez lire les instructions de ce
manuel et prendre quelques instants pour vous familiariser avec le fonctionnement et les
caractéristiques attrayantes de I'instrument.
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GUIDE RAPIDE : COMPACT INSTANT REPLAY 11-8323 BUSHNELL

1

Installation
des piles et de
la carte SD
(optionnelle)

Introduisez 2 piles de type AAA (voyez « Spécifications ») dans le compartiment de piles, au bas du socle
de I'appareil (notez I'indication de polarité a I'intérieur). Une carte mémoire SD (optionnelle) offrant
une plus grande capacité de stockage de photos peut aussi étre installée dans son emplacement, a I'arriére
du socle de 'appareil. (Abaissez le volet en caoutchouc de I'emplacement de carte. Introduisez la carte
avec le coté étiquette vers le bas, jusqu’a ce qu'elle s'enclenche avec un déclic puis remettez le volet en
caoutchouc en place).

Activation de

lappareil

Levez'écran al'aide de 'onglet situé a I'arriere. Appuyez brievement sur le bouton POWER (MARCHE).
Lécran de départ doit s'allumer puis s’éteindre et la DEL rouge d’alimentation doit rester allumée. Ap-
puyez sur LCD/Mode pour rallumer Iécran : vous devez voir I'image actuelle « en direct » vue par
lobjectif de 'appareil situé entre les lentilles des jumelles. Lappareil s’éteint automatiquement au bout
de 2 minutes d’inactivité pour économiser Iénergie des piles. Vous pouvez aussi I'éteindre manuel-
lement en appuyant sur le bouton LCD/Mode ; il n’est pas nécessaire qu'il soit allumé pour prendre
une photo. Lappareil entier se désactive automatiquement au bout de 5 minutes d’inactivité (aucun
bouton n’a été actionné). Pour le désactiver manuellement, appuyez bri¢vement sur le bouton POWER
(MARCHE). Les réglages par défaut de ['appareil fournissent une qualité optimum dans la plupart des condi-
tions. Il est toutefois recommandé de lire tout le manuel pour profiter des nombreuses options disponibles pour
différentes situations de photographie et les préférences de lutilisateur.

Formatage de la
carte SD (option-
nelle)

Si vous avez introduit une carte SD précédemment, formatez-la avant d’utiliser 'appareil. Appuyez sur
le bouton Menu/OK, au centre du clavier argent. Appuyez 4 fois sur la fleche vers le bas pour sélection-
ner « Format ». Appuyez sur la fleche vers la droite puis sur la fleche vers la gauche pour sélectionner
«Yes » (oui). Appuyez sur Menu/OK ; vous verrez un avertissement disant que toutes les images seront
effacées ; sélectionnez « Yes » et appuyez de nouveau sur OK. Utilisez la fleche vers le bas pour sélection-
ner « Exit » (sortir) et appuyez sur OK.

Réglage de
l'optique des
jumelles & la vue
de lutilisateur

Si vous portez des lunettes, roulez les ceilletons en caoutchouc. Réglez I'écartement entre les cylindres
gauche et droit, en regardant dans les jumelles, de fagon a voir une seule image circulaire. Puis repérez
un objet ¢loigné comportant de fins détails et réglez la molette centrale de mise au point jusqu’a ce que
lobjet paraisse net dans 'oculaire gauche. Regardez maintenant a travers I'oculaire droit seulement.
Si l'objet n'apparait pas aussi net, tournez 'oculaire droit (réglage dioptrique) jusqua ce qu'il le soit.
Une fois cela réglé, vous n’avez plus besoin de tourner le réglage dioptrique et vous pouvez simplement
utiliser la molette centrale de mise au point.

;O
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QUICK GUIDE: BUSHNELL COMPACT INSTANT REPLAY 11-8323
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5

Saisie d’une
photo ou d’'un
clip vidéo

Maintenez 'appareil immobile des deux mains et appuyez sur le bouton SNAP (déclencheur) pour pren-
dre une photo fixe. Vous pouvez entendre un bip (qui peut étre désactivé) suivi d’une pause bréve (icone
de fichier affichée) lorsque I'appareil met la photo en mémoire. Pour prendre un clip vidéo, appuyez
une fois sur Menu/OK puis sur la fleche vers la droite pour voir les options vidéo du menu de I'appareil
photo. Utilisez les fleches vers le haut et vers le bas pour sélectionner Replay (boucle) ou Normal (con-
tinu) puis appuyez sur Menu/OK. Ceci vous ramene a affichage en direct et vous pouvez alors saisir
le clip vidéo a tout moment en appuyant sur SNAP. Pour arréter d’enregistrer, appuyez de nouveau sur
SNAP. Veuillez lire la section « Modes Vidéo »jmur une explication détaillée des différences entre les modes
« Normal » et « Replay » ainsi que la facon de déterminer la durée d'enregistrement vidéo.

Revoir et effacer
des  photos et
clips vidéo

Pour revoir ou afficher une photo fixe ou un clip vidéo, appuyez sur le bouton LCD/Mode (appuyez
deux fois si 'écran n’était pas déja actif). Vous pourrez voir la photo fixe ou le clip vidéo (premiére im-
age) le/la plus récent(e). Pour revoir des photos ou clips précédents, un a la fois, appuyez sur la fleche vers
la gauche. Licone du coin inférieur droit de I'écran doit indiquer si le fichier actuel est celui d’une photo
fixe ou d’un clip vidéo normal ou « instant replay ». Les nombres au-dessus de cette icone correspondent
au numéro du fichier actuel et au nombre total de fichiers (2 sur 3, etc.). Pour visionner un clip vidéo
enregistré, appuyez sur la fleche vers le bas (appuyez de nouveau pour arréter le visionnement). Pour voir
simultanément en « onglets » les images de plusieurs photos/clips enregistrés, appuyez sur la fleche vers
le haut apres avoir accédé au mode de visualisation. Utilisez les touches des fleches pour sélectionner un
seul fichier et appuyez de nouveau sur la fleche vers le haut pour voir en grand format. Pour effacer une
photo/un clip vidéo, appuyez sur Menu/OK puis une fois sur la fleche vers le bas (icone de la poubelle).
Appuyez sur la fleche vers la droite ; sélectionnez « Delete One » (effacer une) ou « Delete All » (effacer
tout) et appuyez sur la fleche vers la droite puis sélectionnez « Yes » (oui). Retournez a la colonne Menu,
sélectionnez « Exit » (sortir) et appuyez sur Menu/OK pour retourner a la visualisation.

Connexion a
un  ordinateur
et transfert de
photos

Avant de connecter I'appareil photo, installez le pilote du CD-ROM si vous utilisez Windows 98/98SE
puis installez PhotoSuite si vous n'avez pas de logiciel d’édition de photos. Reliez le cable USB fourni
entre la prise USB de 'appareil photo (a I'arriere du socle de I'appareil) et un port USB sur 'ordinateur.
Si vous avez Windows XP, suivez simplement les instructions/options qui apparaissent automatique-
ment sur I'écran. Si vous avez Win 98 ou 2000, ouvrez « My Computer » (mon ordinateur) sur votre PC.
Lappareil photo est identifié comme un « disque amovible » ; vos photos se trouvent dans les dossiers a
Pintérieur ; il suffit de les faire glisser ou de les copier/coller dans un dossier, sur le disque dur. Reportez-
vous 2 la section « Transfert de photos » de ce manuel.
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Caractéristiques techniques

Grossissement 8x Taille fichier photo fixe (résolu- 2048 x 1536, 1 600 x 1 200, 640 x 480
tion)

Diametre de 30 mm Taux de compression de fichier 1:4 (FQ), 1:8 (NQ), 1:16 (EQ)

Iobjectif (qualité)

Pupille de sortie 3,75 Mémoire interne Mémoire Flash 16 Mo

Largeur de champ 97 ma9ldm Extension de mémoire Carte Secure Digital, jusqua 1 Go de capacité

Dégagement 13 mm Format fichier (fixe/vidéo) JPEG /MJPEG (.AVI)

oculaire

Traitement de
lentille

Multicouches

Gestion de fichier

DCEF (version 1.0), format FAT 16

Type de prisme

A vision directe, BK-7

Ecran LCD

38 mm, & matrice active, 120, 480 pixels

Plage de mise au 5,5 m ~ infini Résolution vidéo/fréquence image | 620 x 480 ou 320 x 240 pixels par image / 30 ou 15 images/s.

point (jumelles) Durée de boucle mode Replay : 8/15/30/60 secondes (suivant la
résolution/fréquence sélectionnée)

Poids 406,5 g Sortie vidéo NTSC/PAL, via port USB 8 broches avec cable spécial (inclus)

Type capteur CMOS Plage de valeurs d’exposition +/- 2 EV par paliers de 0,5 EV

Pixels effectifs

3,2 mégapixels

Options de balance des blancs

Auto, jour, nuageux, fluorescent, incandescent

Couleur

Couleur 24 bits

Scenes préréglées

Programme, sports, paysage, portrait, nuit

Obturateur

Electronique, 1/16 2
1/1000 seconde

Langues de menu

anglais, espagnol, frangais, allemand, italien, portugais, japonais

Plage de mise au
point (appareil
photo)

Fixe, approx. 18 m
~ infini

Désactivation automatique (apres
inactivité)

Ecran LCD : 2 min. / Tout I'appareil : 5 min.

Ouverture dia-

IMangeds Search

/5,6
And Download.

Alimentation

2 piles type AAA, alcalines/lithium/NiMh
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Identification des piéeces Icones affichées sur I’écran LCD

Ecran LCD

Bouton LCD/Mode I | [
Vidéo Normal Vidéo Replay

e

Clavilfr 5 options (relecture)
avec bouton . 17
Menu/OK — Affichage film (vidéo)

et Visualisation de photo fixe 8
Molette Port USB/sortie vidéo # | Icone # | Icone
centrale de_ Avertisseur DEL - - -
mise au point sonore d’alimentation Indicateur de tension de pile (2/3 de charge représenté) 1 | Indicateur de tension de pile

(jumelles)

(plein)

Nombre de photos restant (en fonction de la mémoire disponible)

2 | Total secondes de vidéo dis-
ponible (en fonction de la
mémoire disponible)

Bouton Snap
(déclencheur)

1
2
3 | Mode photo fixe
4

Qualité (compression de fichier) Fine/Normal/Economy (haute/nor-

male/économie)

3 | Mode film

N

Reésolution (taille de fichier) Lage/Medium/Small (grand/moyen/petit) 4 | Résolution (FQ-640x480/
ésolution =640x:

NQ=320x240)

: ““~Réglage
T di(;gl):ﬁque

6 Balance des blancs  Non affiché sauf aprés changement de “Auto” par défiuut dans
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Emplacement de carte SD
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Lexposition

7

Scene  Non affiché sauf aprés changement de “Program” par défaut au menu Mode

a&aEMEQWAMWWCC Non affiché sauf si sélectionné an menu Mode

images/s)

5 | Fréquence image (30 ou 15
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Retournez le Compact Instant Replay et glissez le couvercle du compartiment de
piles pour ouvrir dans le sens représenté a droite. Introduisez 2 piles alcalines ou au
lithium, de type AAA, dans le compartiment, dans le sens indiqué par les schémas
a lintérieur puis remettez le couvercle en place jusqua ce qu'il s'enclenche avec
un déclic. Remarque : Il est également possible d’utiliser des piles rechargeables &
hydrure métallique de nickel (type NiMh) mais certains modéles risquent de ne pas
avoir la puissance suffisante pour alimenter I'Instant Replay. 1l est recommandé
‘utiliser des piles NiMh d’une intensité nominale de 2 300 mA/h ou plus.

Mise en place d’une carte SD

Lappareil photo peut enregistrer de 15 2 642 photos environ dans sa mémoire interne
de 16 Mo, suivant les réglages de résolution et de qualité (consultez le tableau a la
fin de ce manuel). Pour augmenter la capacité de stockage, vous pouvez ajouter une
carte mémoire optionnelle, de type SD (Secure Digital), d’une capacité maximum de
1 Go. Cette carte s'insere dans I'emplacement situé a I'arriere du socle de 'appareil,
comme illustré sur le schéma précédent. Introduisez la carte SD avec le coté étiquette
vers le bas. Remarque : Vérifiez que 'alimentation est coupée avant d’introduire et
de retirer une carte pour éviter de perdre des fichiers ou d’endommager la carte. Il
n'est pas nécessaire de formater une carte neuve mais une carte qui a déja éeé utilisée
dans d’autres dispositifs doit étre formatée par le Compact Instant Replay avant &’y
enregistrer des photos (consultez le menu Setup/Réglage 4 la section suivante). Notez
que ce formatage effacera tous les fichiers enregistrés sur la carte ; veillez donc a les
télécharger ou a les copier préalablement si vous souhaitez les conserver.
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Couvercle du compartiment
de piles

Emplacement de carte
(soulevez le volet)

Réglage de base des jumelles et de I’appareil photo

Avant de prendre des photos ou des clips vidéo, veuillez prendre quelques instants pour régler le Compact Instant Replay a votre vision et
selon vos préférences. Si vous ne portez pas de lunettes, laissez les ceilletons d’oculaire en caoutchouc en position relevée ou roulez-les pour
les abaisser si vous en portez. Saisissez les jumelles par les cotés gauche et droit et écartez ou rapprochez les deux moitiés tout en regardant
dans les jumelles pour régler 'espace entre les oculaires afin que vous puissiez voir une seule image circulaire. Repérez un objet ¢loigné
comportant de fins détails (arbre, panneau, mur de briques, etc.) et réglez la molette centrale de mise au point jusqu’a ce que I'objet paraisse
net quand vous le regardez dans 'oculaire gauche uniquement. Puis, en regardant le méme objet seulement dans I'oculaire droit, tournez
loculaire droit jusqu'a ce que I'image y soit tout aussi nette. Il s'agit du réglage dioptrique qui compense la différence de vision entre les
deux yeux. Une fois cette méthode initiale de réglage suivie, il n’est plus nécessaire d’ajuster le réglage dioptrique et vous pouvez simplement
utiliser la molette centrale pour mettre les objets au point dans les jumelles (la distance de mise au point minimum est d’environ 5 m).

Les photos et clips vidéo numériques ne sont pas affectés par la molette centrale de mise au point car 'objectif de 'appareil photo situé
entre les oculaires des jumelles ne nécessite pas de mise au point. Il est préréglé de maniere que les objets situés approximativement entre
18 m et Iinfini paraissent nets. Notez que les jumelles peuvent effectuer une mise au point plus rapprochée que I'appareil photo. Vérifiez
I'image en direct sur I'écran LCD pour vous assurer que vous étes suffisamment éloigné du sujet pour avoir une photo nette. Lobjectif
de l'appareil photo fournit un grossissement de 8 fois qui est le méme que celui de I'optique des jumelles et il est aligné pour qu’un objet
centré avec les jumelles soit aussi centré sur les photos et clips vidéo. Par conséquent, il n’est pas nécessaire d’avoir I'écran LCD activé ou
méme relevé pour pouvoir saisir des photos ou clips vidéo. La réduction de I'usage de I'écran LCD permet de prolonger sensiblement la
durée de vie des piles.

Avant d’utiliser 'appareil photo pour la premiére fois, vous trouverez utile d’accéder au menu de I'appareil et de régler la date. Levez I'écran
LCD et appuyez sur le bouton de marche. Une fois que le témoin rouge d’activation est allumé, appuyez sur LCD/Mode pour activer
Iécran. Appuyez sur le bouton Menu/OK au centre du clavier puis 3 fois sur la fleche vers le bas pour parvenir au menu Setup/Réglage.
Appuyez une fois sur la fleche vers la droite puis sur la fleche vers le bas pour arriver  « Date ». Appuyez alors deux fois sur la fleche vers
la droite pour accéder au réglage de la date. Utilisez les fleches vers la gauche/droite pour sélectionner la partie de la date que vous voulez
changer puis utilisez les fleches vers le haut ou le bas pour la changer. Pour changer le format de la date de facon que le jour, le mois et
'année soient dans I'ordre souhaité, allez jusqu’a I'icone des fleches, a la partie supérieure gauche de I'affichage de la date et appuyez sur
les fleches vers le haut/bas. Réglez 'heure (format de 24 h) avec les 4 chiffres au bas de I'affichage de la date, de fagon que la date change
automatiquement & minuit  I'endroit oli vous vous trouvez. Une fois la date et 'heure réglées, appuyez une fois sur le bouton Menu/OK
puis de nouveau pour sauvegarder le réglage et sortir. Vous pouvez alors appuyer sur la fleche vers le bas et choisir si vous souhaitez que la
date apparaisse a I'affichage et sur vos photos ou pas (« Show Date On/Off » [indication de date oui/non]). Continuez alors & appuyer sur
la fleche vers la gauche pour revenir a «a Setup » (réglage) ; descendez jusqua « Exit » (sortir) et appuyez sur Menu/OK.
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Saisie de photos fixes

Apres avoir effectué le réglage initial comme décrit aux pages précédentes, vous étes prét a prendre une photo :

1) Levez I'écran LCD et appuyez bri¢vement sur le bouton Power (marche/arrét) (la DEL rouge s'allume). Appuyez sur le bouton
LCD/Mode pour activer I'écran LCD si vous souhaitez voir I'image avant de prendre la photo ou vérifier les réglages de menu, I'état
de charge des piles, etc.

2) Le Compact Instant Replay passe aux réglages par défaut : résolution et qualité les plus élevées, ainsi que « tout sur automatique »
lorsqu’il est mis en marche la premitre fois, afin que vous puissiez prendre immédiatement d’excellentes photos. Si vous préférez utiliser
des réglages différents, consultez la section « Utilisation du menu principal » pour savoir comment trouver et modifier les réglages tels
que la résolution et 'exposition, I'utilisation de préréglages de scene pour les sujets habituels et d’autres options.

3) Vous pouvez composer votre photo tout en regardant dans les jumelles (il n'est pas nécessaire que I'écran LCD soit activé pour pren-
dre une photo). Toutefois, pour obtenir le cadrage le plus précis, il est recommandé de vérifier 'image préalable sur I'écran LCD.

4) Vérifiez que le sujet ne se trouve pas 2 moins de 18 metres environ. Loptique des jumelles peut effectuer une mise au point & une
distance inférieure, mais le réglage de mise au point de I'appareil photo est préréglé pour obtenir les meilleurs résultats avec les sujets
éloignés (aucune mise au point n'est nécessaire pour I'appareil photo). Vous pouvez utiliser I'écran LCD pour vérifier que le sujet n'est
pas trop proche pour donner une image nette.

5) Maintenez I'appareil aussi immobile que possible, des deux mains, et appuyez lentement sur le bouton SNAP (déclencheur). Lécran
s'obscurcit brievement pendant I'enregistrement du fichier (I'icone de fichier apparait) puis vous pouvez prendre une autre photo. Le
compteur situé dans le coin inférieur droit indique la capacité de photos restante qui dépend de 'espace disponible dans la mémoire
interne ou sur la carte mémoire, ainsi que des réglages de résolution et de qualité (vous pouvez passer a des réglages inférieurs a tout
moment pour « loger » davantage de photos dans I'espace restant). Remarque : Le nombre du compteur ne descend pas toujours d’une
unité apres chaque photo prise, car cela dépend des réglages et du contenu réel du fichier par photo. Lorsque le compteur atteint 000,
la mémoire est pleine (il n’y a plus d’espace de stockage) et vous devez télécharger les photos que vous souhaitez conserver pour pouvoir
les effacer ou bien vous pouvez retirer la carte en place et en installer une autre.

6) Un zoom numérique grossissant jusqu’a 6 fois est disponible. Appuyez sur la fleche vers la droite pour effectuer un zoom avant (vous
pouvez voir le résultat sur 'écran LCD). Appuyez sur la fleche vers la gauche pour sortir du zoom.

7) Appuyez sur le bouton LCD/Mode si vous voulez vérifier la photo apres 'avoir prise et appuyez de nouveau sur ce bouton pour
retourner 2 la visualisation en direct. Pour plus de détails sur la fagon de voir et d’effacer les photos déja prises, consultez la section
« Menu de visionnement ».

34

Saisie de clips vidéo en mode normal ou « Instant Replay »

1) Effectuez les opérations 1 2 4 de la page précédente : « Saisie de photos fixes ».
2) Pour passer du mode de photo fixe 4 'un ou l'autre des modes vidéo, appuyez sur le bouton Menu/OK. Le premier groupe de menu
est « Camera » (appareil photo). Appuyez sur la fleche vers la droite puis utilisez les fleches vers le haut ou le bas pour sélectionner le mode
vidéo Normal ou Replay (I'appareil retourne 2 la visualisation en direct apres la sélection d’'un mode vidéo ; vous étes donc prét a filmer
immédiatement). Dans un mode comme dans 'autre, appuyez sur SNAP pour commencer & enregistrer un nouveau clip vidéo et appuyez
dessus de nouveau pour arréter I'enregistrement et garder le clip en mémoire. Voici ce en quoi les deux modes vidéo different :
Au mode vidéo Normal, I'enregistrement continu du clip vidéo commence quand vous appuyez sur le bouton Snap (déclencheur) et se
termine quand vous appuyez de nouveau dessus. La durée d’enregistrement n'est limitée que par le volume de mémoire interne ou sur carte
disponible. Vous pouvez enregistrer un seul long clip vidéo jusqu’a ce que la mémoire soit pleine ou plusieurs clips courts en arrétant et en
reprenant ['enregistrement quand vous le voulez, en appuyant sur Snap. Quand il est arrété, le compteur indique la durée d’enregistrement
approximative restante (en secondes) et il décompte la durée restante quand un enregistrement en mode Normal a commencé.
Le mode vidéo Replay fonctionne différemment. A la fin d’une durée prédéterminée (déterminée par la résolution vidéo et la fréquence
d’image choisies dans le menu Réglage), le clip vidéo recommence une « boucle » ou un nouvel enregistrement, en effacant et en rempla-
cant les événements précédents. Cest une fonction idéale pour saisir I'action des sports car vous pouvez commencer  enregistrer A tout mo-
ment puis arréter juste apres un but ou une autre action importante. Vous serez stir de capter le vif de 'action et vous ne serez pas obligé de
rechercher dans un long film ou de rembobiner pour revoir 'image. Les durées de boucle disponibles sont : 8, 15, 30 ou 60 secondes ; plus
la résolution et la fréquence d’images par seconde sont élevées, plus la boucle est courte. Au mode Replay, quand il est arrét, le compteur
indique la durée d’enregistrement totale disponible (en secondes) et compte a partir de zéro jusqu’a la limite de durée de la boucle, une fois
que Penregistrement a commencé. A la fin de la boucle, quand I'enregistrement recommence une nouvelle boucle, le compteur se remet
automatiquement & zéro et recommence le décompte. Notez que si vous arrétez d’enregistrer & un moment quelconque d’une nouvelle
boucle, le clip vidéo contiendra la derniére partie de la boucle précédente et la premiere partie de la boucle actuelle ; I'appareil conserve
toujours une portion complete de 8, 15, 30 ou 60 secondes des événements les plus récents. Exercez-vous  utiliser le mode « replay » pour
comprendre son fonctionnement avant d’aller & un match important.
3) Appuyez sur le bouton LCD/Mode si vous voulez vérifier un clip vidéo apres 'avoir filmé. Appuyez sur la fleche vers le bas pour com-
mencer le visionnement et appuyez de nouveau pour I'arréter. Appuyez sur la fleche vers la gauche ou vers la droite pour revoir les photos
fixes ou clips vidéo enregistrés précédemment. Appuyez sur la fleche du haut pour afficher les onglets de plusieurs fichiers ; utilisez les
touches des fleches pour mettre le fichier a visionner en surbrillance et appuyez sur Menu/OK pour le sélectionner et le visionner. Quand
vous étes prét A retourner au mode de visualisation en direct afin de saisir d’autres clips vidéo (ou photos fixes), appuyez sur le bouton
LCD/Mode.
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Comme il a été mentionné plus haut dans ce manuel, le Compact Instant Replay est réglé par défaut 4 la résolution
et a la qualité les plus élevées. Lexposition, la balance des blancs et d’autres variables se réglent automatiquement.
Cela signifie que vous pouvez obtenir de bons résultats pour la plupart des sujets et des conditions d’éclairage, sans
avoir a entrer dans des menus et 4 changer des réglages. Toutefois, nous recommandons de vous familiariser avec les
options disponibles, de fagon & pouvoir améliorer vos photos si, par exemple, vous trouvez qu’elles sont trop sombres
(phénomene fréquent avec des paysages de neige, dans la plupart des appareils photo), ou trop vertes (sous certains
éclairages fluorescents). Le menu principal ou menu d’enregistrement est organisé en six groupes. Appuyez sur le bou-
ton « Menu/OK » pour voir ces groupes. Utilisez les boutons des fleches vers le haut ou vers le bas pour sélectionner
un groupe puis la fleche vers la droite et les fleches vers le haut/bas pour voir les articles ou options disponibles pour
ce groupe. Voici une description générale des groupes de menu et leurs fonctions :

Utilisation du menu principal (svite)

Groupe menu | Icone But
Réglage Fournit les options de réglage de : Résolution (taille de fichier), Qualité (com-
IE' pression de fichier), EV (valeur d’exposition), WB (balance des blancs) et ISO

(sensibilité a la lumiere).

Groupe menu | Icone But

Mode appareil Permet de sélectionner la photo fixe ou un de deux modes d’enregistrement de
photo | n clips vidéo (film). Ici, les options de menu indiquent toujours les deux modes
! qui ne sont pas en cours d’utilisation. Par exemple, si vous étes au mode vidéo

« Replay », les autres options sont affichées au menu d’appareil photo. Mode
I@I Photo fixe (icone d’appareil photo) ou mode Vidéo Normal (icone de caméra
avec fleche droite).

Formatage Prépare a l'utilisation une carte mémoire SD neuve ou déja utilisée. Efface
(supprime) tous les fichiers contenus sur la carte. Peut aussi étre utilisé pour
effacer rapidement tout le contenu de la mémoire interne si une carte SD n’a
pas été insérée.

Sortie Sort du menu principal et retourne 2 la visualisation en direct.

Exposition Fournit des options de réglage WB (balance des blancs) et EV (valeur
| l:‘ d’exposition) pour ajuster la reproduction des couleurs et I'exposition pour dif-
férentes situations si les réglages standards automatiques ne produisent pas la

qualité ou les résultats souhaités.

Mode Permet le choix de « Scénes » préréglées qui optimisent les réglages de I'appareil
';:) pour laction des sports, les paysages et autres sujets de photos habituels. Les
56 options de photo fixe, de minuterie automatique et de séquence rapide figurent

aussi dans ce groupe de menu.

Les quelques pages suivantes fournissent la liste compléte de tous les articles et réglages disponibles dans les groupes
du menu principal, avec leur description et leur fonction. Procédez de la méme maniere que vous avez suivie dans
I'exemple ci-dessus, pour vous déplacer dans les écrans de menu afin de mettre en surbrillance et de changer les
réglages selon vos préférences et besoins personnels. Le menu de Visionnement est différent, mais plus simple, avec
quatre groupes seulement (Diaporama, Effacer, Editeur et Sortir). Pour une description compléte, consultez la section
« Menu de visionnement » plus loin dans ce manuel.
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Options du menu principal («¢glages par défaut en caractéres gras)

*Les réglages de Scéne et de Séquence dans « Mode » ne sont pas disponibles lorsque « Camera » (appareil photo) est

7églé pour le mode vidéo Normal ou Replay.

Options du menv principal (svite)

Groupe Réglages Description
APPAREIL Photo fixe Icone de I'appareil Photographies 3,2 mégapixels, images fixes
PHOTO
Clip vidéo Mode vidéo Normal | Filme un clip vidéo standard en continu, avec durée limitée seule-
(icone film avec ment, en fonction de la mémoire interne ou de carte SD restante.
fleche droite)
Mode vidéo Replay Filme des clips vidéo en « boucle », enregistrant par-dessus les
(icone film avec images de la boucle précédente. Les boucles ont une durée fixe (de
fleche circulaire) 8 2 60 secondes), en fonction de la résolution et de la fréquence
d’image (images/seconde).
EXPOSITION | WB (Balance | Auto La Balance des blancs est réglée automatiquement pour une repro-
des blancs) duction correcte des couleurs.
Jour Réglage manuel pour I'extérieur ensoleillé
Ampoule électrique Réglage manuel pour I'éclairage intérieur au tungsténe (ampoule
électrique)
Fluorescent Réglage manuel pour I'éclairage intérieur fluorescent
Nuageux Réglage manuel pour un ciel couvert ou 'ombre
EV -2,0 ~ 42,0 Fournit un réglage manuel de sous-exposition ou surexposition par

paliers de 0,5 EV. Les valeurs négatives produisent des photos plus
sombres, les valeurs positives des photos plus claires.

Groupe | Article Réglages | Description
MODE Scene * Program Exposition standard automatique pour la plupart des sujets ou I'usage général
Sports Utilise des vitesses d’obturateur plus élevées pour capturer le mouvement
Paysage Zone de mise au point plus étendue pour une netteté accrue, du premier plan a I'arriere-plan
Portrait Zone de mise au point moins étendue pour les photos de personnes ; aide 2 isoler le sujet de
larriere-plan
Nuit Utilise des vitesses d’obturateur plus basses pour une meilleure exposition en faible luminosité
Minuterie Oui/ Non Photo prise avec un retard aprés une pression sur le bouton Snap
Séquence * 3 ou 5 images 3 ou 5 images prises en séquence rapide sur pression du bouton Snap
REGLAGE Taille/ Taille d’image 3 options de taille d’image : L(2 048 x 1 536 pixels), M (1 600 x 1 200 pixels) ou S (640 x 480
qualité (Résolution) pixels). Une résolution plus élevée produit des images plus nettes/grandes mais réduit I'espace total
(Photo fixe) de stockage disponible. Utilisez les réglages inférieurs pour stocker davantage en mémoire, ou pour
le courriel, etc. L=3,1 MP/M =2,1 MP/S=0,35MP
Qualité Regle le degré de compression du fichier jpg. Les réglages sont : Fine-FQ (1:4 compression), Nor-
(Taux compres- mal-NQ (1:8) et économie-EQ (1:16). Ce réglage peut étre utilis¢ indépendamment de la taille
sion fichier) d’image pour stocker davantage de photos en échange d’une qualité légerement réduite.
Dans mode Qualité 640 x 480 pixels par image (Résolution)> 4 30 ou 15 images par seconde (Fréquence)
vidéo Normal | (Résolution 320 x 240 pixels par image >a 30 ou 15 images par seconde
uniquement & Fréquence (Apres avoir choisi la résolution, appuyez sur la fleche vers la droite pour choisir la fréquence
image (images/s)
Dans mode Qualité 640 x 480 pixels par image (Résolution)> a 30 ou 15 images par seconde (Fréquence)
vidéo Replay (Résolution & 320 x 240 pixels par image >a 30 ou 15 images par seconde
uniquement Fréquence image | Durée de boucle de 8, 15, 30 ou 60 secondes suivant les réglages de résolution/fréquence 39
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Options du menu principal (svite)
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. ; ..
Groupe | Article Réglages | Description
Date Réglage, Permet le réglage de la date et de I'heure correctes pour votre région. Si « On »
activé/dés- (activé) est sélectionné, la date apparaitra sur I'affichage et sera imprimée sur
activé toutes les photos.
Stockage Auto Les fichiers sont stockés sur la carte SD si elle est insérée, ou sur la mémoire
interne si elle ne I'est pas.
SD Les fichiers sont stockés sur la carte SD uniquement (elle doit étre insérée).
Interne Les fichiers sont stockés dans la mémoire interne uniquement, jamais sur la carte.
Langue 7 disponibles | Sélectionne votre langue préférée pour tous les écrans de menu.
Visionnement | Désactivé/1-3 | Sélectionne la durée de visionnement automatique apres saisie de la photo.
auto secondes
Nom de Remisea Regle le systeme de numérotation des fichiers. Si Remise a zéro est sélectionnée,
fichier zéro/Série une fois que tous les fichiers de la mémoire interne ou de la carte sont effacés, les
numéros des fichiers des nouvelles photos recommencent & « 000 ». Si Série est
sélectionnée, les numéros des fichiers des nouvelles photos reprennent au numéro
suivant aprés le dernier numéro utilisé pour les fichiers précédents.
Bip Activé / Active ou désactive le bip d’avertissement sonore.
Désactivé
Tout réini- Oui / Non La sélection de « Oui » restaure tous les réglages aux valeurs d’origine par défaut
tialiser (indiquées en caracteres gras).
FORMAT Formatage Oui / Non Formate la carte pour les fichiers du Compact Instant Replay. Efface tout le contenu.
SORTIE Sort du systeme menu et retourne 2 la visualisation en direct.
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Icones de visionnement

# | Icone

1| Date du fichier de la photo ou du clip vidéo (la fonction de date doit étre
réglée et activée)

Emplacement du fichier du visionnement en cours (mémoite interne ou carte SD)

Résolution du fichier du visionnement en cours

Qualité (compression du fichier) du fichier du visionnement en cours

(LN RSN KSU 1 NSY

Numéro du fichier actuel (chiffre gauche) : Nombre total de fichiers en
mémoire (chiffre droit)

Indique le type de fichier (photo fixe, mode vidéo normal, mode vidéo Replay)

7 | Indicateur de tension des piles

Menu de visionnement
Visionnement et effacement des photos et clips vidéo

Appuyez sur « LCD/Mode » pour entrer au mode de visionnement. Utilisez les boutons de fleche vers la gauche/droite
pour faire défiler les photos/clips vidéo enregistrés. Une fois au mode de visionnement, appuyez sur le bouton Menu/
OK pour entrer dans le groupe des menus. Linteraction est la méme que celle décrite précédemment, dans les instruc-
tions du menu principal, (utilisez les touches des fleches pour naviguer jusqu'aux groupes et options de menu souhaités
et appuyez sur OK pour confirmer un réglage), mais les articles de menu sont différents, comme suit:

com. All I

Manuals Search IAnd Downloa

Groupe Article Réglages | Description
DIAPORAMA Oui/ La sélection de « Oui » commencera un diaporama de toutes les images
Non actuellement dans la mémoire interne ou sur la carte mémoire, en pas-

sant automatiquement 4 l'image suivante toutes les quelques secondes. 4 1




Menus de visionnement (svife)

Groupe

Article

Réglages

Description

EFFACER

Effacer
une

Oui / Non

Supprime de la mémoire la photo ou le clip vidéo actuellement
afﬁpché(e), Utilisez les fleches vers le haut/bas pour trouver le fichier &
supprimer. Pour le supprimer, mettez I'icéne « Effacer une » en sur-
brillance et appuyez sur OK. Mettez ensuite « Oui » en surbrillance
et appuyez sur OK pour supprimer le fichier.

Effacer
tout

Oui / Non

Supprime tous les fichiers stockés. Pour supprimer tous les fichiers
(sauf ceux qui sont verrouillés ; voyez ci-dessous), mettez I'icone

« Effacer tout » en surbrillance et appuyez sur OK. Mettez ensuite
« Oui » en surbrillance et appuyez sur OK pour supprimer tous les
fichiers actuellement en mémoire.

EDITEUR

Protéger

Verrouiller /
Déverrouiller

Le verrouillage du fichier d’'une photo ou d’un clip vidéo évite son
effacement involontaire. Il peut étre utilisé avec « Effacer tout »
pour effacer rapidement toutes les photos sauf une ou deux. Pour
verrouiller la photo ou le clip actuellement affiché(e), mettez I'icone
« Verrouiller » en surbrillance et appuyez sur OK. Pour déverrouiller
un fichier verrouillé, sélectionnez-le avec les fleches vers le haut/bas,
mettez I'icone « Verrouiller » en surbrillance et appuyez sur OK.

Pivoter

-90 degrés ou
+90 degrés

Fait pivoter 'image actuelle de 90 degrés dans un sens ou dans
lautre.

SORTIE

Sortir

Sort du menu de visionnement et retourne 2 la derni¢re image
visionnée.
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Systeme requis (minimum)

Systeme d’exploitation : Windows® 98/98SE/2000/ME/XP

UC : MMX Pentium® 200 MHz équivalent ou plus rapide (Pentium® IIT 500 MHz pour PhotoSu-
ite5™)

Mémoire : 32 Mo minimum (64 Mo recommandés pour PhotoSuite)

Carte vidéo SVGA avec mémoire VRAM 2 Mo, écran 800 x 600, haute couleur 16 bits

200 Mo d’espace libre sur disque dur (pour I'installation de PhotoSuite)

Port USB interne

Installation du logiciel

Si vous utilisez Windows 98, vous devez installer les pilotes avant de connecter 'appareil photo & votre ordina-
teur. Insérez le CD-ROM dans le lecteur de CD de l'ordinateur ; il doit se lancer automatiquement et Iécran
d’installation doit apparaitre. Sélectionnez « Install Driver » (installer le pilote) et suivez les directives. Relancez
votre ordinateur apres I'installation. Windows 2000, ME et XP ne nécessitent pas de pilotes car I'appareil photo
utilise le dispositif de stockage de masse USB, ce qui permet d’accéder aux fichiers des photos comme s'ils étaient
sur un disque dur externe. Pour tout systtme d’exploitation Windows, si vous n’utilisez pas déja un logiciel
d’édition de photos que vous préférez, vous pouvez installer Roxio PhotoSuite® du CD-ROM. N’oubliez pas

de lire enti¢rement les Notes de publication, en notant les conseils et questions éventuels relatifs  votre systéme
d’exploitation.

Téléchargement de photos et clips vidéo a un ordinateur - étape par étape

1. Si vous utilisez Windows 98/98SE, n’oubliez pas d’installer d’abord le pilote.

2. Vérifiez que I'Instant Replay est activé et connectez le cable fourni au port USB de I'appareil photo (ouvrez
le volet de connecteur du c6té gauche de 'appareil) puis directement a un port USB principal sur I'ordinateur
(n'utilisez pas les ports USB du panneau avant, du clavier ni les plots non alimentés).

3. Lécran LCD s'éteindra pour économiser I'énergie des piles et Instant Replay sera reconnu comme un dispositif

standard de « stockage de masse USB ». Cela signifie que les fichiers de 'appareil photo pourront étre visualisés,
édités ou copiés facilement sur un disque dur, tout comme s'ils étaient stockés sur un disque dur externe ou un

CD-ROM.
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Téléchargement de photos et clips vidéo a un ordinateur - étape par étape (suite)

4. (Cette étape n'est pas nécessaire avec Windows XP ; suivez simplement les options de I'écran pour visualiser,
copier ou éditer les photos). Ouvrez Windows Explorer ou « Mon ordinateur ». Lappareil photo est considéré
comme un nouveau « disque amovible » avec une lettre d’unité inutilisée qui lui est assignée. Effectuez un double
clic sur cette icone de nouveau « Disque » ; ouvrez le dossier « DCIM » a l'intérieur puis les fichiers qui s’y trouvent
(« TOOBNxxx », etc.). Vos photos/clips vidéo sont les fichiers a I'intérieur ; ils ont le préfixe « PICT__ » suivi d’'un
nombre, le méme que celui vu auparavant sur affichage de 'appareil, lors du visionnement des photos. Un seul clic
sur un fichier doit montrer une petite image.

5. Cliquez « Edit>Select All » (éditer>sélectionner tout) (ou cliquez sur une photo, commande+clic pour sélectionner
de multiples photos) puis « Edit>Copy to Folder » (éditer>copier dans dossier) (dans les menus Windows).
Sélectionnez un dossier existant sur votre disque dur, tel que « Mes photos » ou créez un nouveau dossier (« Vacances
au bord de mer », etc.) puis cliquez sur OK pour transférer les copies des fichiers de photos souhaités.

6. Une fois que les photos sont transférées sur votre disque dur, vous pouvez déconnecter 'appareil photo. Il est
possible que Windows 2000 fasse apparaitre un avertissement disant que vous avez déconnecté un dispositif USB
sans arréter ou éjecter le disque d’abord (vos fichiers de photos ne seront pas endommagés). Si C’est le cas, cochez la
case qui ajoute une icone au plateau ou 2 la barre de tiches. Ainsi, la prochaine fois que vous finissez de transférer
vos photos, vous pouvez cliquer d’abord sur cette icone et arréter le « dispositif de stockage de masse USB » avant
de déconnecter 'appareil.

Remarque : Si votre ordinateur ne peut lire les fichiers de film .avi avec Windows Media Player, vous
devrez peur-étre télécharger une version de Media Player ou DirectX plus récente chez Microsoft.com.
11 est également possible de lire les fichiers de film avec QuickTime Player, figurant sur de nombreux
ordinateurs ou pouvant étre téléchargé gratuitement chez Apple.com.
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Téléchargement de photos et clips vidéo a un ordinateur - étape par étape (suite)

7. Vous pouvez dés maintenant ouvrir les fichiers de photos dans n'importe quel logiciel d’édition de photos.
Utilisez simplement Fichier>Ouvrir et allez dans le dossier oli vous avez enregistré les photos précédemment. Si
vous utilisez PhotoSuite, sélectionnez Fichier>Ouvrir photo puis utilisez le menu déroulant « Regarder dans » en
haut de la fenétre Ouvrir, sélectionnez « Mon ordinateur », sélectionnez votre disque dur et faites un double clic
sur n'importe quelle photo du dossier oli vous avez copié les fichiers de I'appareil photo. Il est également possible
d’ouvrir les fichiers et de travailler sur les photos directement a partir de I'Instant Replay, pendant qu'il est encore
connecté. Pour faire cela avec PhotoSuite, commencez par effectuer les opérations 1 4 3 puis ouvrez PhotoSuite ;
sélectionnez Fichier>Ouvrir photo et utilisez le menu « Regarder dans » pour sélectionner « Mon ordinateur »
puis le « disque amovible » et ouvrez les dossiers s’y trouvant jusqu’aux fichiers de photos JPEG. Si vous choisissez
de travailler de cette maniere, 4 partir de 'appareil photo connecté, n'oubliez pas de sauvegarder la photo (quand
vous avez fini de I'éditer) sur votre disque dur et non pas sur la mémoire ou la carte de 'appareil. Pour faire
cela dans PhotoSuite, apres avoir cliqué sur « Done » (terminé), répondez & « Save Changes? » (sauvegarder les
modifications?) par « Yes » (oui), mais répondez a « Replace Existing File? » (Remplacer le fichier existant?) par
«No » (non) et utilisez la boite de dialogue « Save As » (sauvegarder en) pour sauvegarder la photo éditée dans
un dossier de votre disque dur (« Save In>Local Disk ») (sauvegarder dans>disque local), et non pas le « disque
amovible » (appareil photo).

8. Si vous débutez dans I'édition de photos sur un ordinateur, consultez le menu d’aide du logiciel (PhotoSuite
comporte une aide intégrée trés compléte) pour les conseils dutilisation des fonctions. En plus de pouvoir régler
la luminosité, le contraste, la netteté et la couleur de vos photos, vous pouvez changer leur taille pour qu'elle
corresponde au papier si vous les imprimez, ou encore sauvegarder un fichier plus petit, a résolution basse ou
moyenne, pour pouvoir I'envoyer par courrier électronique ou I'insérer dans des documents. Quand vous étes
prét a sauvegarder votre fichier édité, vous pouvez utiliser « Sauvegarder comme » et lui donner un nom plus
descriptif que « I00BN___ ». Cette opération préserve aussi le fichier d’origine qui peut étre réouvert et remodifié
ultérieurement. Vérifiez que vous avez bien transféré toutes les photos que vous souhaitiez conserver avant
d’utiliser la fonction Effacer tout sur I'appareil photo, afin de créer de 'espace pour les nouvelles images.
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Référence de capacité de stockage de photos (capacit¢ maxi +/- 2 photos)

Taille d’image

Mégapixels
(approx.)

Qualité *

Mémoire
interne**

Carte SD
64 Mo

L2048 x
1536

3,1

FQ

15 photos

60 photos

NQ

31

124

EQ

62

248

M 1600 x
1200

2,1

FQ

25

100

NQ

51

204

EQ

102

408

S 640 x 480

0,35

FQ

160

640

NQ

321

1284

EQ

642

2568
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* Sélectionne le degré de compres-
sion de fichier (taux jpg).
(FQ=faible/EQ=forte)

FQ: Haute qualité (1:4)

NQ: Qualité normale (1:8)

EQ: Qualité économie (1:16)

**Mémoire vive interne disponible
pour les fichiers de photos :

16 Mo

La taille d’'image désigne le
nombre de pixels ou la résolution
du fichier numérique.

La capacité de stockage réelle varie
selon le contenu de chaque fichier
de photo. Il est possible que vous
puissiez prendre quelques photos
de plus ou de moins que la ca-
pacité moyenne indiquée.

Utilisez les réglages de grande
taille et de haute qualité pour les
photos que vous voudrez agrandir
ou recadrer ultérieurement. Si
nécessaire, il est aussi possible

de réduire la taille du fichier a
Iaide du logiciel photo. Utilisez
les réglages de petite taille et/ou
qualité inférieure si vous envoyez
seulement les fichiers par courrier
électronique, si vous les insérez
dans des documents, si vous faites
de petites impressions et si vous
ne voulez pas changer la taille du

GARANTIE LIMITEE DE DEUX ANS

pouvez aussi contacter Bushnell au :

“Vanuats-Searc And-Downtoad:

Votre produit Bushnell® est garanti exempt de défauts de matériaux et de fabrication
pendant deux ans apres la date d'achat. Au cas ot un défaut apparaitrait sous cette
garantie, nous nous réservons l'option de réparer ou de remplacer le produit, 2 condition
de nous le renvoyer en port payé. La présente garantie ne couvre pas les dommages
causés par une utilisation, une manipulation, une installation incorrecte(s) ou un
entretien incorrect ou fourni par quelqu'un d'autre qu'un centre de réparation agréé
par Bushnell.

Tout retour effectué dans le cadre de la présente garantie doit étre accompagné des
articles indiqués ci-dessous :

1) un chéque ou mandat d'une somme de 10,00 $ US pour couvrir les frais

d'envoi et de manutention
2) le nom et I'adresse pour le retour du produit
3) une description du défaut constaté
4) la preuve de la date d'achat

5) Le produit doit étre emballé soigneusement, dans un carton d'expédition
solide, pour éviter qu'il ne soit endommagé durant le transport ; envoyez-le

en port payé, a I'adresse indiquée ci-dessous :

Aux Erats-Unis, envoyez a:

Au CANADA, envoyez a:

Bushnell Performance Optics
Attn.: Repairs

8500 Marshall Drive
Lenexa, Kansas 66214

Attn.: Repairs

Pour les produits achetés en dehors des Etats-Unis et du Canada, veuillez contacter votre
distributeur local pour tous renseignements concernant la garantie. En Europe, vous
BUSHNELL Performance Optics Gmbh
European Service Centre
MORSESTRASSE 4

D- 50769 Cologne
Allemagne

Tél: +49 (0) 221 709 939 3
Fax: +49 (0) 221 709 939 8

La présente garantie vous donne des droits légaux spécifiques.
Vous pouvez avoir d'autres droits qui varient selon les pays.

©2005 Bushnell Performance Optics

Bushnell Performance Optics

25A East Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

Remarque relative a la FCC (Commission fédérale des
télécommunications)

Cematériel aété testé ets’est révélé étre conforme aux limites
d’un dispositif numérique de classe B, conformément a la
section 15 de la réglementation FCC. Ces limites ont été
établies pour assurer une protection raisonnable contre
les parasites nuisibles dans les immeubles résidentiels.
Ce matériel produit, utilise et peut émettre de I'énergie
radiofréquence ; en conséquence, s'il n'est pas installé et
utilisé en conformité avec les instructions, il risque de
provoquer des parasites nuisibles aux communications
radio. Toutefois, il n'est pas garanti que des parasites ne
se produiront pas dans une installation particuliere. Si ce
matériel causait des parasites nuisibles a la réception radio
ou télévision, qui peuvent étre déterminés en mettant le
matériel hors tension puis sous tension, l'utilisateur peut
essayer de remédier au probléme en appliquant I'une ou
plusieurs des mesures suivantes :

- Réorienter ou déplacer I'antenne de réception.

- Augmenter la distance séparant le matériel du récepteur.
- Connecter le matériel 2 une prise de courant ou a un
circuit différent(e) de celui (celle) auquel (a laquelle) le
récepteur est relié.

- Consulter le concessionnaire ou un technicien radio/TV
expérimenté.

Le cable d’interface blindé doit étre utilisé avec le matériel
afin d’étre conforme aux limites d’un dispositif numérique,
conformément 2 la sous-section B de la section 15 de la
réglementation FCC.

Les spécifications et conceptions sont sujettes A
modification sans préavis ni obligation de la part du
fabricant.
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iLo felicitamos por su eleccién del Compact Instant Replay™ Bushnell® El Compact Instant
Replay es ideal para todos los eventos deportivos y la observacién de la naturaleza, ya que
combina un binocular compacto de potencia 8 de alta calidad con una cdmara digital de 3.2
megapixeles muy dtil. El Compact Instant Replay tiene “doble personalidad”, ya que es capaz
de tomar fotografias fijas digitales de alta resolucién como también filmar clips de video
que se repiten (loop) automdticamente, o renuevan, cada 8 a 60 segundos (dependiendo de
los ajustes de calidad). jEsto da la seguridad de que siempre captard el punto cumbre de la
accion! Las fotografias y los videos se almacenan automdticamente en la memoria interna,
o una tarjeta Secure Digital (SD, por sus siglas en inglés /tarjeta digital segura), y se pueden
examinar instantdneamente en la pantalla LCD, reproducir en un televisor, o descargar a su
computadora sin necesidad de instalar ningtin software especial (Con Windows 2000, XP o
Mac. Para Windows 98/98SE se provee software).

Antes de usar su nuevo Compact Instant Replay, lea las instrucciones contenidas en este

manual y témese el tiempo para aprender el funcionamiento de la cdmara y sus muchas otras
caracteristicas.
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GUiA RAPIDA: COMPACT INSTANT REPLAY 11-8323 BUSHNELL

1

Instalar las pilas
y (opcional) la
tarjeta SD

Inserte 2 pilas AAA (vea las “Especificaciones”) en el compartimiento para pilas situado en la parte
inferior del dispositivo (pod) de la cdmara (Nétese la indicacién de polaridad adentro). También, para
contar con mayor capacidad de almacenamiento para fotografias, puede instalar una tarjeta de memoria
SD (opcional) en la ranura para tarjeta, ubicada en la parte trasera del dispositivo (pod)de la cdmara
(Tire hacia abajo la cubierta de goma de la ranura. Inserte la tarjeta con la etiqueta hacia abajo hasta
sentir un chasquido (clic) y coloque la cubierta de goma nuevamente).

Encienda la
cdmara

Levante la pantalla LCD, utilizando la lengiieta en la parte trasera. Oprima y suelte el botén POWER
(Encendido). La pantalla de inicio empezard a destellar, después se apagard y el LED rojo permanecerd
encendido. Oprima “LCD/Mode” (LCD/Modalidad) para encender nuevamente la pantalla. Verd una
imagen preliminar “en vivo” desde la lente de la cdmara, ubicada entre las lentes del objetivo del bin-
oculgar. La pantalla se apagard automdticamente después de 2 minutos para ahorrar energfa de las pilas
cuando la cdmara estd inactiva. También puede apagar manualmente la pantalla oprimiendo el botén
LCD/Mode. No necesita estar encendida para tomar una fotograffa. Toda la cdmara se apagard au-
tomdticamente después de 5 minutos de estar inactiva (no se oprime ningtin botén). Para apagar manu-
almente, oprima y suelte el botén POWER. Los ajustes predeterminados de la cdmara proporcionardn
una calidad éptima en la mayoria de las condiciones. Sin embargo, recomendamos leer el manual completo
para aprovechar las tantas opciones disponibles en los diversos meniis para distintas situaciones fotogrdficas y
preferencias personales.

Formatee la
tarjeta SD
(opcional)

Si inserté previamente una tarjeta SD, formatéela antes de usar la cdmara. Oprima el botén Menu/OK
(Menti/Aceptar) en el centro (fel teclado plateado. Oprima la flecha Hacia abajo 4 veces para seleccionar
“Format” (Formato). Oprima la flecha Hacia la derecha y después la flecha Hacia la izquierda para selec-
cionar “S{”. Use la flecha Hacia abajo para seleccionar “Exit” (Salir) y oprima OK (Aceptar).

Ajuste el bin-
ocular a sus ojos

Si estd usando anteojos, baje las ojeras de goma. Ajuste la distancia entre los tubos izquierdo y derecho
del binocular mientras mira por el mismo hasta que la vista aparezca como una sola imagen circular.
Después, busque un objeto distante con detalles finos, y ajuste la perilla de enfoque central hasta que
el ogjeto aparezca bien nitido por el ocular izquierdo. Ahora, mire por el ocular c(llerecho solamente. Si
el objeto no aparece igualmente nitido, gire el ocular derecho (ajuste diéptrico) hasta que también esté
nitido. Una vez ajustado, no serd necesario mover este ajuste diéptrico, y puede simplemente enfocar
utilizando la perilla de enfoque central.
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GUiA RAPIDA: COMPACT INSTANT REPLAY 11-8323 BUSHNELL

5

Tome una foto
o grabe un
video

Sujete la cdmara bien fija con ambas manos y oprima el botén SNAP (Instantdnea) para tomar una foto-
graffa fija. Escuchard un pitido (lo puede apagar), seguido por una breve pausa (se visualiza el icono de
archivo) mientras la cdmara guarda la fotograffa en la memoria. Para filmar un video, oprima Menu/OK
una vez y después la flecha Hacia la derecha, para ver las opciones de video en el menu de la cdmara.
Use las flechas Hacia arriba y Hacia abajo para seleccionar Replay (reproducir) o Normal (continuo), y
después oprima Menu/OK. De esta forma regresard a la pantalla de imagen preliminar en vivo, y puede
comenzar a filmar el video en cualquier momento oprimiendo el botén SNAP. Para parar la grabacién
de video, oprima SNAP nuevamente. Lea la seccion “Modalidades de video” para una explicacién en detalle
de la forma en que difieren las modalidades de video Normal y Replay, incluso cémo determinar el tiempo de
grabacion del video.

Examine y
borre fotos/
videos

Para examinar o reproducir una fotograffa fija o un video, oprima el botén LCD/Mode (oprima dos
veces si la pantalla no estaba activa). Verd la fotograffa fija o video mds reciente (primer fotograma).
Para examinar fotograffas o video previos, uno a la vez, oprima la flecha Hacia la izquierda. El icono
en la esquina inferior derecha de la pantalla indicard si el archivo de revisién actual es una fotografia
fija, un video normal o “instante replay “ (reproduccién instantdnea). Los niimeros encima de este
icono muestran el nimero de archivo actual/total de archivos (2 de 3, etc.). Para reproducir un video
almacenado, oprima la flecha Hacia abajo (oprimala nuevamente para detener la reproduccién). Para
ver instantdneamente imdgenes en miniatura de varias fotos/video almacenados, oprima la flecha Hacia
arriba después de entrar a la modalidad Review (Revisar). Utilice las flechas para seleccionar un archivo
individual, después oprima la flecha Hacia arriba nuevamente para ver el fotograma completo. Para bor-
rar fotos/videos, oprima Menu/OK y después la flecha Hacia abajo una vez (icono de Papelero). Oprima
la flecha Hacia la derecha, seleccione Delete One (Borrar uno) o Delete All (Borrar todo) y después
oprima la flecha Hacia la derecha y seleccione Si. Regrese a la columna Mend, seleccione Exit (Salir) y
oprima Menu/OK para regresar a la pantalla Review (Revisar).

Conéctese a la
computadora
y transfiera
fotografias

Antes de conectar la cdmara, instale el controlador del CD-ROM si utiliza Windows 98/98SE, e instale
PhotoSuite si no tiene instalado un software de edicién de fotograffas. Conecte el cable USB suminis-
trado desde el receptdculo USB de la cdmara (en la parte trasera del pod) al puerto USB en su computa-
dora. Si tiene Windows XD, siga las instrucciones/opciones en pantalla que aparecen automdticamente.
Si tiene Win 98 6 2000, abra “Mi computadora” en su computadora. La cdmara estd identificada como
un “Disco removible”. Sus fotograffas estén en las carpetas dentro del mismo, simplemente arrastre o
copie/coloque en cualquier carpeta en su unidad de disco duro. Remitase a la seccién “Transferencia de
fotografias” en este manual.

|
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Especificaciones técnicas

Aumento 8x Tamafio de archivo de fotos fijas 2048x1536, 1600x1200, 640x480
(resolucién)

Didmetro del 30mm Relacién de compresién del 1:4 (FQ), 1:8 (NQ), 1:16 (EQ)

objetivo archivo (calidad)

Pupila de salida 3.75 Memoria interna Memora Flash 16MB

Campo visual

320 pies a 1000 yardas

Expansién de memoria

Tarjeta Secure Digital, capacidad hasta 1 GB

Descanso ocular

13mm

Formato del archivo (Fija/Video)

JPEG /MJPEG (AVI)

Recubrimiento de
la lente

Completamente
recubierta

Administracién del archivo

Formato DCF (Versién 1.0), FAT 16

Tipo de prisma

Techo, BK-7

LCD

1.5 TFT, 120,480 pixeles

Alcance de enfoque

18 pies ~ infinito

Resolucién de video/frecuencia

620x480 or 320x240 pixeles por imagen / 30 6 15 imdgenes/se-

(binocular) de imagen gundo (ips). Longitud del loop modalidad Replay 8/15/30/60
segundos (por resolucién/ips seleccionada)
Peso 14.3 02/ 406.5 g Salida de video NTSC/PAL, via un puerto USB de 8 clavijas USB con cable

especial(incluido)

Tipo de sensor

CMOS

Rango del valor de exposicién

+/- 2 EV en incrementos de 0.5 EV

1/1000 segundos

Efectivo 3.2 megapixeles Opciones de equilibrio de blanco | Auto, Difa, Nublado, Fluorescente, Incandescente
Color color 24 bits Escenas prefijadas Programa, Deportes, Paisaje, Retrato, Noche
Obturador Electrénico, 1/16 a Idiomas del Mend Inglés, espafiol, francés, alemdn, italiano, portugués, japonés

Alcance de enfoque
(cdmara)

Fija, aprox 60 pies ~

infinito

Apagado automdtico (después de
inactividad)

Pantalla LCD 2 minutos / Todo apagado: 5 minutos.

V=P

K/rilr? Download

Fuente de alimentacién

2 pilas AAA, alcalinas/litio/NiMh
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Identificacion de las piezas

Pantalla LCD

Botén LCD/Mode

Teclado de 5
vias con botén

Menu/OK

Perilla de en-
foque central
(binocular)

Botén ,
Power on
(Encen- Snap
dido)
: < Ajuste
T diéptrico

Puerto USB/Salida de video

Ranura para tarjeta SD

Download from Www.Somanuals.com. All M

Iconos de pantalla LCD de imagen preliminar

Pantalla preliminar de fotos fijas

G

543

Video normal T’ideo/Replay
(Reproduccién)

Pantalla de filmacién (video)

P W Y } '
CIT AU DOWMoaa:

# | Icono # | Icono
1 | Indicador de pila (se ilustra 2/3 energfa) 1 | Indicador de pila (llena)
2 | N° de fotos restante (basado en memoria disponible) 2 | Segundos totales de video
3 | Modalidad de fotograffa fija disponible (basado en la
memoria disponible)
4 | Calidad (compresién del archivo) Fina/NormallEcondmica - - -
Modalidad Filmacién
5 | Resolucién (tamafio de archivo) Grnde/Mediano/Pequeiio -
4 | Resolucién (FQ=640x480/
6 Equilibrio de blanco No se visualiza salvo que sea cambiado de “Auto” pred NQ=320x240)
minado en Exposicién
7 | & I . S ) 5 | Frecuencia de imagen
cena No se visualiza salvo que sea de “Program”p en el menti Mode (306 15 lp.f)
Modalidad de filmacién secuencial No se visualiza salvo que se seleccione
en el menii
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Instalacion de las pilus

Invierta el Compact Instant Replay, y abra la tapa de las pilas deslizdndola en el
sentido que se muestra a la derecha. Inserte 2 pilas AAA alcalinas o de litio en el
compartimiento, en el sentido indicado por los diagramas en el interior, y deslice la
tapa de vuelta a su lugar hasta sentir un chasquido (clic). Nota: También se pueden
usar pilas recargables tipo NiMbh, pero algunos modelos no suministran corriente
adecuada para alimentar el Instant Replay. Se recomienda usar pilas NiMh con una
corriente nominal de 2300 mAh o mayor.

La cdmara tiene capacidad para guardar desde 15 hasta aproximadamente 642
fotograffas en la memoria interna de 16 MB, dependiendo de los ajustes de resolucién
y calidad (remitase a la tabla al final de este manual). Para expandir el almacenamiento
disponible, se puede afiadir una tarjeta de memoria tipo Secure Digital (SD - Digital
seguro) opcional, de cualquier capacidad hasta 1 GB. La tarjeta se inserta en la ranura
en la parte trasera del pod de la cdmara, como se muestra en el tltimo diagrama.
Inserte la tarjeta SD con el lado de etiqueta hacia abajo. Nota: Cercidrese de que
la corriente estd apagada antes de insertar o retirar las tarjetas, para prevenir
la posible pérdida de archivos o daiio a la tarjeta. No es necesario formatear una
tarjeta nueva, pero una que ha sido previamente usada en otros aparatos debe ser
formateada por el Compact Instant Replay antes de poder guardar fotograffas en
ella (Vea “Menu Setup (Ment Configuracién) en la seccién siguiente. Nétese que
esto borrard todos los archivos previamente almacenados en la tarjeta, por lo tanto

56 asegurese de descargarlos o copiarlos primero si desea conservarlos.

Tapa del compartimiento

para pilas

Ranura para tarjeta

(levantar la tapa)

Configuracion basica del binocular y la camara

Antes de tomas fotograffas o videos, dedique unos minutos a configurar su Compact Instant Replay para propia vista y las preferencias
del usuario. Le sugerimos dejar las ojeras de goma levantadas si no estd usando anteojos, en caso contrario, bdjelas. Agarre los lados
izquierdo y derecho del binocular, y apdrtelo o jintelo mientras mira por el binocular para ajustar la distancia entre oculares hasta que
su vista sea una sola imagen circular. Busque un objeto distante con detalles finos (4rbol, fetrem, muro de ladrillos, etc.) y ajuste la
perilla de enfoque central hasta que el objeta aparezca bien nitido al verlo por el ocular izquierdo del binocular solamente. Después,
mirando al mismo objeto por el lado derecho del binocular, gire simplemente el ocular derecho hasta que su ojo derecho vea la ima-
gen igualmente nitida. Esto se llama ajuste didptrico, y compensa cualquier diferencia que haya en la vista entre el ojo izquierdo y el
derecho. Una vez que estd ajustado ejecutando el procedimiento inicial, deje el ajuste didptrico tal cual y use solamente la perilla de
enfoque central para enfocar nitidamente los objetos situados a cualquier distancia mirando por el binocular (la distancia minima de
enfoque es aproximadamente 16 pies).

Sus fotos digitales y videos no son afectados por la perilla de enfoque central, ya que la lente de cdmara ubicada entre las lentes del
objetivo del binocular no requiere enfoque. Estd preajustada de tal modo que los objetos ubicados desde aproximadamente 60 pies
hasta infinito siempre estardn enfocados. Nétese que el binocular es capaz de enfocar mds cerca (a una distancia menor) que la cdmara.
Vea la imagen preliminar en vivo en la pantalla LCD para cerciorarse de que estd lo suficientemente alejado para obtener fotograffas
nitidas. La lente de la cdmara proporciona un aumento de 8x, lo cual es igual a la éptica del binocular, y est4 alineada de tal mofo que
un objeto centrado en la vista del binocular también lo estard en sus fotografias o videos. Por lo tanto, no es necesario tener la pantalla
LCD encendida o incluso levantada mientras se toman fotograffas o videos. Al reducir el uso de la pantalla LCD se prolongard signifi-
cativamente la vida util de las pilas.

Silo desea, puede ingresar al ment de la cdmara y poner la fecha correcta antes de usar la cdmara por primera vez. Levante la pantalla
LCD y oprima el botén POWER. Después que la luz roja se ilumina, oprima LCD/Mode para activar la pantalla. Oprima el botén
Menu/OK en el centro del teclado y después oprima la flecha Hacia abajo 3 veces para ir al mend “Configuracién” (Setup). Oprima
la flecha Hacia la derecha una vez, seguida por la flecha Hacia abajo para llegar a “Date” (Fecha). Después, oprima la ﬂecﬂa Hacia la
derecha dos veces para entrar a la configuracién de la fecha. Use las flechas Izquierda/Derecha para seleccionar la parte de la fecha que
quiere cambiar, después oprima las flechas Hacia arriba o Hacia abajo para hacer los cambios. Para cambiar el formato de la fecha de tal
modo el mes, dfay afio queden en el orden deseado, desplécese al icono “flechas” en la parte superior izquierda de la pantalla de la fecha
y oprima las flechas Hacia arriba/Hacia abajo. Ajuste la hora (formato de 24 hrs.) con los 4 nimeros ubicados en la parte inferior de
la pantalla de fecha, de tal forma que la fecha cambie autométicamente a medianoche para el lugar en que usted se encuentra. Una vez
que la fecha y hora estdn ajustadas, oprima el botén Menu/OK una vez, y nuevamente para guardar sus ajustes y salir. Después puede
oprimir la flecha Hacia abajo y escoger si desea que la fecha aparezca en la pantalla y en sus fotograffas o no (“Show Date On/Off”)
(Mostrar fecha Activado/Desactivado). Siga oprimiendo la flecha Hacia la izquierda hasta que regrese a “Setup”, despldcese hacia abajo
a “Exit” (Salir) y oprima Menu/OK. 57
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Tomar fotografias fijas

Después de ejecutar la configuracién inicial como se describe en las pdginas anteriores, usted estd preparado para tomar una fotograffa:

1) Levante la pantalla LCD y oprima brevemente el botén POWER (el LED rojo se ilumina). Oprima el botén LCD/Mode para activar
la pantalla LCD si desea ver una imagen preliminar o verificar los ajustes de menu, condicién de las pilas, etc.

2) Al encender por primera vez el Compact Instant Replay regresard a los valores de resolucién y calidad mds altos, como también a
“todo en automdtico”, para que usted pueda tomar excelentes fotografias inmediatamente. Si prefiere usar diferentes configuraciones,
consulte la seccién “Utilizacién del mend principal” para obtener instrucciones respecto a cémo encontrar y cambiar las configuraciones
tales como resolucién y exposicién, usando valores prefijados de escenas para temas comunes y otras opciones.

3)Puede componer sus fotograffas mientras observa por el binocular (la pantalla LCD no tiene que estar activada para tomar una foto-
graffa). Sin embargo, para obtener un ajuste mds exacto de la imagen, se recomienda ver la imagen preliminar en la pantalla LCD.

4) Cercidrese de no estar a menos de 60 pies aproximadamente de su blanco. La éptica del binocular enfocard a una distancia menor que
esta, pero el foco de la cdmara estd prefijado para obtener mejores resultados con objetos distantes (no es necesario enfocar la cdmara).
Se puede utilizar la pantalla LCD para verificar si el objeto estd demasiado cerca para obtener resultados nitidos.

5) Mantenga la cdmara tan firme como sea posible con ambas manos y apriete lentamente el botén SNAP. La pantalla se oscurecerd
brevemente mientras el archivo se almacena (se visualiza el icono de carpeta), entonces usted estd preparado para tomar otra fotograffa.
El contador situado en la esquina inferior derecha cambiard para indicar la capacidad restante para fotografias, la cual depende de la
cantidad de memoria interna o de tarjeta disponible, como también los ajustes de resolucién y calidad (puede reducur los a)ustes en
cualquier momento para guardar una mayor cantidad de fotografias en la memoria restante). Nota: El dor no siempre di ye
un niimero después de que se toma cada fotografia, dependiendo de estos ajustes y el contenido real del archivo por foto. Cuando el contador
llega a “000”, la memoria (espacio de almacenamiento)estd llena y deberd descargar las fotografias que desea conservar para asi poder después
borrarlas, o puede sacar la tarjeta SD e instalar una nueva.

6) Hay un zoom digital hasta 6x disponible. Oprima la flecha Hacia la derecha para acercar (ampliar) la imagen (verd el resultado en la
pantalla LCD). Oprima la flecha Hacia la izquierda para alejar (reducir) la imagen.

7) Oprima el botén LCD/Mode si desea ver la fotografia después de haberla tomado, y luego oprimalo nuevamente para regresar a
una imagen preliminar en vivo. Remitase a la seccién “Mend de revisién” para mds informacién respecto a la revisién y borrado de las
fotograffas tomadas.
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Tomar videos Normal o “Instant Replay”

1) Ejecute los pasos 1 al 4 de la pdgina anterior, “Tomar fotograffas fijas”

2) Para cambiar de fotograffas fijas a cualquiera de las dos modalidades de video, oprima el botén Menu/OK. El primer grupo de ment
es “Camera” — oprima la flecha Hacia la derecha, después use las flechas Hacia arriba o Hacia abajo para seleccionar la modalidad de
video Normal o Replay (la cdmara regresard a la pantalla de imagen preliminar en vivo después de seleccionar una modalidad de video,
de tal modo que usted estd preparado para comenzar a tomar un video inmediatamente. En cualquiera de las dos modalidades, oprima
el botén SNAP para grabar un nuevo clip de video, y oprimalo nuevamente para detener la grabaci’n y guardar el video en la memoria.
A continuacién explicamos en qué difieren las dos modalidades de video:

Modalidad de video Normal — esta modalidad tomard un video continuo que comienza cuando se oprime el botén SNAP y finaliza
cuando se oprime nuevamente. El tiempo de grabacién estd limitado solamente por la cantidad de memoria interna o de tarjeta actual-
mente disponible. Se puede grabar un solo video largo hasta que se llena la memoria, o multiples videos mds cortos parando e iniciando
la grabacién cada vez que lo desea, oprimiendo el botén SNAP. El contador indica el tiempo aproximado(en segundos) de grabacién
restante disponible al parar, e inicia la cuenta regresiva del tiempo restante cuando se inicia la grabacién de video Normal.
Modalidad de video Replay — funciona de otra manera; al final de un limite de tiempo predeterminado (determinado por la resolucién
del video y la frecuencia de imagen configuradas en el mend Setup (Configuracién), el clip de video comienza a “loop”, o regrabar,
borrando y sustituyendo los acontecimientos previos. Esto es ideal para captar la accién deportiva, ya que puede comenzar a grabar en
cualquier momento, parar la grabacién inmediatamente después de un “touchdown”, gol u otra accién importante. Tendr4 la seguridad
de que capté el momento cumbre, y no tendrd que buscar entre los videos previos o seguir rebobinando para verlo una y otra vez. Las
longitudes de loop disponibles son 8, 15, 30 6 60 segundos — mientras mds alta la resolucién e imdgenes por segundos, mds corto serd el
loop. En modalidad Replay, el contador indica el tiempo (en segundos) total de grabacién disponible al parar, y cuenta desde cero hasta
el final del limite del tiempo del loop cuando comienza la grabacién. Al final del loop, cuando la regrabacién comienza, el contador se
pone a cero automdticamente y para comenzar otra vez. Nétese que si cesa de grabar en la mitad de un loop “fresco”, su video tendrd la
tltima parte del segmento del loop anterior y la primera parte del nuevo. La cdmara siempre guarda 8, 15, 30 6 60 segundos completos
de los eventos mds recientes. Practique un poco y experimente con la modalidad de Replay para acostumbrarse a su funcionamiento
antes de ir a un juego importante.

3) Oprima el botén LCD/Mode si desea ver un video después de grabarlo. Oprima la flecha Hacia abajo para iniciar la reproduccién,
oprimalo nuevamente para pararla. Oprima las flechas Hacia la izquierda o Hacia la derecha para ver los archivos de fotografias fijas o
video previos. Si oprime la flecha superior visualizard un conjunto de imdgenes en miniatura de multiples archivos. Use las flechas para
destacar el archivo que desea ver, después oprima Menu/OK para seleccionar y verlo. Cuando esté listo para regresar a la pantalla de
imagen preliminar en vivo para tomar mds videos (o fotograffas fijas), oprima el botén LCD/Mode.

4) Remitase a la seccién “Ment de revisién” para mds informacién respecto a la revisién y borrado de las fotografias tomadas. 59
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Utilizacion del mend principal

Tal como lo mencionamos anteriorme':te en est!z’manual, el Compact Instant Replay viene preajustado para su reso-
lucién y calidad més altas posibles. La exposicién, el equilibrio de blanco y otras variables se ajustan automdticamente.
Esto significa que usted obtendrd buenos resultados para la mayorfa de los temas e iluminacion sin necesidad de ir a
los ments y cambiar ninguna configuracién o ajuste. Sin embargo, le recomendamos familiarizarse con las opciones
disponibles de tal modo que pueda mejorar su fotografias si, por ejemplo, decide que estdn saliendo demasiado oscu-
ras (muy comun para escenas de nieve con la mayorfa de las cdmaras), o demasiado verde (bajo algunos tipos de luces
fluorescentes). El ment principal, o de grabacién, estd organizado en seis grupos. Oprima el botén “Menu/OK” para
ver estos grupos. Use las flechas hacia arriba y hacia abajo para seleccionar un grupo, después use la flecha Hacia la
derecha y las flechas Hacia arriba/Hacia abajo para ver los {temes u opciones disponibles dentro del grupo. A continu-
acién encontrard una descripcion general de los grupos del mend y sus funciones:

Utilizacion del menu principal continvacion

Grupo del Icono
mend

Propésito

Grupo del Icono Propésito

mend

Camera Mode Permite seleccionar entre las modalidades de fotograffa fija 0 uno de dos
(Modalidad de n videos (filmacién). Aqui, las opciones del ment siempre muestran dos mo-
cémara) dalidades que no estén actualmente en uso. Por ejemplo, si estd en modalidad

de video “Replay”, las otras opciones se visualizardn en el mend Camera:
@ Modalidad de fotografia fija (icono de cdmara) o modalidad de video Normal

(icono de filmadora con flecha recta).

Proporciona opciones para configurar: Resolucién (tamafio del archivo),
calidad (compresién del archivo), EV (valor de exposicién), WB (equilibrio de
blanco) e ISO (sensibilidad a la luz)

Setup (Configu-

racién)

Prepara para su uso una tarjeta de memoria SD nueva o previamente usada.

Borra (suprime) todos los archivos contenidos en la tarjeta. También se puede
H usar para borrar répidamente todo el contenido interno de la memoria, si no
se ha insertado una tarjeta SD.

Format (Formato)

Exit (Salir) |E! Sale del ment principal y regresa a la imagen preliminar en vivo.

Exposure (Ex- Proporciona opciones para ajustar el WB (equilibrio de blanco) y el EV (valor
posicién) | l:' de exposicién) para ajustar con precisién la representacién del color y la

exposicién para distintas condiciones, si los ajustes automdticos normales no
producen la calidad o los resultados deseados.

Mode (Modali- Permite la eleccién de “Escenas” prefijadas que optimizan los ajustes de la cd-
dad) s mara para acciones de deporte, paisajes y otros temas comunes de fotograffas.
@ En este grupo del ment también se encuentran las opciones de Self Timer
50 B (disparador automdtico o autotemporizador) y Rapid Sequence (secuencia

La pdgina siguiente proporciona una lista de todos los puntos y ajustes disponibles en los grupos del mend Main
(Principal), junto con las descripciones de sus funcién. Ejecute los mismos procedimientos utilizados en el ejemplo
anterior para desplazarse por las pantallas del ment para destacar y cambiar cualquiera de estos ajustes de acuerdo a
sus propias preferencias o necesidades. El ment Review (Revisar)es diferente, pero mds sencillo, con solamente cuatro
grupos (Slide show, Delete, Editor y Exit [Show de diapositivas, Borrar, Editar y Salir]. Remitase a la seccién “Ment
Review” mds adelante en este manual para obtener una descripcién completa.
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Sistema de menvu Pl‘illtip(ll (ajustes predeterminados estdn en negrita)
*Los ajustes de Escena y Secuencia en “Mode” no estiin disponibles cuand la “tdmara” estd configurada para video Normal o Replay.

Sistema del menv Principal continvacion

Grupo Item Configuracién || Descripcién
CAMERA Fotografia fija | Icono de cdmara Fotograffas de imdgenes fijas de 3.2 megapixeles
Video Clip Video normal Graba video continuo esténdar, con el tiempo limitado solamente
(Clip de video) | (Icono de filmadora | por la memoria interna o de tarjeta SD restante.
con flecha recta)
Video Replay (Icono | Graba “loops” de video, regrabando sobre un video previo. Los
de filmadora con loops son de longitud fija (de 8 a 60 segundos), segtin lo determi-
flecha circulando) nado por la resolucién y frecuencia de imagen (ips).
EXPOSURE WB (equilibrio | Automdtico El equilibrio de blanco se ajusta automdticamente para la reproduc-
(Exposicién) de blanco) cién correcta del color.
Dia Ajuste manual para condiciones soleadas al aire libre
Bombilla de luz Ajuste manual para iluminacién (bombilla de luz) de tungsteno
para interior
Fluorescente Ajuste manual para iluminacién fluorescente interior
Nublado Ajuste manual para condiciones de sombra o nublado al aire libre
EV -2.0 - +2.0 Proporciona ajuste manual de sub/sobreexposicién en incrementos

de 0.5 EV. Los valores menos (-) producen fotos mds oscuras, los
valores mas (+) mds claras.
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Grupo | Item Configuracién || Descripcién
MODE Scene * Program Exposicién automdtica estindar para la mayorfa de los temas o uso general
(Modali- (Escena) (Programa)
dad)
Sports (Deportes) | Usa las velocidades mds altas del obturador para ayudar a inmovilizar la imagen.
Landscape(Paisaje) | La zona mds profunda del foco para una nitidez extendida del plano anterior al plano de fondo.
Portrait (Retrato) | Zona llana del foco para fotografias de personas - ayuda a aislar el sujeto del plano de fondo
Night (Noche) Usa las velocidades mds bajas del obturador para exposiciones mejores en poca luz
Self Timer Yes / No La fotograffa se toma después de un retardo al oprimir el botén SNAP
(Disparador
automdtico)
Sequence * 3 6 5 disparos 3 6 5 imdgenes tomadas en secuencia rdpida al oprimir el botén SNAP
(Secuencia)
SETUP Size/Quality Image Size 3 opciones para tamaio de imagen: L(2048x1536 pixeles), M (1600x1200 pixeles) o S (640x480
(Configu- | (amafio/calidad) | (Resolution) pixeles) Los ajustes mds altos de resolucién producen fotos impresas mds nitidas/grandes, pero
racién) (Fotograffa fija) reducen el espacio total de almacenamiento disponible. Use ajustes mds bajos para guardar més en
la memoria, o para correo electrénico, etc. L=3.1MP / M=2.1MP / $=0.35MP
Quality Fija la cantidad de compresién del archivo jpg. Los ajustes son: Fino-FQ (1:4 compresién),
(Relacién de Normal-NQ (1:8) y Econémico-EQ (1:16). Esto puede usarse independientemente del tamafio de
compresién del | la imagen para ayudar a guardar mds fotos a cambio de una calidad ligeramente reducida.
archivo)
En modalidad | Calidad 640x480 pixeles por imagen (Resolution)> a 30 6 15 imdgenes por segundo (frecuencia de
de video Nor- (Resolution imagen) 320x240 pixeles por imagen a >30 6 15 imdgenes por segundo
mal solamente & FPS (Después de seleccionar la resolucién, oprima la flecha Hacia la derecha para seleccionar la
frecuencia de imagen (ips - imagen/segundo)
En modalidad Quality 640x480 pixeles por imagen (Resolution)> a 30 6 15 imédgenes por segundo (frecuencia de imagen)
de video Replay | (Resolution 320x240 pixeles por imagen a >30 6 15 imdgenes por segundo
solamente & FPS La duracién del loop de 8, 15, 30 6 60 segundos depende de la resolucién y la frecuencia de imagen (ips).
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Sistema del menu Principal continvacion

Grupo Item Configuracién | Descripcién
Date (Fecha) | Setup, Permite configurar la fecha/hora correcta para su zona. Si selecciona “ON”
On/Off (activado), la fecha aparecerd en la pantalla e impresa en todas las fotografias.
Storage (Alma- | Auto Los archivos se guardan en la tarjeta SD, si estd insertada, de lo contrario en la
cenamiento) RAM interna
SD Los archivos se guardan en la tarjeta SD solamente (debe estar insertada)
Internal Los archivos se guardan en la memoria interna solamente, nunca en la tarjeta
Language 7 disponibles | Selecciona el idioma preferido para todas las pantallas del mentd
(Idioma)
Rec View Off/1-3 sec Selecciona el limite de tiempo de la pantalla de revisién automdtica después de
(Ver grab.) tomada la fotograffa
File name Reset/Series | Ajusta el sistema de numeracién de los archivos. Si se selecciona Reset (puesta a cero),
(Nombre de después de borrar todos los archivos en la memoria interna o de tarjeta, los ndmeros
archivo) de archivo para las fotograffas nuevas comienzan nuevamente en “000”. Si se selec-
ciona Series, los nimeros de archivos para las foto&igraﬁ'as nuevas comenzaran en el
ndmero siguientes después del tiltimo nimero utilizado para los archivos previos.
Beep (Zum- | On/Off Enciende o apaga el pitido de alerta
bador)
Reset all Yes / No Al seleccionar “Si” restablece todas las configuraciones (ajustes) a los predetermi-
(Reposicio- nados originales (indicados en negrita)
nar todo)
FORMAT | Format Yes / No Formatea la tarjeta para los archivos del Compact Instant Replay. Borra todo el
(Formato) (Formato) contenido.
EXIT (Salir) Sale del sistema de mend y regresa a imagen preliminar en vivo

Ver los iconos de visuvalizacion

# | Icono

1| Fecha del archivo de fotograffa o video (La funcién de fecha debe estar
configurada y activada)

Ubicacién del archivo de revisién actual (memoria interna o tarjeta SD)

Resolucidn del archivo de revisién actual

Calidad (compresién del archivo) del archivo de revision actual

(2N SN KSO I NS)

Ntmero de archivo actual (ndmero izquierdo): Archivos totales en la
memoria (nimero derecho)

Indica el tipo de archivo (foto fija, video normal, video replay)

7 | Indicador de pilas

Menu Review (Revisar)

Revision y borrado de fotografias y videos

Oprima “LCD/Mode” para entrar a la modalidad Review (Revisar) Use las flechas Hacia la izquierda/Hacia la derecha para
desplazarse por las fotograffas/videos almacenados. Una vez que estd en la modalidad Review, oprima el botén Menu/OK
para ingresar el grupo Revisar de mens. Estos funcionan de la misma manera previamente descrita en las instrucciones

del sistema de ment principal (use las flechas para desplazarse hasta el grupo y opciones de ment deseados, oprima OK
(Aceptar) para confirmar una configuracién), pero con distintos itemes de menti como se muestra aqui:

Grupo Item Configura- || Descripcién

cion
SLIDE Yes / No | Al seleccionar “Yes” (Sf) comienza a presentar una revisién de todas
SHOW las imdgenes que actualmente se encuentran en la memoria interna
(Proyeccién de o de tarjeta, cambiando automdticamente a la imagen siguiente
diapositivas) después de unos pocos segundos.
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Menu Review continvacion

Grupo Item Configuracién | Descripcién
DELETE Delete Yes / No Borra de la memoria la fotograffa o video que se visualiza actual-
(Borrar) One mente. Use las flechas Hacia arriba/Hacia abajo para encontrar el ar-
(Borrar chivo que desea borrar. Para borrar, destaque el icono “Delete One”
uno) (Borrar uno) y oprima “OK” (Aceptar). Después destaque “Yes” (S)
y oprima “OK” para borrar el archivo.
Delete Yes / No Borra todos archivos almacenados. Para borrar todos los archivos,
All (Bor- (excepto los bloqueados - vea mds abajo)destaque el icono “Delete
rar todo) all” (Borrar todo) y oprima “OK”. Después destaque “Yes” (Si)
y oprima “OK” para borrar todos los archivos actualmente en la
memoria.
EDITOR Protect Lock / Cuando se bloquea un archivo de fotograffa o video se impide el
(Editar) (Prote- Unlock borrado accidental. Se puede usar junto con “Delete All” para borrar
ger) (Bloquear rdpidamente todas, excepto una o dos fotografias. Para bloquear la
(Desbloquear) | fotograffa o video actualmente visualizado, destaque el icono “Lock”
(Bloquear) y oprima “OK”. Para desbloquear un archivo previa-
mente bloqueado, selecciénelo usando las flechas Hacia arriba/Hacia
abajo, destaque el icono “Lock” nuevamente, y oprima “OK”.
Rotate -90 Degree Gira el cuadro de la imagen actual 90 grados en cualquiera de las dos
(Girar) or +90 direcciones.
Degree
EXIT (Salir) | Exit Sale del ment Review (Revisar) y regresa a la dltima imagen selec-
(Salir) cionada para revisar.
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Requisitos de sistema (minimo)

OS: Windows® 98/98SE/2000/ME/XP

CPU: MMX Pentium® 200MHZ equivalente o mds répido (Pentium® III 500 MHz para PhotoSu-
ite5™)

Memoria: 32MB minimo (64MB recomendado para PhotoSuite)

Tarjeta de video SVGA con VRAM 2MB, pantalla 800x600, color alto de 16 bits

200 MB de espacio libre en la unidad de disco duro (si va a instalar PhotoSuite)

Puerto USB interno

INSTALACION DEL SOFTWARE

Si estd utilizando Windows 98, deberd instalar los controladores antes de conectar la cdmara a su computadora
(PC). Inserte el CD-ROM en la unidad de disco compacto (CD) de su computadora; funcionard automdtica-
mente y se visualizard la pantalla de instalacién. Seleccione “Install Driver” (Instalar controlador), después siga

las instrucciones. Después de la instalacidn, inicie nuevamente su computadora. Las versionse Windows 2000,

ME y XP no requieren controladores, ya que la cimara utiliza la norma de almacenamiento masivo USB, lo que
permite accesar los archivos de fotos tal como si estuvieran almacenados en una unidad de disco duro exterior. Para
cualquier sistema operativo (OS) Windows, si usted no estd utilizando un software de edicién de fotografias de su
preferencia, puede instalar el programa Roxio PhotoSuite® del CD-ROM. Cercidrese de leer todos los Avisos de
noticias (“Release Notes”), destacando los consejos o problemas potenciales pertinentes a la configuracién y sistema
operativo de su computadora.

Transferencia de fotos y videos a la computadora - Paso por paso

1. Si tiene la versién Windows 98/98SE, cercidrese de instalar el controlador primero.

2. Cercidrese de que el Instant Replay estd encendido y conecte el cable que se suministra al puerto USB de la c4-
mara (abra la cubierta del conector en el lado izquierdo del Replay), después directamente al puerto USB principal
en su computadora. No use los puertos USB en el panel frontal/teclado ni ndcleos multiples sin alimentacién de
energfa.

3. La pantalla LCD se apagard para ahorrar energfa de las pilas, y el Instant Replay serd reconocido por un dis-
positivo de “almacenamiento masivo USB” normal. Esto significa que es muy fécil ver, editar o copiar a su disco
duro los archivos de la cdmara, tal como si estuvieran almacenados en una unidad de disco dura exterior o un 67
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Transferencia de fotos y videos a lu computadora - Paso por paso continvacion

4. (Con la versién Windows XP no se necesita ejecutar este paso, simplemente use las opciones en pantalla para
ver, copiar o editar sus fotografias). Abra Mi Computadora o Windows Explorer. La cdmara serd vista como un
nuevo “Disco removible” y se le asignard una letra de unidad de disco sin usar. Haga doble clic sobre este nuevo
icono “Disk”, abra la carpeta “DCIM” dentro de €, después la carpeta (carpetas) dentro de eso (“100BNxxx” ,etc).
Sus fotograffas/videos son los archivos adentro, tienen el prefijo “PICT__" seguido por un ndimero, como se vio
anteriormente en la pantalla de la cémara cuando revis6 las fotografias. Haciendo un solo clic sobre cualquier archivo
mostrard una sola imagen preliminar pequeiia.

5. Haga clic sobre “Edit>Select All” (Editar>Seleccionar todo) (o haga clic sobre una fotograffa, control+clic para
seleccionar varias fotograffas), después “Edit>Copy to Folder” (Editar>Copiar a Carpeta) (en menus Windows).
Seleccione una carpeta existente en su unidad de disco duro, tal como “My Pictures” (Mis fotos), o cree una carpeta
nueva (“Vacaciones en Hawai”, etc.) y haga clic en “OK” para transferir las copias de los archivos de fotografias que
desea.

6. Tras transferir las fotograffas a la unidad de disco duro, puede desconectar la cdmara. La versién Windows 2000
puede producir en la pantalla una advertencia de que usted desconecté un dispositivo USB sin tener que primero
parar o expulsar el “disco” (sus archivos de fotograffas no se dafiardn). De ser asf, marque la casilla que afiade
un icono a la bandeja o barra de tareas de su sistema. Después, la préxima vez que termine la transferencia de
fotografias, puede hacer clic sobre ese icono primero, y “Stop de USB Mass Storage Device” (Parar el dispositivo de
almacenamiento masivo USB) antes de desconectar la cdmara.

Nota: Si su computadora no acepta archivos de peliculas .avi en Windows Media Player, puede
descargar una version mds reciente de Media Player o Direct X de Microsoft.com. Los archivos de
peliculas también pueden reproducirse con el QuickTime Player, incluido con muchas compuradoras,
o disponible como una descarga gratuita de Apple.com.
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Transferencia de fotos y videos a lu computadora - Paso por paso continvacion

7. Ahora estd preparado para abrir los archivos de fotografias en cualquier software para editar fotografias.
Simplemente use File>Open (Archivo>Abrir) y vaya a la carpeta donde almacené anteriormente las fotograffas.
Si estd utilizando PhotoSuite, seleccione File>Open Photo (Archivo>Abrir foto), después use el mend desplegable
“Look in” (Mirar en) en la parte superior de la ventana Abrir, seleccione “Mi Computadora”, seleccione su
unidad de disco duro, y haga doble clic sobre cualquier fotografia en la carpeta donde copié los archivos de la
cdmara. También es posible abrir y trabajar con las fotografias directamente del Instant Replay mientras estd
conectado. Para hacer esto con PhotoSuite, primero ejecute los pasos 1 al 3, después abra PhotoSuite, seleccione
FileOpen>Photo y use el ment “Look in” para seleccionar Mi Computadora, después seleccione el “Disco
Removible”, y abra las carpetas en su interior hasta llegar a los archivos de fotografias JPEG. Si decide trabajar
de esta manera, desde una cdmara conectada, cerciérese de guardar las fotograffas (una vez terminado de editar)
en su unidad de disco duro, y no en la memoria o tarjeta de la cdmara. Para hacer esto en PhotoSuite, después
de hacer clic sobre “Done” (Terminado), conteste “S{” a la pregunta “Save Changes?” (;Guardar cambios?), pero
entonces conteste “No” a la pregunta “Replace Existing File”? (;Sustituir el archivo existente?) y use el cuadro de
didlogo “Save As” (Guardar como) para guardar las foto editada en una carpeta en su unidad de disco duro (“Save
In>Local Disk” - Guardar en>disco local), no en el “Disco removible” (cdmara).

8. Si estd editando fotograffas por primera vez en su computadora, consulte el ment Ayuda de su software
(PhotoSuite tiene incorporada una Ayuda muy amplia) para obtener consejos sobre el uso de sus funciones.
Junto con el ajuste del brillo, contraste, nitidez y color de sus fotograffas, puede cambiar el tamafio de la foto
para adaptarla al tamafio del papel si la va a imprimir, o guardar una versién de resolucién baja o mediana mds
pequefa para enviar por correo electrénico o insertar en documentos. Cuando esté preparado para guardar su
archivo editado, puede usar “Save As” (Guardar como) y darle un nombre mds descriptivo que “100BN___". De
esta forma también preserva el archivo original como reserva para volver a abrir o editar mds tarde. Cercidrese de
que transfirié satisfactoriamente todas las fotograffas que querfa guardar antes de usar “Delete All” (Borrar todo)

su cdmara para dejarespacio para guardar imdgenes nueva.
Download from Www.Somanuals.com. All Fanusis SEaPeR En@tfog\m O 8 8
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Referencia de la capacidad de almacenamiento de fotografias (capacidad mix., +/- 2 fotografias)
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Tamafio de Megapixeles | Calidad * | Memoria | Tarjeta SD
imagen (aprox.) interna** 64 MB
L 2048x1536 3.1 FQ 15 fotos 60 fotos

NQ

31

124

EQ

62

248

M 1600x1200

2.1

FQ

25

100

NQ

51

204

EQ

102

408

S 640x480

0.35

FQ

160

640

NQ

321

1284

EQ

642

2568
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* Selecciona la cantidad de com-
presién del archivo (relacién jpg)
(FQ=baja/EQ=alta)

FQ: Calidad fina (1:4)

NQ: Calidad normal(1:8)

EQ: Calidad econémica (1:16)

**RAM interna disponible para
archivos de fotografias: 16 MB

El tamafio de imagen se refiere
a las dimensiones en pixeles, o
resolucién, del archivo digital.

La capacidad real de almace-
namiento variard basada en el
contenido de cada archivo de
fotos. Es posible que saque unas
pocas fotos mds o menos que la
capacidad promedio indicada.

Use los ajustes de tamafio grande
y alta calidad para fotograffas que
desea agrandar o recortar mds
adelante. En caso de requerirse,
también las puede reducir a un
archivo mds pequefio usando su
software de fotograffa. Use ajustes
tamafio pequefio y/o baja calidad
si solamente las va a enviar por
correo electrénico, insertar en
documentos, o hacer impresiones
pequefias, y no quiere volver el
archivo al tamafio original més
adelante.

GARANTIA LIMITADA DE DOS ANOS

Su producto Bushnell® estd garantizado contra defectos de material y fabricacién
durante dos afios a partir de la %echa de compra. En caso de defectos bajo esta garantfa,
nosotros, a nuestra opcién, repararemos o sustituiremos el producto siempre que lo
devuelva con portes pagados. Esta garantfa no cubre defectos causados por el uso
indebido, ni por un manejo, instalacién o mantenimiento del producto inapropiados
o elhmalxll[enimiento hecho por otro que no sea un Centro de Servicio Autorizado de
Bushnell.

Cualquier envio que se haga bajo garantia deberd venir acompanado por lo siguiente:

1) Un cheque/giro postal por la cantidad de 10 délares para cubrir los gastos de
manejo y envio

2) Nombre y direccién donde quiere que se le envie el producto

3)  Una explicacién del defecto

4)  Prueba de fecha de compra

5) El producto debe empaquetarse bien en una caja resistente para evitar que se
dane durante el transporte, y enviarse con portes pagados a la direccién que
se muestra a continuacién:

En EE UU, enviar a: En CANADA, enviar a:

Bushnell Performance Optics Bushnell Performance Optics
Atn.: Repairs Atn.: Repairs

8500 Marshall Drive 25A East Pearce Street, Unit 1
Lenexa, Kansas 66214 Richmond Hill, Ontario L4B 2M9

En el caso de los productos comprados fuera de los Estados Unidos o Canadd, llame al
distribuidor local para la informacién pertinente sobre la garantfa. En Europa también
puede llamar al: BUSHNELL Performance Optics Gmbh

European Service Centre

MORSESTRASSE 4

D- 50769 KOLN

ALEMANIA

Tél: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

Esta garantia le ofrece derechos legales especificos.
Puede que tenga otros derechos ?ue varfan de un pafs a otro.
©2005 Bushnell Performance Optics

“Vanuats-Searc And-Downtoad:

Nota de la FCC:

Este equipo ha sido sometido a pruebas y cumple con
los limites establecidos para un aparato digital de Clase
B, de acuerdo con la Parte 15 del Reglamento de la
FCC. Estos limites estdn disefiados para proporcionar
proteccién razonable contra interferencias perjudiciales
en una instalacién residencial. Este equipo genera, emplea
y puede irradiar energfa de radiofrecuencia y, si no se
instalada y utiliza de acuerdo con las instrucciones, puede
causar interferencia perjudicial a las radiocomunicaciones.
Sin  embargo, no garantizamos que no ocurririn
interferencias en una instalacién en particular. Si este
equipo causa interferencias perjudiciales a la recepcién
radial o televisiva, situacién que puede determinarse
apagando y encendiendo el equipo, se sugiere al usuario
que trate de corregir tal interferencia mediante uno o mds
de las siguientes medidas:

- Reorientar o relocalizar la antena receptora.

- Incrementar la separacién entre el equipo y el receptor.
- Conectar el equipo a un tomacorriente en un circuito
diferente al que estd conectado el receptor.

- Consultar con el concesionario o un  técnico
experimentado  en  radio/televisién  solicitdndole
asistencia.

Con este equipo se debe usar un cable de interfaz
blindado para cumplir con los limites para un aparato
digital de acuerdo con la Subparte B de la Parte 15 del
Reglamento de la FCC.

Las especificaciones y disefios estdn sujetos a cambios sin
ningtin aviso u obligacién por parte del fabricante.
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Wir gratulieren zu Threm Kauf der Bushnell® Compact Instant Replay™ Die Compact
Instant Replay ist ideal fiir alle Sportveranstaltungen und Beobachtungen in der Natur,
denn sie verbindet ein hochwertiges kompaktes Fernglas mit 8-facher Leistung mit einer
vielseitigen 3,2 Megapixel Digitalkamera mit erstaunlicher Videoleistung. Die Compact
Instant Replay hat eine “gespaltene Persénlichkeit®, denn sie kann digitale Standphotos
mit hoher Bildauflésung ebenso aufnehmen wie Videoclips, die alle 8 bis 60 Sekunden
»schleifen® oder auffrischen (je nach den Qualititseinstellungen). Dies gewihrleistet, dafl Sie
immer den Hohepunke der Aktion erfassen! Die Fotos und Videos werden automatisch im
internen Speicher abgelegt oder auf einer optionalen SD-Karte (Secure Digital) gespeichert,
und sie kénnen sofort auf dem Aufklapp-Bildschirm gesichtet, im Fernseher betrachtet oder
auf einen Computer heruntergeladen werden, ohne daff hierfiir eine besondere Software
installiert werden miif§te. (Unter Windows 2000, XP oder Mac. Fiir Windows 98/98SE wird
eine Software mitgeliefert).

Bevor Sie Thre neue Compact Instant Replay benutzen, lesen Sie bitte die in diesem

Handbuch gegebenen Anweisungen gut durch, und nehmen Sie sich Zeit, sich mit dem
Betrieb der Kamera und ihren vielen Ausstattungsdetails vertraut zu machen.
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KURZER LEITFADEN: BUSHNELL COMPACT INSTANT REPLAY 11-8323

1

Batterien und
die (optionale)
SD-Karte
einlegen

2 AAA Alkali-Batterien (siche ,Spezifikationen® in das Batteriefach am Boden des Kameragehiuses
einlegen. (Auf die Polarititsangabe innen achten). Es kann auch eine SD-Speicherkarte (Option) in den
Kartenschlitz installiert werden, der sich an der Riickseite des Kameragehiuses befindet. (Den Gum-
mideckel des Kartenschlitzes nach unten ziehen. Die Karte mit dem Etikett nach unten bis zum Klick
cinlegen und den Gummideckel wieder anbringen).

Die Kamera
einschalten

Das LCD Display mit der Zunge an der Riickseite anheben. Den POWER Knopf driicken und los-
lassen. Der Start-Bildschirm des Displays leuchtet auf, geht dann aus, und die rote LED der Strom-
versorgung bleibt an. ,LCD/Mode” driicken, damit das Display wieder einschaltet — Man sicht eine
“live” Vorschau des Bildes von der Kameralinse zwischen den Fernglas-Objektivlinsen. Das Display
geht nach 2 Minuten automatisch wieder aus, um bei unbenutzter Kamera Batterieenergie zu sparen.
Das Display kann auch von Hand mit Driicken des LCD/Mode Knopfes abgeschaltet werden — Fiir die
Aufnahme eines Fotos braucht es nicht eingeschaltet zu sein. Die ganze Kamera schaltet nach 5 Minuten
automatisch aus, wenn sie inaktiv war (keine Knépfe betitigt). Fiir die Stromabschaltung von Hand
den POWER Knopf driicken und loslassen. Die standardmiifsigen Kameraeinstellungen sorgen unter den
meisten Bedingungen fiir optimale Qualitiit. Es wird jedoch empfohlen, das gesamte Handbuch durchzule-
sen, damit die vielen Vfﬁ baren Optionen in den einzelnen Meniis fiir verschiedene Fotobedingungen und
Benutzervorziige vorteil) afg genutzt werden kinnen.

Die SD-Karte
(Option) forma-

tieren

Wenn weiter oben eine SD-Karte eingesetzt wurde, muf§ sie vor der Benutzung der Kamera formatiert
werden. Den Menu/OK Knopf in der Mitte des silbernen Tastenfeldes driicken. Die ,Down® Pfeiltaste
4 mal driicken und ,,Format“ wihlen. Die ,Rechts“ Pfeiltaste driicken, dann die ,,Links“ Pfeiltaste und
,Yes“ wihlen. Menu/OK driicken, es erscheint eine Warnung, dafi alle Bilder geléscht werden, ,,Yes®
wihlen und erneut OK driicken. Mit der ,,Down* Pfeiltaste , Exit“ wihlen und OK driicken.

Die Fernglas-
optiken auf die
Augen einstellen

Brillentriger rollen die Augenmuscheln aus Gummi nach unten. Den Abstand zwischen dem rechten
und dem linken Fernglaszylinder bei gleichzeitigem Durchsehen durch das Fernglas einstellen, bis der
Anblick wie ein einziges kreisrundes Bild aussicht. Dann nach einem entfernten Objekt mit feinen
Details suchen und den mittleren Fokussierknopf einstellen, bis das Objekt durch das linke Okular
scharf aussicht. Nun nur noch durch das rechte Okular schauen. Wenn das Objekt nicht gleich scharf
erscheint, das rechte Okular (Dioptrieneinstellung) drehen, bis die Einstellung auch schalrfg ist. Danach
braucht diese Dioptrieneinstellung nicht mehr verindert werden, es wird nur noch mit dem mittleren
Fokussierknopf fokussiert.

Download from Www.Somanuals.com. AitMgnuals Search And Download.
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KURZER LEITFADEN: BUSHNELL COMPACT INSTANT REPLAY 11-8323

5

Ein Foto
aufnehmen,
oder einen
Videoclip

schieflen

Die Kamera mit beiden Hinden ruhig halten und fiir die Aufnahme eines Standfotos den SNAP Knopf
driicken. Es ist ein ,,Piepton® zu héren (dieser kann ausgeschaltet werden), danach folgt eine kurze Pause
(Anzeige des Datei-Icons), wenn die Kamera das Foto im Speicher ablegt. Fiir das Schief8en einer Video
einmal Menu/OK driicken, dann die ,Rechts Pfeiltaste, damit die Videooptionen des Kamerameniis
sichtbar werden. Mit den Tasten ,Up“ oder ,Down® entweder Replay (Schleife) oder Normale (kon-
tinuierliche) Video wihlen, dann Menu/OK driicken. Jetzt ist man wieder zuriick beim Display mit der
live Vorschau, und mit der Videoaufnahme kann jederzeit mit Driicken von SNAP begonnen werden.
Am Ende der Videoaufzeichnung erneut SNAP driicken. Bitte den Abschnitt “Video Modsi” genau durch-
lesen. Er enthiilt eine detaillierte Erklirung iiber die Unterschiede der “Normal” und “Replay” Videomodi
einschliefllich dariiber, wie die Zeit der Videoaufnahme bestimmt wird.

Fotos / Videos
iiberpriifen
und léschen

Fiir die Uberpriifung oder Wiedergabe eines Standfotos oder einer Video den LCD/Mode Knopf driick-
en (zweimal driicken, wenn das Display nicht schon aktiv war). Es wird das jiingste Standfoto oder
Video (erstes Bild) angezeigt. Fiir die Uberpriifung vorheriger Fotos oder Videos Schritt fiir Schritt,
die ,Links" Pfeiltaste driicken. Das Icon in der Ecke unten rechts des Displays gibt an, ob die aktuell
iiberpriifte Datei ein Standfoto, eine ,Normal® oder “Instant Replay” Video ist. Die Zahlen iiber diesem
Icon zeigen die laufende Dateinummer / Dateien insgesamt (2 von 3, usw.) an. Fiir das Abspielen einer
gespeicherten Video die “Down” Pfeiltaste driicken (zum Stoppen des Abspielens nochmals driicken).
Zum gleichzeitigen Sehen der , Thumbnail“ Bilder von mehreren gespeicherten Fotos / Videos sofort
die ,,Up* Pfeiltaste nach Eingabe des Uberpriifungsmodus driicken. Mit den Pfeiltasten eine einzelne
Datei wihlen, dann erneut ,Up“ driicken, um das Vollbild zu sehen. Zum Léschen eines Fotos / Vid-
eos Menu/OK driicken, dann einmal die “Down” Pfeiltaste (Miilleimer Icon). Die ,Rechts” Pfeiltaste
driicken Delete One (Eins l6schen) oder Delete All (Alle l6schen) wihlen, dann die ,,Rechts“ Pfeiltaste
driicken und ,,Yes“ wihlen. Zur Meniispalte zuriickgehen, ,Exit“ wihlen und Menu/OK driicken, um
zur Uberpriifungsanzeige zuriickzukehren.

/6

An einen
Computer
anschliefSen
und Fotos
iibermitteln

Vor dem Anschliefen der Kamera den Treiber von der CD-ROM installieren, wenn Windows 98/98SE
benutzt wird, und PhotoSuite installieren, wenn noch keine Software fiir Fotobearbeitung vorhanden
ist. Das mitgelieferte USB-Kabel von der PC Buchse an der Riickseite des Kameragehiuses) am USB-
Port des PC anschlieffen. Bei installiertem Windows XP nur die automatisch erscheinenden Anweisun-
gen / Optionen im Bildschirm befolgen. Bei Windows 98 oder 2000 “My Computer” (Mein Computer)
auf dem PC 6ffnen. Die Kamera wird als ,Removable Disk* (Herausnechmbare Festplatte) erkannt — Die
Fotos befinden sich in den inneren Ordnern, sie nur einfach in einen Ordner der Festplatte ziehen oder
sie kopieren / einfiigen. Siche im Abschnitt ,,Fotos tibermitteln® dieses Handbuchs.

Download from Www.Soman,

Technische Spezifikationen

Vergroflerung 8x Dateigrofe fiir Standfotos 2.048 x 1.536, 1.600 x 1.200, 640 x 480
(Bildauflssung)

Objektiv- 30 mm Datei-kompression Verhiltniszahl | 1:4 (FQ), 1:8 (NQ), 1:16 (EQ)

Durchmesser (Qualitir)

Austritts-pupille 3,75 Interner Speicher 16 MB Flash Memory

Sehfeld

97,54 m @ 1.000 m

Speicher-erweiterung

Secure Digital Card , bis zu 1 GB Kapazitit

Augenabstand

13 mm

Dateiformat (Stand / Video)

JPEG /MJPEG (.AVI)

Linsenver-giitung

Vollbeschichtet

Datei- Management

DCEF (Version 1.0), FAT 16 Format

Prismentyp

Dachkant, BK-7

LCD

1,5” TFT, 120.480 Bildpunkte

Fokus-Reichweite

18’ - unendlich

Video Auflsung / Bildrate

620 x 480 oder 320 x 240 Bildpunkte pro Bild / 30 oder 15

(Fernglas) Bilder/Sck. Abspielmodus Schleifenlinge: 8/15/30/60 Sekunden
(pro Auflsung / gewihlte Bilder/Sekunde)

Gewicht 14,3 02/ 406.5 g Video Out NTSC/PAL, iiber 8 Pin USB Port mit Spezialkabel (mitgeliefert)

Sensortyp CMOS Belichtungs-wertbereich +/-2EV in 0,5 EV Schritten

Tatsichliche 3,2 Megapixel Weiflabgleich-optionen Automat., Tageslicht, Wolkig, Fluoreszenz, Gliihlampe

Bildpunkte

Farbe 24 Bit Farbe Voreingestellte Szenen Programm, Sports, Landschaft, Portrit, Nacht

Verschlufl Elektronisch, 1/16 bis | Meniisprachen Englisch, Spanisch, Franzésisch, Deutsch, Italienisch, Portugie-
1/1000 Sekunden sisch, Japanisch

Fokusbereich Fest, ca. 60" - Autom. Abschaltung (nach LCD Display: 2 Min. / All Leistung Aus: 5 Min.

(Kamera) unendlich fehlender Aktivitit)

Blenden-6ffnung /5,6 Stromver-sorgung 2 x AAA Batterien, Alkali/Lithium/NiMh
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Identifizierung der Teile
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LCD Display

LCD/Modus-Knopf

5-Wege-Tastenfeld
mit Menu/OK
Knopf
Mittlerer
Fokussierknopf
(Fernglas)

Dioptrienan-
passung

LCD mit Vorschau der Icons

USB Port/
Video Out Power
Piepton

SD-Karten-Schlitz

Download from Www.Somanuals.com. All M
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Display fiir Standfotos-Vorschau

# | Icon

Normal Video _Absplel-Video
Film (Video) Display

Batterickontrolle (2/3 Ladestand angezeigt)

Icon

Anz. verbleibender Fotos (basiert auf der verfiigbaren Speicherkapazitit)

Batteriekontrolle (voll)

1
2
3 | Standfoto-Modus
4

Qualitit (Dateikompression) Fine/Normal/Economy
Fein / Normal / Spar

5 Auflésung (Dateigrofie) Large/Medium/Small
Grof¢/ Mittel / Klein

Gesamtzahl verfiigbare
Sekunden der Video
(basiert auf der verfiigbar-
en Speicherkapazitit)

Video Modus

6 | WeiRabgleich Ohne Anzeige, aufler bei Anderung vom Standardwert
wAuto“ bei Belichtung

Aflésung (FQ = 640 x
480/ NQ = 320 x 240)

7 Szene Ohne Anzeige, aufler bei Anderung vom Standardwert “Program”
im Modus Menii

Bildrate (30 oder 15
B/Sek.)

ilglaFlﬁﬁafmﬁﬂthQWfﬂdnghne Anzeige, aufler im Modus Menii gewiihls
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80 vorher heruntergeladen oder kopiert werden, wenn sie aufbewahrt werden sollen.

Die Compact Instant Replay umdrehen und den Batteriefachdeckel wie rechts
abgebildet 6ffnen. 2 AAA Alkali- oder Lithiumbatterien wie von den Diagrammen
im Fach einlegen, dann den Batteriefachdeckel bis zum Einrasten schlieflen. Hinweis:
Es kinnen auch aufladbare NiMh Batterien benutzt werden, einige Modelle kinnen
aber nicht den richtigen Strom zur Versorgung der Instant Replay abgeben. NiMh

Batterien mit laufender Rate von 2300 mAb oder dariiber werden empfohlen.

Die Kamera kann je nach den Einstellungen fiir Auflésung und Qualitit 15 bis 642
Fotos im integrierten 16 MB Speicher ablegen (siehe die Tabelle auf der Riickseite
dieses Handbuchs). Zur Erweiterung der verfiigbaren Speicherkapazitit kann als
Option eine SD-Speicherkarte (,Secure Digital“) mit biszu 1 GB Kapazitit eingesetzt
werden. Die Karte wird in den Schlitz an der Riickseite des Kameragehiuses wie
auf dem letzten Diagramm gezeigt eingesetzt. Die SD-Karte mit dem Etikett nach
unten einsetzen. Hinweis: Sichergehen, dafS vor dem Einsetzen oder Entfernen
von Karten der Strom abgeschaltet ist, damit moglicher Verlust von Dateien oder
Beschiidigung der Karte verhindert wird. Eine neue Karte muf nicht formatiert
werden, jedoch miissen vorher in anderen Geriten benutzte Karten von der Compact
Instant Replay formatiert werden, bevor Fotos darauf gespeichert werden. (Siche
“Setup Menu” im nichsten Abschnitt). Es wird darauf hingewiesen, dafl dabei alle
vorher auf der Karte gespeicherten Dateien geléscht werden, also sichergehen, dafl sie

Batteriefachdeckel

Kartenschlitz
(Deckel anheben)

JLinks® Pfe;
Download from Www.Somanuals.com. All M‘anuag earc|

Grundlagen der Vorhereitung von Fernglas und Kamera

Vor dem Aufnehmen von Fotos oder Videos einen Moment darauf verwenden, die Compact Instant Replay auf die individuelle
Schschirfe und Benutzervorziige einzustellen. Wenn keine Brille getragen wird, die Augenmuscheln aus Gummi in ihrer Position
,oben® lassen, Brillentriger rollen sie nach unten. Das Fernglas an der linken und rechten Seite ergreifen und es beim Durchschauen
zur Anpassung des Abstands der Okulare auseinanderzichen oder zusammendriicken, bis der Anblick wie ein einziges kreisrundes
Bild aussieht. Dann nach einem entfernten Objekt mit feinen Details suchen (Baum, Schild, Ziegelmauer, usw.), und den mittleren
Fokussierknopf cinstellen, bis das Objekt durch das linke Okular scharf aussicht. Nun nur noch durch das rechte Okular auf das gleiche
Objekt schauen und einfach am rechten Okular drehen, bis das Bild fiir das rechte Auge gleich scharf ist. Dies wird die Dioptrienein-
stellung genannt, und sie kompensiert jeden Sichtunterschied zwischen dem linken und dem rechten Auge. Nach der ersten Einstel-
lung mit diesem Verfahren kann die Dioptrieneinstellung so belassen werden, und allein der mittlere Fokussierknopf bringt Objekte in
beliebiger Entfernung durch die Okulare hindurch in scharfen Fokus. (Der Mindestfokusabstand betrigt ca. 4,88 m).

Die digitalen Fotos und Videos werden vom mittleren Fokussierknopf nicht betroffen, denn die Kameralinse zwischen den Objek-
tivlinsen des Fernglases bendtigen keine Fokuseinstellung. Sie ist so voreingestellt, daf8 Objekte in Reichweiten von ca. 18,29 m bis
unendlich im Fokus bleiben. Es wird darauf hingewiesen, daf§ das Fernglas niher als die Kamera fokussieren kann. Das live Vorschau-
bild auf dem LCD priifen, um sicherzugehen, daff ausreichende Entfernung zur Gewihrleistung scharfer Fotos eingehalten wird.
Die Kameralinse bietet 8-fache Vergroflerung, die gleiche wie die Optiken des Fernglases, und sie ist so ausgerichtet, dafl ein in der
Fernglassicht zentriertes Objekt auch auf den Fotos und Videos zentriert ist. Daher braucht das LCD nicht eingeschaltet oder sogar
angehoben sein, wihrend Fotos oder Videos geschossen werden. Die geringere Benutzung des LCD wird die Lebensdauer der Batterien
signifikant verlingern.

Vor der ersten Benutzung der Kamera kann im Kameramenii das richtige Datum eingestellt werden. Das LCD Display anheben und
den POWER Knopf driicken. Wenn die rote Stromlampe leuchtet, LCD/Mode driicken, damit das Display eingeschaltet wird. Den
Menu/OK Knopfin der Mitte des Tastenfeldes driicken, dann die “Down” Pfeiltaste dreimal driicken, um zum “Setup” Menii zu gelan-
gen. Die ,Rechts” Pfeiltaste einmal driicken, dann die ,Down* Pfeiltaste bis zu ,Date”. Dann fiir den Eintritt in die Datumseinstellung
die ,Rechts® Pfeiltaste zweimal driicken. Mit den ,Links“ / ,,Rechts” Pfeiltasten den Teil des Datums wihlen, der geiindert werden soll,
dann das Datum mit den ,Down* / ,Up* Pfeiltasten dndern. Fiir die Anderung des Datumsformats, damit Monat, Tag und Jahr in
der gewiinschten Reihenfolge erscheinen, zum ,,Pfeil Icon oben links in der Datumsanzeige gehen und die ,Down® / ,Up® Pfeiltasten
driicken. Die Uhrzeit (24 Std. Format) mit den 4 Zahlen unten in der Datumsanzeige einstellen, damit sich das Datum automatisch
um Mitternacht der gegebenen Ortszeit dndert. Nach dem Einstellen von Datum und Uhrzeit den Menu/OK Knopf einmal driicken
und dann nochmals zur Sicherung der Einstellung und des Ausstiegs. Dann kann mit Driicken der ,Down® Pfeiltaste gewihlt werden,
ob das Datum im Display und auf den Fotos erscheinen soll oder nicht (“Show Date On/Off”) (“Datum zeigen An/Aus”). Denn die

taste bis zur Riickkehr zu “Setup” gedriicke halten, zu “Exit” hinuntergehen und Menu/OK driicken.
KndRﬁown oad, " & §
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Standfotos aufnehmen

Nach dem ersten Setup wie weiter oben beschrieben kann ein Foto aufgenommen werden:

1) Das LCD anheben und den POWER Knopf kurz driicken (rote LED leuchtet auf). Fiir die Einschaltung des LCD Display
den LCD/Mode Knopf driicken, wenn eine Vorschau des Bildes gesichtet oder Meniieinstellungen, der Batteriezustand usw. gepriift
werden sollen.

2) Die Compact Instant Replay geht bei der ersten Einschaltung zum Standardwert der héchsten Bildauflssung und der Qualititsein-
stellungen {iiber, desgleichen zu “everything on automatic” (alles auf Automatik), so dafl sofort ausgezeichnete Fotos aufgenommen
werden kénnen. Wenn andere Einstellungen vorgezogen werden, im Abschnitt “Using the Main Menu” (Benutzung des Hauptmeniis)
die Anweisungen dazu nachlesen, wie die Einstellungen gefunden und geindert werden, wie Bildauflssung und Belichtung unter
Einsatz von Szenenvoreinstellungen fiir allgemeine Themen und andere Optionen.

3) Das Foto kann beim Schauen durch das Fernglas komponiert werden (Das LCD braucht fiir die Aufnahme eines Fotos nicht einge-
schaltet zu sein). Jedoch wird zwecks genauesten Bildzuschnitts das Priifen der LCD Vorschau empfohlen.

4) Sichergehen, daf§ eine Entfernung von ca. 18,29 m bis zum Subjekt eingehalten wird. Die Fernglasoptiken fokussieren zwar niher,
aber der Kamerafokus ist fiir beste Ergebnisse bei entfernten Subjekten voreingestellt (die Kamera benstigt kein Fokussieren). Das LCD
kann zur Priifung dessen benutzt werden, dafl das Subjeke fiir scharfe Bilder nicht zu nahe ist.

5) Die Kamera mit beiden Hiinden so ruhig wie moglich halten und langsam den SNAP Knopf driicken. Das Display wird wihrend
des Speicherns der Datei fiir kurze Zeit schwarz (das Ordner-Icon wird angezeigt), dann kann sofort ein weiteres Foto aufgenommen
werden. Der Zihler in der Ecke unten rechts veridndert sich und zeigt die verbleibende Fotokapazitit an, die vom Umfang des ver-
fiigbaren internen oder Kartenspeichers, sowie von der Bildauflésung und den Qualititseinstellungen abhiingt (Es kann jederzeit auf
geringere Qualitit umgeschaltet werden, damit mehr Fotos in den verbleibenden Speicher ,hineinpassen®. Hinweis: Der Ziihler ziiblt
nicht immer um eins riickwiirts, sobald ein Foto aufgenommen wurde, dies hiingt von diesen Einstellungen und dem tatsiichlichen Dateiinhalt
pro Foto ab. Wenn der Ziihler “000” erreicht, ist kein Speicher (Speicherplatz) mehr vorhanden, und es sollten Fotos heruntergeladen werden,
die aufbewahrt werden sollen, damit sie aus dem Speicher geldscht werden kinnen, oder die SD-Karte kann herausgenommen und durch eine
andere ersetzt werden.

6) Es ist ein digitaler Zoom bis zu 6 x verfiigbar. Fiir das Einzoomen die ,Rechts” Pfeiltaste driicken (das Ergebnis erscheint im LCD).
Fiir das Auszoomen die ,, Links“ Pfeiltaste driicken.

7) Den LCD/Mode Knopf driicken, wenn das Foto nach der Aufnahme gepriift werden soll, ihn dann fiir die Riickkehr zur live
Vorschau erneut driicken. Siehe im Abschnitt “Review Menu” (Uberpriifungsmenii) mehr dariiber, wie vorher aufgenommene Fotos
betrachtet, iiberpriift und geloscht werden.
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nNormal” oder “Instant Replay” Videos aufnehmen

1) Die Schritte 1 bis 4 auf der vorherigen Seite ,,Standfotos aufnehmen® befolgen.

2) Fiir die Umschaltung von Standfotos auf einen Video-Modus den Menu/OK Knopf driicken. Die erste Meniigruppe ist “Camera”
(Kamera) — Die “Rechts” Pfeiltaste driicken, mit der “Up” und “Down” Pfeiltaste “Normal” oder “Replay video” Modus wihlen (Die
Kamera kehrt nach der Wahl eines Video-Modus zum Display mit live Vorschau zuriick), so ist man sofort aufnahmebereit. In jedem
Modus SNAP driicken und mit der Aufzeichnung eines neuen Videoclips beginnen, ihn zum Stoppen der Aufzeichnung und zum
Ablegen der Video im Speicher erneut driicken. Hier liegen die Unterschiede zwischen den beiden Video Modi:

Normal Video Modus nimmt einfach einen kontinuierlichen Videoclip auf, sobald der SNAP Knopf gedriickt wird, und endet, wenn
der Knopf erneut gedriicke wird. Die Aufzeichnungsdauer wird nur vom Umfang des gerade verfiigbaren internen Speichers oder der
Speicherkarte begrenzt. Es kann eine einzige lange Video gedreht werden, bis kein Speicherplatz mehr vorhanden ist, oder es kénnen
mehrere kiirzere Videos aufgezeichnet werden, indem die Aufnahme auf Wunsch mit Driicken von SNAP gestoppt oder gestartet wird.
Der Zihler zeigt die ungefihre verfiigbare verbleibende Aufnahmedauer (in Sekunden) an, wenn er gestoppt wird, und er zihlt die
verbleibende Zeit abwirts, wenn eine ,Normal“ Videoaufzeichnung gestartet wird.

Replay Video Modus funktioniert anders — Am Ende einer vorbestimmten Zeitgrenze (wird von der Videoauflésung und der Bildrate
wie im Setup Menii definiert bestimmt), beginnt der Videoclip zu “schleifen” oder neu aufzunchmen, wobei die vorherigen Ereignisse
geloscht und ersetzt werden. Dies ist ideal fiir Sportereignisse, denn mit der Aufzeichnung kann jederzeit begonnen und sie dann direkt
nach einer Landung, einem Tor oder einem anderen Hohepunkt gestoppt werden. Man ist sicher, den Hohepunkt zu bekommen,
und es miissen nicht erst viele vorherige Videos durchsucht oder immer wieder zuriickgespult werden, um ihn wieder und wieder
anzuschauen. Die erhiltlichen Schleifenlingen betragen 8, 15, 30 oder 60 Sekunden — Je héher die Bildauflésung und die Bildrate
pro Sekunde, um so kiirzer ist die Schleife. Im ,Replay“ Modus zeigt der Zihler beim Stoppen die verfiigbare Gesamtaufnahmedauer
(in Sekunden) an und zihlt von Null aufwirts bis zum Ende der Schleifenzeitgrenze, wenn die Aufnahme beginnt. Am Ende der
Schleife, wenn die Neuaufzeichnung beginnt, geht der Zihler automatisch zuriick und startet wieder ab Null. Wenn die Aufzeichnung
auf halbem Wege durch eine ,neue® Schleife abgebrochen wird, wird die Video den letzten Teil des vorherigen Schleifenabschnitts
enthalten und den ersten Teil des neuen — Die Kamera behilt immer volle 8, 15, 30 oder 60 Sekunden der jiingsten Ereignisse bei. Vor
dem ersten ,richtigen” Einsatz sollte mit dem ,,Replay Modus ein bifichen geiibt und experimentiert werden, um ein Gefiihl dafiir zu
bekommen, wie das funktioniert.

3) Wenn eine Video nach der Aufnahme gepriift werden soll, den LCD/Mode Knopf driicken. Die ,,Down® Pfeiltaste driicken, um
mit dem Abspielen zu beginnen, sie zum Stoppen erneut driicken. Fiir die Uberpriifung der vorherigen Video- oder Standfotodateien
die ,Links“ oder ,Rechts® Pfeiltaste driicken. Mit Driicken der ,Up“ Pfeiltaste wird eine “thumbnail” Uberpriifung von mehreren
Dateien gesichtet — Mit den Pfeiltasten die Datei hervorheben, die tiberpriift werden soll, dann fiir Wahl und Uberpriifung Menu/OK
driicken. Fiir die Riickkehr zum Display mit der live Vorausschau den LCD/Mode Knopf driicken, fiir die Aufnahme weiterer Videos
(oder Standbilder) den LCD/Modus Knopf driicken. .

4) Sieche im Abschnitt “Review Menu” (Uberpriifungs-Menii) weitere Hinweise zur Uberpriifung und zum Loschen von vorher auf-
genommenen Videos. 83
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Wie weiter oben in diesem Handbuch angegeben, ist die Compact Instant Replay werksmiflig fiir ihre grofite ver-
fiigbare Bildauflssung und Qualitit voreingestellt. Belichtung, Weiffabgleich und andere Variablen sind automatisch
eingestellt. Das bedeutet, dafl bei den meisten Subjekten und Lichtverhiltnissen gute Ergebnisse erzielt werden, ohne
in die Meniis einsteigen und Einstellungen dndern zu miissen. Wir empfehlen jedoch, sich mit den verfiigbaren
Optionen vertraut zu machen, damit die Fotos verbessert werden kénnen, wenn sie zum Beispiel zu dunkel heraus-
kommen (passiert bei den meisten Kameras bei Schneeszenen), oder zu griin (unter manchen Fluo-Lampen). Das
Haupt- oder Aufnahmemenii ist in sechs Gruppen unterteilt. Zum Sichten dieser Gruppen den “Menu/OK” Knopf
driicken. Mit den ,,Up*“/ ,Down" Pfeiltasten eine Gruppe wihlen, dann mit Driicken der ,Rechts* Pfeiltaste und den
»Up“ / ,Down" Pfeiltasten dic Artikel oder Optionen schen, die innerhalb der Gruppe verfiigbar sind. Nachstehend

eine allgemeine Beschreibung der Mentigruppen und ihrer Funktionen:

Using The Main Menu continved

Meniigruppe | Icon Zweck

Meniigruppe | Icon Zweck

Damit kénnen Standfoto oder eine von zwei Video (Film) Betriebsweisen

n gewihlt werden. Hier zeigen die Meniioptionen immer die beiden Modi, die

I im Moment nicht benutzt werden. Wenn man zum Beispiel schon im  “Re-

play” Video Modus ist, werden die anderen beiden Modi im Kamera-Menii

I@I angezeigt: Standfoto Modus (Kamera Icon) oder ,Normal® Video Modus
(Filmkamera mit Icon mit geradem Pfeil).

Kamera Modus

Setup @ Provides options for setting: Resolution (Dateigréfie), Quality (Dateikompres-
sion), EV (Belichtungswert), WB (Weiflabgleich), and ISO (Lichtempfindlich-
keit).

Formatieren Bereitet eine neue oder vorher benutzte SD-Speicherkarte auf den Gebrauch

‘ vor. Loscht (vernichtet) alle auf der Karte vorhandenen Dateien. Kann auch
zum raschen Loschen des gesamten Inhalts des internen Speichers benutzt
werden, wenn keine SD-Karte eingesetzt wurde.

Exit @I Ausstieg aus dem Hauptmenii und Riickkehr zum live Vorschaubild.

Belichtung Bietet Optionen fiir die Einstellung des WB (Weiflabgleichs) und EV (Belich-
| l:‘ tungswert) fiir die Feinabstimmung der Farbwiedergabe und der Belichtung fiir

verschiedene Bedingungen, wenn die standardmif8igen automatischen Einstel-
lungen nicht fiir die gewiinschte Qualitit oder Ergebnisse sorgen.

Modus Erlaubt die Wahl unter voreingestellten ,Szenen®, die die Kameraeinstellungen
@ fiir Sportereignisse, Landschaften und andere allgemeine Fotosubjekte optim-
ieren. In dieser Meniigruppe werden auch die Optionen Self Timer und Rapid

B4

Sequence Standfoto geboten.

Die nichsten Seiten enthalten eine vollstindige Liste aller in den Hauptmeniigruppen enthaltenen Artikel und Ein-
stellungen zusammen mit den Beschreibungen ihrer Funktion. Mit dem gleichen Verfahren wie im obigen Beispiel
durch die Meniibildschirme gehen, um eventuell Einstellungen hervorzuheben oder zu dndern, damit sie individuelle
Vorziige oder Bediirfnisse erfiillen. Das Uberpriifungsmenii ist anders, jedoch einfacher und hat nur vier Gruppen
(Dia-Show, Loschen, Editor und Exit). Siehe im “Review Menu” Abschnitt weiter unten in diesem Handbuch fiir eine
vollstindige Beschreibung.
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Hauptmeni System (Standardeinstellungen in Fettdruck)
*Einstellungen Szene und Sequenz unter “Mode” sind nicht verfiigbar, wenn “Camera’fiir , Normal“ oder ,,Replay

Video “ eingestellt ist.
Gruppe Einstellungen | Beschreibung
KAMERA Stand-foto Kamera Icon Fotos 3,2 Megapixel Standbilder
Video Clip Normal Video Dreht standardmifig kontinuierliche Video mit nur durch den
(Film Icon mit verfiigbaren internen Speicherplatz oder die SD-Karte begrenzter
geradem Pfeil) Dauer
Replay Video (Film Dreht Video “Schleifen”, mit erneuter Aufnahme auf vorhandener
Icon mit drehendem | Video. Schleifen haben feste Lingen (von 8 bis 60 Sekunden), wie
Pfeil durch die Videoauflssung und die Bildrate bestimmt (FPS)
BELICH- WB (Weif3- Auto Weiflabgleich ist automatisch fiir die richtige Farbwiedergabe
TUNG abgleich) cingestellt
Tageslicht Manuelle Einstellung fiir sonnige Lichtverhiltnisse im Freien
Gliihbirne Manuelle Einstellung fiir Tungstenbeleuchtung (Gliithbirne) im
Innern
Fluo Manuelle Einstellung fiir Fluolicht im Innern
Wolkig Manuelle Einstellung fiir wolkigen Himmel oder Schatten im Freien
EV -2,0 - +2,0 Bietet manuelle Anpassung an Unter- / Uberbelichtung in 0,5
Lichtwert Lichtwert-Schritten. Minuswerte ergeben dunklere Fotos, Pluswerte
hellere Fotos.
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Hauptmenii System Fortsetzung

Group | Item Settings Description
MODUS | Szene* Programm Standardmiifige Selbstbelichtung fiir die meisten Subjekte oder allgemeine Zwecke

Sport-ereignisse | Setzt hohere Verschluigeschwindigkeiten ein, damit Bewegung ,eingefroren® werden kann

Landschaft Tiefere Fokuszone fiir erweiterte Schérfe vom Vorder- bis zum Hintergrund

Portriit Geringe Fokuszone fiir Fotos von Leuten — hilft beim Trennen des Subjekts vom Hintergrund

Nacht Setzt geringere Verschluf8geschwindigkeiten fiir bessere Belichtungen bei schwachem Licht
Self Timer Ja/ Nein Foto nach einer Verzogerung aufgenommen, nachdem der Verschlufknopf gedriickt wurde
Sequenz * 3 oder 5 3 oder 5 Bilder werden in rascher Folge aufgenommen, wenn SNAP gedriickt wurde

Aufnahmen

SETUP Grofe/ Bildgrofe 3 Optionen fiir Bildgrofe: L (2.048 x 1.536 Bildpunkte), M (1.600 x 1.200 Bildpunkte), oder S
Qualitic (Auflésung) (640 x 480 Bildpunkte). Hohere Auflésungseinstellungen erzeugen schirfere / breitere Drucke,
(Stand-foto) reduzieren aber den verfiigbaren gesamten Speicherplatz. Mit niedrigeren Einstellungen mehr im

Speicher ablegen, oder fiir E-Mails, usw. L=3,1 MP/M =2,1 MP /S = 0,35 MP

Qualiic Stelle die Kompression von jpg Dateien ein. Einstellungen sind: Fine-FQ (1:4 Kompression), Nor-
(VerhiltniszahlDa- mal-NQ (1:8) und Economy-EQ (1:16). Dies kann unabhiingig von der Bildgréfe benutzt werden,
ke . damit mehr Fotos im Austausch mit leicht geringerer Qualitit gespeichert werden kénnen.
tei-kompression)
Nur im Qualitit 640 x 480 Bildpunkte pro Bild (Auflésung) > bei 30 oder 15 Bildern pro Sekunde (Bildrate)
Normal Video | (Auflésung & 320 x 240 Bildpunkte pro Bild > bei 30 oder 15 Bildern pro Sekunde
Modus FPS (Nach der Wahl der Auflésung mit Driicken der “Rechts” Pfeiltaste die Bildrate (fps) withlen)
In Replay Qualitit 640 x 480 Bildpunkte pro Bild (Auflssung) > bei 30 oder 15 Bildern pro Sekunde (Bildrate)
Video Mode (Auflosung & 320 x 240 Bildpunkte pro Bild > bei 30 oder 15 Bildern pro Sekunde
only FPS 8, 15, 30 oder 60 Sekunden Schleifendauer je nach Auflésung / fps
4 s oot O toort
rantars-Searc ANt Downoa:
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Hauptmeni System Forisetzung

Gruppe | Artikel Einstel- Beschreibung
lungen
Datum Setup, Dient bei der richtigen Einstellung von Datum / Uhrzeit Femaﬂ Zeitzone. Wenn “On”
On/Off gewihlt ist, erscheint das Datum im Display und wird auf alle Fotos aufgedruckt.
Speiche-rung | Auto Dateien werden auf der SD-Karte gespeichert, wenn sie eingesetzt wurde,
andernfalls im internen RAM.
SD Dateien werden nur auf der SD-Karte gespeichert (mufi eingesetzt werden).
Intern Dateien werden nur im internen Speicher abgelegt, niemals auf einer Karte.
Sprache 7 verfiig-bar | Wihlt die bevorzugte Sprache fiir alle Menuanzeige-Displays.
Rec View Off/1-3 Sek. | Wihlt die Zeitgrenze der automatischen Uberpriifungsanzeige nach der Auf-
nahme des Fotos.
Datei-name Reset/Serien Stellt das System der Dateinummerung ein. Wenn Reset gewihlt ist, und wenn
alle Dateien im internen oder Kartenspeicher geloscht sind, beginnen die
Dateinummern wieder bei “000”. Wenn Serien gewihlt ist, beginnen die Da-
teinummern fiir neue Fotos wieder mit der nichsten Nummer nach der letzten
fiir vorherige Dateien benutzten Nummer.
Piepton On / Off Schaltet den Piepton an oder aus.
Riickstellung | Yes / No Mit “Yes” werden alle Einstellungen auf die urspriinglichen Standardwerte gesetzt
Alle (in Fettdruck gezeigt).
FORMAT | Formatieren | Yes/No Formatiert die Karte fiir die Compact Instant Replay Dateien. Loscht den gesamten Inhalt.
EXIT Steigt aus dem Meniisystem aus und kehrt zur live Vorschau zuriick.
Download from Www.Somanual

Icons im Uberprifungs-Display

# | Icon

Datum der Foto- oder Videodatei (Das Datumsmerkmal muf eingestellt und eingeschaltet werden)

Ort der laufenden Uberpriifungsdatei (INterner Speicher oder SD Karte)

Auflsung der laufenden Uberpriifungsdatei

Qualitit (Dateikompression) der laufenden Uberpritfungsdatei

Nummer der laufenden Datei (linke Zahl): Gesamtanzahl der Dateien im Speicher (rechte Zahl)

Gibt den Dateityp an (Standfoto, “Normal” Video, “Replay “ Video)

BTN NN RN IS RTINS}

Batteriekontrolle

Uberprifungsmenii

Uberpriifen und Loschen von Fotos und Videos

Fiir den Eintrite in den Uberpriifungs-Modus “LCD/Mode” driicken. Mit den ,Links“ / ,Rechts Pfeiltasten die
gespeicherten Fotos / Videos durchblittern. Im Uberpriifungs-Modus wird mit Driicken des Menu/OK Knopfes in
den Uberpriifungs-Meniisatz eingetreten. Diese funktionieren genauso wie vorher in den Anweisungen zult Haupt—
menii-System beschrieben (mit dem Pfeiltastenfeld zur gewiinschten Meniigruppe und den Optionen navigieren, mit
Driicken von OK eine Einstellung bestitigen), jedoch mit anderen Meniiartikeln wie hier gezeigt wird:

Gruppe

Artikel

Einstellungen

Beschreibung

DIA SHOW

Yes / No

Nach der Wahl von “Yes” beginnt eine Uberpriifung aller
im Moment im internen oder Kartenspeicher vorhandenen
Bilder, wobei alle paar Sekunden automatisch zum nichsten

Bild iibergegangen wird.
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Gruppe

Artikel

Beschreibung

Beschreibung

LOSCHEN

Eins
l6schen

Yes / No

Loscht das im Moment angezeigte Foto oder die Video aus dem
Speicher. Mit den “Up” / “Down” Pfeiltasten die Datei finden, die
geloscht werden soll. Zum Léschen das “Delete One” (Eins l&schen)
Icon hervorheben und “OK” driicken. Then “Yes” hervorheben und
zum Loschen der Datei “OK” driicken.

Alle

loschen

Yes / No

Léscht alle gespeicherten Dateien. Zum Léschen aller Dateien (mit
Ausnahme der gesperrten — siche weiter unten) das “Delete All”
Icon hervorheben und “OK” driicken. Dann ,,Yes“ hervorheben und
,OK* driicken, damit alle im Moment im Speicher vorhansdenen
Dateien geldscht werden.

EDITOR

Schiitzen

Sperren /
Freigeben

Das Sperren einer Foto- oder Videodatei verhindert ungewolltes
Loschen. Kann zusammen mit “Delete All” benutzt werden, damit
alle aufler ein oder zwei Fotos geléscht werden. Zum Sperren des
im Moment angezeigten Fotos oder der Video das “Lock” Icon
hervorheben und “OK?” driicken. Fiir die Freigabe einer vorher
gesperrten Datei diese mit den “Up” / “Down” Pfeiltasten wihlen,
das “Lock” Icon erneut hervorheben und “OK” driicken.

Drehen

-90 Grad oder
+90 Grad

Dreht die Ansicht des momentanen Bildes um 90 Grad in jede
Richtung.

EXIT

Exit

Steigt aus dem Uberpriifungsmenii aus und kehrt zum zuletzt
gewihlten Uberpriifungsbild zuriick.

Erforderliches System (Minimum)

OS: Windows® 98/98SE/2000/ME/XP

Zentraleinheit: MMX Pentium® 200 MHZ gleichwertig oder schneller Pentium® III 500 MHz fiir
PhotoSuite5™)

Speicher: 32 MB Minimum (64 MB fiir PhotoSuite empfohlen)

SVGA Videokarte w/2 MB VRAM, 800 x 600 Bildschirmanzeige, 16 Bit High color

200 MB verfiigbarer Speicherplatz auf der Festplatte (wenn PhotoSuite installiert wird)

Interner USB Port

Installation der Software

Wenn Windows 98 benutzt wird, miissen vor dem Anschluff der Kamera an den Computer Treiber installiert werden.
Die CD-ROM in das CD Laufwerk des Computers cinlegen; sie liuft automatisch, und der Bildschirm fiir die Instal-
lation wird angezeigt. ,Install Driver” wihlen, dann die Anweisungen befolgen. Den Computer nach der Installation
neu starten. Fiir Windows 2000, ME und XP sind keine Treiber erforderlich, da die Kamera mit dem USB Massens-
peicher-Standard arbeitet, damit auf die Fotodateien so zugegriffen werden kann, als ob sie auf einer externen Festplatte
gespeichert wiren. Wenn noch keine Fotobearbeitungs-Software vorhanden ist, kann bei jedem Windows OS Roxio
PhotoSuite® von der CD-ROM installiert werden. Sichergehen, die ,,Release Notes® (Hinweise zur Ausgabe) vollstin-
dig durchlesen und alle fiir den Computer und die OS relevanten Tips oder potentiellen Punkte festhalten.

Die Fotos und Videos auf den PC herunterladen - Schritt fir Schritt

1. Bei cinem Computer mit Windows 98/98SE sichergehen, daf§ der Treiber zuerst installiert worden ist.

2. Sichergehen, daf die Instant Replay Stromversorgung eingeschaltet ist, und das mitgelieferte Kabel an die USB
Buchse der Kamera anschlieen (den Anschlufldeckel auf der linken Seite des Replay 6ffnen), dann direkt an den
USB Port des Computers — keine USB Ports an der Frontplatte / auf der Tastatur oder ,hubs“ ohne Stromversorgung
benutzen.

3. Das LCD Display schaltet aus, um Batterieenergie zu sparen, und die Instant Replay wird als standardmifSige “USB
Mass Storage” (Massenspeicher) erkannt. Dies bedeutet, dafl die Kameradateien leicht gesichtet, bearbeitet oder auf die
Festplatte kopiert werden kinnen, als ob sie auf eine externe Festplatte oder eine CD-ROM gespeichert wiirden. 91
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Die Fotos und Videos auf den PC herunterladen - Schritt fir Schritt

4. (Dieser Schritt ist bei Windows XP nicht erforderlich, nur einfach die Optionen des Bildschirms zum Sichten,
Kopieren oder Bearbeiten der Fotos benutzen). Die Kamera wird als neue ,Removable Disk® (Herausnehmbare
Festplatte) gesehen und ein noch nicht benutzter Buchstabe fiir den Treiber zugeordnet. Doppelklick auf dieses
neue ,Festplatte” Icon, den “DCIM Ordner” innen 6ffnen, dann einen (alle) darin enthaltenen Ordner 6ffnen
(,100BNxxx“, usw.). Die Fotos sind die darin vorhandenen Dateien — Sie haben das Prifix “PICT__” mit nach-
folgender Nummer, die gleiche wie vorher im Monitor der Kamera gesehen, als die Fotos iiberpriift wurden. Bei
Einzelklick auf eine Datei sollte ein kleines Vorschau-Bild angezeigt werden.

5. Auf “Edit>Select All” (Bearbeiten>Alle withlen) klicken (oder auf ein Foto klicken, “control® + Klick zur Auswahl
mehrerer Fotos), dann ,,Edit>Copy to Folder” (Bearbeiten>In den Ordner kopieren), (in den Windows Meniis).
Einen auf der Festplatte vorhandenen Ordner wihlen wie “My Pictures” (Meine Bilder) oder einen neuen Ordner
anlegen (,Urlaub Hawai 2005%, usw.), dann auf ,OK* klicken, um Kopien der gewiinschten Fotodateien zu iiber-
mitteln.

6. Nach der Ubermittlung der Fotos auf die Festplatte kann die Kamera abgetrennt werden. Windows 2000 kann
einen Bildschirm mit der Warnung erzeugen, dafl eine USB Vorrichtung abgetrennt wurde, ohne die ,Festplatte®
vorher zu stoppen oder auszuwerfen. (Die Fotodateien werden davon nicht beschidigt). Wenn dies eintritt, die Box
priifen, die ein Icon zur Systemanzeige oder Taskleiste hinzufiigt. Das nichste Mal kann dann nach der Ubermit-
tlung von Fotos zuerst auf dieses Icon und ,,Stop the USB Mass Storage Device” (Den USB Massenspeicher stoppen)
geklickt werden, bevor die Kamera abgetrennt wird.

Hinweis: Wenn der PC die .avi Filmdateien nicht im Windows Media Player abspielen will, kann es
erforderlich sein, eine jiingere Version des Media Player oder Direct X von Microsoft.com herunter-
guladen. Die Filmdateien kinnen auch mir dem QuickTime Player abgespielt werden, der in vielen
Computern vorhanden ist oder als kostenloser Download von Apple.com erhiildlich ist.
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Die Fotos und Videos auf den PC herunterladen - Schritt fir Schritt

7. Jetzt kénnen die Fotodateien unter jeder beliebigen Bearbeitungs-Software gedffnet werden. Nur ,File>Open”
(Datei>6ffnen) benutzen und zum Ordner gehen, in dem die Fotos vorher gespeichert worden waren. Unter
PhotoSuite “File>Open Photo” (Datei>Foto 6ffnen) wihlen und dann im “Look in” (Hineinschauen) Pull Down
Menii oben am Offnen Fenster “My Computer” wihlen, den Festplattentreiber wihlen und jedes Foto im Ordner
doppelt anklicken, in den die Dateien ab der Kamera kopiert worden waren. Es ist auch méglich, die Fotos
direkt in der Outdoor Kamera zu 6ffnen und damit zu arbeiten, solange sie noch angeschlossen ist. Hierfiir unter
PhotoSuite zunichst die Schritte 1 bis 3 durchfiihren, dann PhotoSuite 6ffnen, “File>Open Photo” wihlen und
im “Look in” Menii “My Computer” wihlen, dann die “Removable Disk” wihlen und die darin enthaltenen
Ordner bis zu den JPEG Fotodateien 6ffnen. Wenn auf diese Weise ab einer angeschlossenen Kamera gearbeitet
werden soll, sichergehen, dafl das Foto vorher auf der Festplatte gesichert wird (nach Abschluf§ der Bearbeitung)
und nicht in den Speicher der Kamera oder die Karte. Hierfiir unter PhotoSuite zunichst auf “Done” (Fertig)
klicken, dann auf “Save Changes?” (Anderungen sichern?) mit “Yes” antworten, dann aber auf “Replace Existing
File”? (Vorhandene Datei iiberschreiben?) mit “No” antworten und die “Save As” (Sichern als) Dialogbox dazu
benutzen, das bearbeitete Foto in einem Ordner auf der Festplatte zu sichern (“Save In>Local Disk”), (Sichern
in>Lokale Festplatte) und nicht auf “Removable Disk” (Kamera).

8. Ein Anfinger bei der Fotobearbeitung im Computer das Hilfe-Menii der Software nach Tips zur Benutzung
ihrer Merkmale befragen, (PhotoSuite hat umfangreiche eingebaute Hilfe). Bei der Anpassung von Helligkeit,
Kontrast, Schirfe und Farbe der Fotos kann das Foto so bemessen werden, daff es bei Ausdruck auf das Papier
paflt, und es kann eine kleinere Datei mit niedriger oder mittlerer Aufldsung gesichert werden, die in E-Mails
oder Dokumente eingefiigt wird. Wenn die bearbeitete Datei gesichert werden soll, kann “Save As” benutzt und
ihr ein besser beschreibender Name als “100BN___” gegeben werden. Hierbei wird auch die Originaldatei als
Sicherung erhalten, die spiter erneut gedffnet und neu bearbeitet wird. Sichergehen, daf§ alle Fotos, die gesichert
werden sollten, mit Erfolg iibermittelt wurden, bevor “Delete All” (Alles 16schen) auf der Kamera gewihle wird,
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Referenz fiir Foto-Speicherkapazitiit (max. Kapazitit, +/- 2 Fotos)

Bildgro3e

Megapixel
(ca.)

Qualicit *

Interner

Speicher*™

64 MB
SD-Karte

* Wihlt den Umfang der Kom-
pression der Datei (jpg Verhiltnis)
(FQ = gering / EQ = stark)

FQ: Feine Qualitit (1:4)

L 2.048 x
1.536

3,1

FQ

15 Fotos

60 Fotos

NQ: Normale Qualitit (1:8)
EQ: Sparqualitit (1:16)

**Interner RAM verfiigbar fiir

NQ

31

124

Fotodateien: 16 MB

EQ

62

248

Die Bildgrofe bezieht sich auf
die Pixel-Abmessungen, oder die
Auflésung, der digitalen Datei.

M 1.600 x
1.200

2,1

FQ

25

100

Die tatsichliche Speicherkapazitit
schwankt je nach Inhalt jeder
Fotodatei. Es kann méglich sein,

NQ

51

204

einige Fotos mehr oder weniger
als mit der aufgelisteten Kapazitit
aufnehmen zu kénnen.

EQ

102

408

Eine grofe Grofle und hohe

S 640 x 480

0,35

FQ

160

640

Qualitit fiir Fotos einstel-
len, die spiter vergrofert oder

NQ

321

1284

abgeschnitten werden sollen. Sie
kénnen bei Bedarf auch mit der
Foto-Software auf eine kleinere

EQ

642

2568

Dateigrofie reduziert werden.
Geringe Gréfe und/oder geringe
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Qualitit einstellen, wenn die
Fotos nur per E-Mail versandt, in
Dokumente eingefiigt oder kleine
Drucke davon angefertigt werden
sollen und die Datei spiter nicht
verindert werden soll.

ZWEIJAHRIGE BESCHRANKTE GARANTIE

Sie erhalten fiir Thr Bushnell®-Produkt eine Garantie fiir einen Zeitraum von zwei Jahren ab dem
Kaufdatum. Die Garantie erstreckt sich auf Material- und Herstellungsfehler. Fiir den Fall, dass ein
Mangel im Rahmen dieser Garantie auftritt, werden wir das Produkt nach unserer Wahl reparieren
oder austauschen, vorausgesetzt, dass Sie das Produkt freigemacht zuriickschicken. Von dieser Garantie
ausgeschlossen sind Schiden, die auf Missbrauct hgemife Behandl Installations- oder
‘Wartungsarbeiten, die nicht von einer autorisierten Bushnell-Kundendi bteil
werden, zuriickzufiihren sind.

Jeder Riicksendung im Rahmen dieser Garantie miissen folgende Dokumente und Angaben beigefiige
werdens

1) Ein Scheck/eine Zahlungsanweisung in Hohe von 10,00 USD zur Abdeckung der
Porto- und Bearbeitungskosten

2)  Name und Anschrift fiir die Riicksendung des Produkes

3)  Eine Erliuterung des Mangels

4)  Nachweis des Kaufdatums

S)  Das Produke sollte zur Vermeidung von Transportschaden gut verpacke in einem
stabilen Versandkarton an die nachstehend aufgefithree Adresse geschicke werden,
wobei die Gebithren fiir die Riicksendung im Voraus zu entrichten sind.

Adresse fiir Riicksend in die USA:
Bushnell Performance Optics

Aten.: Repairs

8500 Marshall Drive

Lenexa, Kansas 66214

Adresse fiir Riicksendungen nach KANADA:
Bushnell Performance Optics

Actn.: Repairs

25A East Pearce Street, Unit 1

Richmond Hill, Ontario L4B 2M9

Bei Produkten, die Sie auBerhalb der Vereinigten Staaten oder Kanadas gekauft haben, erhalten Sie
die entsprechenden Informationen zur Garantie von ihrem Hindler vor Ort. In Europa erreichen Sie
Bushnell auch unter: BUSHNELL Performance Optics Gmbh

European Service Centre

MORSESTRASSE 4

D- 50769 KOLN

Deutschland

Tél: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

Mit dieser Garantie erwerben Sie bestimmte Rechtsanspriiche.
Sic haben maglicherweise dariiber hinaus noch andere Rechte, die von Land zu Land variieren.
©2005 Bushnell Performance Opics

Marnale-S. h And-D. 1 d
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Anmerkung beziiglich FCC Richtlinien:

Dieses Geriit wurde getestet und es wurde als mit
den Vorschriften fiir ein digitales Gerit der Klasse B
iibereinstimmend befunden, gemiss Teil B der FCC
Vorschriften. Diese Vorschriften wurden entwickelt, um
innerhalb eines Wohnhauses cinen verniinftigen Schutz
vor gefihrlichen Interferenzen zu gewihrleisten. Dieses
Gerit erzeugt und verwendet Radiofrequenzenergie
und kann diese ausstrahlen und, wenn dieses nicht in
Ubereinstimmung mit der Bedienungsanleitung eingesetzt
wird, kann es den Rundfunkverkehr empfindlich storen.
Es gibt jedoch keinerlei Garantie dafiir, dass die Stérung
in einer bestimmten Einrichtung nicht auftritt. Wenn
dieses Gerit stérende Auswirkungen auf den Radio-
oder Fernsehempfang haben sollte, die durch Aus- und
Einschalten des Geriites festgestellt werden kénnen, ist
es fiir den Geritenutzer méglich, eine Behebung der
Stérung mit Hilfe einer oder mehrerer der folgenden
Mafinahmen zu erreichen:

- Neuausrichtung oder N
- Das Gerit mit einem Ausgang eines Netzes verbinden, das in
keinerlei Verbindung zu dem Netz steht, womit der Receiver
verbunden ist.

- Fragen Sie den Fachhindler oder einen erfahrenen Radio-
oder Fernsehtechniker um Rat.

ung der Empfar

Unter Beachtung der Vorschriften fiir ein digitales
Gerit gemifl Unterartikel B des Abschnitts 15 der FCC
Richtlinien ist ein abgeschirmtes Interface-Kabel mit dem
Gerit zu verwenden.

Der Hersteller behilt sich das Recht auf die
Durchfithrung von Anderungen von Spezifikationen
und Konstruktionsmerkmalen ohne jegliche vorherige

Ankiindigung oder Verpflichtung vor. CE 9 5
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Grazie per aver scelto il binocolo Bushnell® Compact Instant Replay™! Compact Instant
Replay ¢ ideale per tutti gli eventi sportivi e I'osservazione della natura, in quanto abbina
un binocolo di dimensioni contenute, ingrandimento 8x, ad una versatile fotocamera
digitale da 3.2 megapixel dotata di capacita video straordinarie. Compact Instant Replay
ha una “doppia personalita”, permettendo di scattare fotografie digitali ad alta risoluzione
e riprendere sequenze video che “ciclano”, o rinfrescano, ogni 8 — 60 secondi (a seconda
delle impostazioni della qualitd). Avrete sempre la certezza di catturare i momenti pil
importanti dell’evento! Le vostre foto e i vostri video sono automaticamente conservati nella
memoria interna, o su una card SD (Secure Digital) opzionale, e possono essere visionati
immediatamente sullo schermo LCD ribaltabile, riprodotti su un televisore o scaricati sul
computer, senza bisogno di installare alcun software speciale (con Windows 2000, XP o
Mac. Il software viene fornito per Windows 98/98SE).

Prima di usare il Compact Instant Replay, vi preghiamo di leggere le istruzioni contenute

nel presente manuale e imparare a conoscere il funzionamento della fotocamera e le molte
notevoli caratteristiche del prodotto.
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GUIDA DI CONSULTAZIONE RAPIDA: BUSHNELL INSTANT REPLAY 11-8323

Installazione Inserite 2 pile alcaline AAA (vedere le “Specifiche”) nel vano portapile in basso sulla cassa della foto-
p p portap!
delle pile e camera (notare la polarita delle pile indicata all'interno. Per aumentare la capacita di memoria delle
p foto, ¢ possibile installare una card di memoria SD (opzionale) nello slot apposito, situato sul retro della
della card SD cassa della fotocamera (tirare in basso la copertura di gomma dello slot delle card; inserire la card con il lato
opzionale ell’etichetta rivolto in basso fino a quando non sentite un clic, e rimettere a posto la copertura di gomma).
(op ) dell’etich ivolto in basso fino a quand i li i posto la cop: dig )
ccensione della zate il display a , usando la linguetta sul retro. Premete e rilasciate I'interruttore . La
A i della | Al il display a LCD do la ling; 1 P ilasciate I'i POWER. L:

fotocamera

schermata di avvio sul display lampeggera, quindi scompare ¢ il LED rosso dell’alimentazione rimar-
ra acceso. Premete “LCD/Mode” per accendere di nuovo il display; vedrete un’anteprima dal vivo
dell'immagine dall’'obiettivo della fotocamera, situato fra gli obiettivi del binocolo. Per risparmiare la
carica delle pile, il display si spegnera automaticamente dopo 2 minuti di inattivita della f%tocamera.
Potete anche spegnere manualmente il display premendo il pulsante LCD/Mode; per scattare le foto,
non ¢ necessario che il display sia acceso. La fotocamera si spegnera automaticamente dopo 5 minuti
di inattivita (non ¢ stato premuto alcun pulsante). Per spegnere manualmente la fotocamera, premete e
rilasciate il pulsante POWER. Le impostazioni predefinite a'%l/t;fotﬂmmem garantiscono la qualite migliore
perla maggio;,pﬂrte delle condizioni. Tuttavia, vi raccomandiamo di leggere l'intero manuale per approfittare delle
molte opzioni disponibili nei diversi menu per le diverse situazioni fotografiche e le proprie preferenze personali.

Formattazione
della card SD

(opzionale)

Se avete gia installato una card SD, formattatela prima di usare la fotocamera. Premete il pulsante
Menu/OK al centro del tastierino colore argento. Premete il tasto Freccia in basso 4 volte per selezionare
“ Format” (Formatta). Premete il tasto Freccia a destra, quindi Freccia a sinistra per selezionare “Yes”
(S1). Premete Menu/OK: vedrete un messaggio di avvertenza indicante che tutte le immagini saranno
cancellate; selezionate “Yes” e premete di nuovo OK. Usate Freccia in basso per selezionare “Exit” (Esci)
e premete OK.

Regolazione
delle ottiche del
binocolo per la
propria vista

Se portate gli occhiali, abbassate i bordi degli oculari di gomma. Regolate la distanza fra il cilindro destro
e sinistro del binocolo mentre guardate nel binocolo, fino a quando I'immagine che vedete & una sola im-
magine circolare. Trovate quindi un oggetto lontano con fini particolari, e regolate la manopola centrale
per la messa a fuoco fino a quando l'oggetto appare nitido nell’oculare sinistro. Adesso guardate solo
attraverso 'oculare destro. Se 'oggetto non appare parimenti nitido, ruotate 'oculare destro (regolazione
diottrica) fino a quando non ¢ nitido. Una volta regolato, non dovrete pil1 spostare questa regolazione
diottrica, e potete semplicemente mettere a fuoco usando la manopola centrale.

;O
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GUIDA DI CONSULTAZIONE RAPIDA: BUSHNELL INSTANT REPLAY 11-8323

5

Scatto di una
foto o ripresa
di un breve
filmato

Per scattare una foto, tenete ferma la fotocamera con entrambe le mani e premete il pulsante SNAP.
Sentirete un “segnale acustico” (che pud essere disattivato), seguito da una breve pausa (appare I'icona
dei file) mentre la fotocamera salva la foto in memoria. Per fare una ripresa video, premete una volta
Menu/OK, quindi Freccia a destra, per vedere le opzioni video del menu Camera. Usate i tasti Freccia
in alto/in basso per selezionare video Replay (ciclo) o Normale (continuo), quindi premete Menu/OK.
Tornerete alla visualizzazione di anteprima dal vivo, e potere iniziare la ripresa video in qualsiasi mo-
mento premendo SNAP. Per interrompere la registrazione video, premete di nuovo SNAP. Leggete la
sezione “Modaliti video” per una spiegazione dettagliata delle differenze fra le modalita Replay e Normale,
compreso il modo in cui viene determinata la durata della registrazione video.

Revisione e
cancellazione
di foto/video

Per rivedere o riprodurre una foto o un video, premete il pulsante LCD/Mode (premere due volte se il
display non ¢ gia attivato). Vedrete la foto o il video piti recente (primo fotogramma). Per rivedere foto
o video precedenti, una/o alla volta, premete Freccia a sinistra. Licona nell’angolo in basso a destra sul
display indichera se il file attualmente in revisione ¢ una foto, o un video normale o un video a “ripro-
duzione istantanea”. I numeri sopra questa icona mostrano il numero del file corrente/file totali (2 di
3, ecc.) Per riprodurre un video memorizzato, premete il tasto Freccia in basso (premetelo di nuovo per
interrompere la riproduzione). Per vedere subito immagini “in miniatura” di diverse foto/diversi video
memorizzati, premete Freccia in alto dopo essere entrati in modalita di revisione. Usate i tasti delle
frecce per selezionare un singolo file, quindi di nuovo Freccia in alto per vederlo il fotogramma intero.
Per cancellare una foto o un video, premete Menu/OK, quindi premete una volta Freccia in basso (icona
Cestino). Premete Freccia a destra, selezionate Delete One (Cancella uno) o Delete All (Cancella tutti),
quindi premete Freccia a destra e selezionate Yes (Si). Tornate alla colonna Menu, selezionate Exit (Esci)
e premete Menu/OK per tornare alla schermata Review (Rivedi).

Collegamento
al computer e
trasferimento

delle foto

Prima di collegare la fotocamera, installate il driver dal CD-ROM, se usate Windows 98/98SE, ¢ instal-
late PhotoSuite, se non disponete gia di un software per il foto editing. Collegate il cavo USB, fornito,
dalla presa USB della fotocamera (sul retro della cassa della fotocamera) ad una porta USB del computer.
Se usate Windows XP, seguite semplicemente le istruzioni/opzioni che appariranno automaticamente
sullo schermo. Se usate Win 98 o 2000, aprite “Risorse del computer” sul PC. La fotocamera ¢ identi-
ficata come un “Disco rimovibile” — le vostre foto sono nella cartella: trascinatele o copiate/incollate le
foto in una cartella qualsiasi del vostro disco rigido. Fate riferimento alla sezione “Trasferimento delle
foto” di questo manuale.
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Specifiche tecniche

Ingrandimento 8x Dimensione delle foto (Risoluzione) | 2048x1536, 1600x1200, 640x480
Diametro 30mm Indice di compressione dei file 1:4 (FQ), 1:8 (NQ), 1:16 (EQ)
dell’obiettivo (Qualita)

Pupilla di uscita 3,75 Memoria interna 16MB di memoria flash

Campo visivo 320 fral000 yds Espansione della memoria Card Secure Digital, sino a 1 GB di capacita
Estrazione pupillare 13mm Formato dei file (Foto/Video) JPEG / MJPEG (.AVI)

Trattamento della
lente

Completamente
trattate

Gestione dei file

DCEF (versione 1.0), formato FAT 16

Tipo di prisma

A tetto, BaK-4

LCD

1.8” TFT, 120.840 pixel

Intervallo di messa
a fuoco (binocolo)

18’ - inf.

Risoluzione video/ Frequenza
fotogrammi

620x480 o 320x240 pixel per fotogramma. Durata ciclo modo

Replay: 8/15/30/60 secondi (per risoluzione/fps selezionati)

Peso

2502/ 406,5 g

Uscita video

NTSC/PAL, via porta USB a 8 piedini con cavo speciale (fornito)

1/1000 di secondo

Tipo di sensore CMOS Intervallo valori esposizione +/- 2 EV in successione di 0.5 EV

Pixel efficaci 3.2 Megapixel Opzioni equilibrio bianco Auto, Luce diurna, Nuvoloso, Fluorescente, Incandescente
Colore colore a 24 bit Scene prefissate Programma, Sport, Paesaggio, Ritratto, Notte

Otturatore Elettronico da 1/16 a Lingue del Menu Inglese, Spagnolo, Francese, Tedesco, Italiano, Portoghese,

Giapponese

Intervallo messa a
fuoco (fotocamera)

Fissa, circa 60* ~
infinito

Spegnimento automatico (dopo
inattivitd)

Schermo LCD: 2 Min. / Tutta 'alimentazione: 5 Min.

Apertura
dell’obiettivo

/5.6

Alimentazione

2 pile AAA alcaline/litio/NiMh

om. All Manuals Search And Download.

101



Identificazione delle parti

tazione)

Display LCD

Pulsante LCD/Mod:

Tastierino a 5
direzioni con pul-
sante Menu/OK

Manopola cen-
trale di regolazi-
one della messa a

# fuoco (binocolo)

diottrica

102

Porta USB/Uscita video

Segnale
acustico

LED alimentazione

Slot card SD
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Icone della visvalizzazione di anteprima sullo schermo LCD

Visualizzazione di anteprima delle foto

[

e

Video normale
Visualizzazione Film (Video)

' Video Replay

# | Icona # | Icona
1 | Indicatore delle pile (mostrate con 2/3 della carica) 1 | Indicatore delle pile (piene)
2 | Numero di foto rimanenti (in base alla memoria disponibile) 2 | Secondi Totale di video
3 | Modalita Foto Risoluzione (Dimensione dei file) disp Om.bde. (in b.as? alla
- - - memoria disponibile)
4 Quahté (COmPfCSSlOnC dei ﬁlC) Fine/Normale/Economica - N
3 | Modalita Film
5 | Risoluzione (Dimensione dei file) LugoediumiSmall (grandetmediafpiccole) - -
P POTOR Risoluzione (FQ=640x480/
uul1IDrio bl1anco Non visualizzata a meno che non venga cambiata da _

%:;lto” predefinito in Esposizione g NQ—320X'240)
7 Scena  Non visualizzata a meno che non venga c dal “P; ” predefi 5 FI'CquCIlZa fotogrammi

ito nel menu Modalit (30 4 15_]‘]75)
8 dallta %resa in sequenza Non visualizzata a meno che non venga 103
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Capovolgete il binocolo Compact Instant Replay e aprite la copertura delle pile
spostandola nella direzione indicata a destra. Inserite 2 pile alcaline AA o al litio nel
vano portapile nella direzione indicata nei diagrammi all'interno, quindi rimettete
a posto la copertura delle pile fino a quando non si sente uno scatto. Noza: possono
essere usate anche le pile ricaricabili di tipo NiMb, ma alcuni modelli possono
non fornire corrente adeguata per alimentare I'Instant Replay. Le pile tipo NiMh
raccomandate sono quelle di corrente nominale di 2300 mAb o superiore.

La fotocamera pud memorizzare da 12 a 642 foto nella memoria interna da 16 MB,
a seconda delle impostazioni della risoluzione e della qualita (consultate la tabella sul
retro di questo manuale). Per espandere la memoria disponibile, potete aggiungere
una scheda di memoria opzionale tipo card Secure Digital (SD), con capacita sino
a 1 GB. La card viene inserita in uno slot sul retro della cassa della fotocamera,
come mostrato nell'ultimo diagramma. Inserite la card CF con il lato dell’etichetta
rivolto in basso. Nota: per evitare la perdita di file o danni alla card, spegnere
la fotocamera prima di inserire o rimuovere la card. Una scheda nuova non deve
essere formattata, ma una scheda gid usata in altri dispositivi deve essere formattata
da Compact Instant Replay prima di memorizzarvi le foto (fate riferimento a “Menu
di impostazione” nella sezione seguente). La formattazione di una card usata in
precedenza causera la cancellazione di tutti i file memorizzati su di essa; pertanto,
se desiderate conservare i file, vi ricordiamo di scaricare o copiare i file prima di
formattare la card.
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Slot per card
(copertura sollevata)

Preparazione di base del binocolo e della fotocamera

Prima di scattare le foto o fare riprese video, regolate il binocolo Compact Instant Replay secondo la vista dei vostri occhi e le vostre
preferenze. Se non portate gli occhiali, lasciate in posizione rialzata i bordi di gomma degli oculari di gomma, oppure abbassateli se
invece portate gli occhiali. Afferrate i lati sinistro e destro del binocolo, e separateli o avvicinateli mentre guardate nel binocolo per rego-
lare la distanza fra gli oculari, fino a quando I'immagine che vedete ¢ una sola immagine circolare. Trovate un oggetto lontano con fini
particolari (albero, cartello, muro di mattoni, ecc.) e regolate la manopola centrale per la messa a fuoco fino a quando I'oggetto appare
nitido, quando viene guardato attraverso solo I'oculare sinistro. Guardando poi allo stesso oggetto attraverso I'oculare destro, ruotate
Toculare fino a quando 'immagine appare nitida anche per il vostro occhio destro. Questa operazione si chiama regolazione diottrica, e
compensa ogni differenza fra la vista dell'occhio destro e quella dell’occhio sinistro. Una volta eseguita questa regolazione, non dovrete
pitt cambiarla: basta che usate la manopola di messa a fuoco centrale per mettere a fuoco attraverso il binocolo oggetti qualsiasi distanza
(la distanza focale minima ¢ di circa 16 piedi o 4,87 metri).

Le foto digitali ¢ i video non subiscono alcun effetto dalla manopola di messa a fuoco centrale, poiché I'obiettivo della fotocamera,
situato fra le lenti del binocolo, non richiede la messa a fuoco; ¢ gia impostato in modo che oggetti distanti da 18 metri all'infinito
saranno a fuoco. Tenete presente che il binocolo ¢ capace di mettere a fuoco pitt vicino della fotocamera. Controllate I'immagine di an-
teprima sul display LCD per verificare che siete lontani abbastanza per ottenere foto nitide. Lobiettivo della fotocamera & capace di un
ingrandimento 8x, uguale a quello delle ottiche del binocolo, ed ¢ allineato in modo che un oggetto centrato nella visione al binocolo
sara anche centrato nelle foto e nei video. Pertanto, non & necessario che 'LCD sia acceso né che sia alzato mentre si scattano foto o si
riprendono video. Riducendo I'uso dell’LCD si allunga notevolmente la durata delle pile

Prima di usare la fotocamera per la prima volta, potete anche andare al menu della fotocamera e impostare la data corretta. Alzate il dis-
play LCD e premete il pulsante POWER. Quando si accende la luce spia rossa, premete LCD/Mode per accendere il display. Premete
il pulsante Menu/OK al centro del tastierino, quindi premete il tasto Freccia in basso 3 volte per accedere al menu “Impostazione”.
Premete una volta il tasto Freccia a destra, seguito dal tasto Freccia in basso, per accedere a “Date”(Data). Premete quindi due volte il
tasto Freccia a destra per accedere all'impostazione della data. Usate i tasti Freccia a sinistra/destra per selezionare la parte della data che
volete cambiare, quindi premete i tasti Freccia in alto/in basso per cambiarla. Per cambiare il formato della data in modo da visualizzare
il mese, il giorno e I'anno nel modo desiderato, portatevi all'icona delle “frecce” in alto a sinistra del display della data, quindi premete
i tasti Freccia in alto/in basso. Impostate I'ora (formato delle 24 ore) con i 4 numeri in fondo al display della data, in modo che la data
cambi automaticamente alla mezzanotte della vostra localitd. Una volta che la data e 'ora sono impostate, premete una volta il tasto
della Freccia in basso e scegliete se volete che la data appaia o no sul display e sulle foto (“Show Date On/Off “ — Mostra data: si/no).
Continuate a premere la Freccia a sinistra fino a quando non tornate a “Impostazione”, scorrete in basso fino a “Exit” (esci) ¢ premete

Menu/OK.
105
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Come scattare una foto

Dopo la preparazione iniziale, descritta nelle pagine precedenti, siete pronti a scattare le foto:

1) Alzate il display LCD e premete brevemente il pulsante POWER (il LED rosso si accende). Premete il pulsante LCD/Mode per
accendere il display LCD se volete vedere un’anteprima dell'immagine o controllare le impostazioni del menu, le condizioni delle pile,
ecc.

2) Quando viene acceso per la prima volta, Compact Instant Replay si imposta, per definizione, nella risoluzione e nella qualita piti alta,
nonché in “tutto automatico”, cosi che potete scattare subito foto eccellenti. Se preferite usare altre impostazioni, consultate la sezione
“Uso del menu principale” per istruzioni su come trovare e cambiare impostazioni quali risoluzione e esposizione, uso di impostazioni
predefinite di scena per soggetti pilt comuni ed altre opzioni.

3) Potete comporre la foto mentre guardate attraverso il binocolo (per scattare una foto, non ¢ necessario che I'LCD sia acceso). Tut-
tavia, per inquadrature pilt accurate, il controllo dell’anteprima sull’LCD ¢ raccomandato.

4) Accertatevi di essere lontani almeno 18 metri dall’oggetto da fotografare. Le ottiche del binocolo si mettono a fuoco a distanze mi-
nori, ma la messa a fuoco della fotocamera ¢ impostata per risultati migliori con oggetti lontani (nessuna messa a fuoco ¢ necessaria per
la fotocamera). Per verificare che 'oggetto non sia troppo vicino, e ottenere pertanto una foto nitida, potete usare il display LCD.

5) Con entrambe le mani, tenete la fotocamera quanto pil ferma possibile e, lentamente, premete il pulsante SNAP. 1 display si
oscurera brevemente mentre il file viene memorizzato (appare I'icona delle cartelle); quindi, potrete scattare un’altra foto. Il contatore
nell’'angolo in basso a destra cambia per visualizzare la capacita residua per le foto, che dipende dalla quantita di memoria interna o della
card disponibile, nonch¢ dalle impostazioni della risoluzione e della qualita (¢ possibile passare in qualsiasi momento a impostazioni
inferiori per includere un numero di foto maggiore nella memoria residua). Nota: il contatore non scenderd sempre di un numero
dopo che viene scattata una foto; tutto dipende dalle impostazioni e dal contenuto effettivo reale di ogni foto. Quando il contatore
raggiunge “000”, la memoria ¢ esaurita (spazio di conservazione) e dovreste scaricare le foto che desiderate tenere al PC, in modo che
le foto scaricate possono essere cancellate, oppure estracte e installate un’altra card SD.

6) E disponibile uno zoom digitale con potenza d’ingrandimento fino a 6x. Premete il tasto Freccia a destra per zumare (vedrete il
risultato sul display LCD). Premete il tasto Freccia a sinistra per togliere la zumata.

7) Per controllare la foto appena scattata, premete il pulsante LCD/Mode, quindi premetelo di nuovo per tornare ad un’anteprima dal
vivo. Per maggiori informazioni su come rivedere foto scattate in precedenza, consultate la sezione “Menu Revisione”.
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Come fare una ripresa in modalita video Normal (normale) o ‘Instant Replay’

1) Seguite i passi da 1 a 4 della procedura “Come scattare una foto”, spiegata in precedenza.

2) Per passare dalla modalita foto a quella video, e viceversa, premete il pulsante Menu/OK. 1l primo gruppo di menu ¢ “Camera”:
premete il tasto Freccia a destra, quindi il tasto Freccia in alto/in basso per selezionare la modalita video Normal o Replay (dopo aver
selezionato la modalita video, la fotocamera torna alla visualizzazione di anteprima dal vivo, permettendovi di fare subito una ripresa).
In una modalita qualsiasi, premete SNAP per iniziare una nuova registrazione video, e premetelo di nuovo per interrompere la regist-
razione e conservare il video nella memoria. Le due modalita video differiscono come segue:

Modalita video Normal: iniziera una sequenza video continuata a partire dal momento in cui viene premuto il pulsante SNAP e ter-
mina quando il pulsante viene premuto di nuovo. La durata della registrazione dipende solamente dalla quantita di memoria interna
o della card al momento disponibile. Potete registrare un unico video lungo fino a quando non avete pitt memoria disponibile, oppure
diversi video pili brevi fermando e avviando la registrazione ogni volta che volete, premendo il pulsante SNAP. Il contatore mostra il
tempo approssimato di registrazione a disposizione rimanente (in secondi) quando la registrazione viene interrotta, e riprende il conto
alla rovescia quando viene iniziata un registrazione video in modalith Normal.

Modalita video Replay: al termine di un predeterminato limite di tempo (determinato dalle impostazioni fatte nel menu Setup per la
risoluzione video e la frequenza dei fotogrammi), la sequenza video comincia a “ciclare”, o a registrare di nuovo dall’inizio, cancellando
e sostituendo le precedenti registrazioni. Questa modalita ¢ ideale per filmare momenti salienti di un evento sportivi, quali un goal
di una partita di calcio, poiché potete iniziare a registrare in qualsiasi momento, quindi fermare la registrazione dopo che ¢ passato il
momento saliente dell’evento. Sarete certi di aver registrato il momento saliente, e non avrete bisogno di ricercarlo in una serie di video
precedenti o di riavvolgere in continuazione per vederlo e rivederlo di nuovo. I cicli sono disponibili in lunghezze di 8, 15, 30 o 60
secondi: quanto pil alti sono i valori della risoluzione e dei fotogrammi al secondo, tanto pilt breve sara il ciclo. In modalita Replay, il
contatore mostra il tempo di registrazione a disposizione rimanente (in secondi) quando la registrazione viene interrotta, e riparte da
zero fino al termine della durata limite del ciclo, quando inizia la registrazione. Terminato un ciclo, quando inizia la nuova registrazione
da zero, il contatore si azzera automaticamente e riparte. Tenete presente che se interrompete una registrazione durante un nuovo ciclo,
il video conterra I'ultima parte del ciclo (video) precedente e la prima parte del nuovo; la fotocamera salva sempre 8, 15, 30 0 60 secondi
degli eventi pilt recenti. Prima di usare questa modalita durante un evento sportivo importante, fate un po’ di pratica e sperimentatela
per capire bene come funziona.

3) Premete il pulsante LCD/Mode se desiderate controllare un video dopo averlo ripreso. Premete il tasto Freccia in basso per iniziare
la riproduzione, premetelo di nuovo per interromperla. Premete il tasto Freccia a sinistra/a destra per rivedere video o foto precedenti.
Premendo la freccia in alto verra visualizzata una rassegna “in miniatura’di diversi file: usate i tasti delle frecce per evidenziare il file
che desiderate rivedere, quindi premete Menu/OK per selezionarlo e vederlo. Quando siete pronti per tornare alla visualizzazione di
anteprima dal vivo per riprendere altri video (o scattare altre foto), premete il pulsante LCD/Mode.

4) Per maggiori informazioni su come rivedere e cancellare video gia filmati, vedere la sezione “Menu Revisione”. 107
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E gia stato menzionato in questo manuale che Compact Instant Replay viene consegnato impostato sulla pitt alta
risoluzione e qualitd delle immagini disponibile. Lesposizione, 'equilibrio bianco ed altre variabili sono impostate
automaticamente. Cid significa che otterrete buoni risultati per la maggior parte dei soggetti e delle condizioni di luce,
senza bisogno di accedere ai menu e cambiare le impostazioni. Tuttavia, vi raccomandiamo di imparare a conoscere
bene le opzioni disponibili in modo che possiate migliorare le vostre foto se, per esempio, pensate che siano troppo
scure (fatto comune per le scene con neve per la maggior parte delle fotocamere digitali) oppure troppo verdi (in pre-
senze di alcuni tipi di illuminazione fluorescente). Il menu principale, o di registrazione, ¢ organizzato in sei gruppi.
Per vedere i sei gruppi, premete il pulsante “Menu/OK”. Selezionate un gruppo con i pulsanti Freccia in alto e freccia
in basso, quindi usate il tasto Freccia a destra e i tasti Freccia in alto/in basso per vedere le voci o le opzioni disponibili
nel gruppo. Segue una descrizione generale dei gruppi del menu e le rispettive funzioni:

Uso del menu principale continvazione

Gruppo del menu | Icona Funzione

Permette di selezionare le modalita Foto o una o due modalita film (video). Le
opzioni del menu qui mostrano sempre le due modalita che al momento non
sono usate. Per esempio, se siete gid nella modalita video Replay, le altre opzioni

Modalita Camera

o modalita video Normal (icona di una videocamera con freccia diritta)

Gruppo del menu | Icona Funzione
Setup Offre le opzioni per 'impostazione di Resolution [risoluzione] (dimensione dei
(Impostazione) @ file), Quality (compressione dei file, EV (valore esposizione), WB (equilibrio

bianco) e ISO (sensibilita luminosa).

Format Prepara per 'uso una card di memoria SD nuova o gia utilizzata. Cancella tutti

(Formatta) i file contenuti nella card. Pud essere usata anche per cancellare velocemente
tutto il contenuto della memoria interna se non ¢ installata una card SD.

Exit Esce dal menu principale e torna all'immagine di anteprima dal vivo.

(Esci)

@ saranno visualizzate nel menu Camera: modalita Foto (icona della fotocamera)

Exposure Contiene le opzioni per impostare WB (equilibrio bianco) e EV (valore

(Esposizione) dell’esposizione) per perfezionare la resa del colore e I'esposizione per le diverse
condizioni, se le impostazioni automatiche standard non producono la qualita
o i risultati desiderati.

Mode — Permette di scegliere “Scene” preimposate che ottimizzano le impostazioni della

(Modalit) ;} fotocamera per momenti di eventi sportivi, paesaggi e altri soggetti comuni di
fotografie. Questo gruppo del menu offre anche le opzioni fotografiche Selt

— Timer (Timer automatico) e Rapid Sequence (Sequenza rapida).
108

Le pagine seguenti contengono 'elenco completo di ogni voce e impostazione disponibile nel menu principale, in-
sieme alla descrizione della rispettiva funzione. Seguite la stessa procedura usata nell’esempio precedente per spostarvi
fra le schermate dei menu, per evidenziare e cambiare un’'impostazione in maniera adeguata alle vostre esigenze o
preferenze. Il menu Revisione ¢ diverso, ma & pitt semplice, con solo quattro gruppi (Diapositive, Cancella, Editor e
Esci). Per una descrizione completa, consultate la sezione “Menu Revisione”.
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Sistema del menu prlmlpule (e impostazioni predefinite sono in grassetto)

Le i joni Scena e S

Sistema del menu principale continvazione

Gruppo

Voce

Impostazioni

Descrizione

1p non sono di in “Modaliti” quando la “Camera” é impostata su video Normale o Replay.
Gruppo Voce Impostazioni Descrizione
CAMERA Foto Icona della foto- Fotografie 3.2 megapixel fotogrammi fissi
camera
Video clip Video Normal (icona | Riprende video standard continuo, con durata limitata solo dalla
del film con freccia memoria interna o della card SD rimanente disponibile
diritta)
Video Replay (icona | Riprende video a cicli ripetuti, registrando sopra video precedenti.
del film con freccia La durata dei cicli & fissa (da 8 a 60 secondi), determinata dalla
accerchiante risoluzione del video e dalla frequenza dei fotogrammi (FPS).
ESPOSIZIONE | WB (equilibrio | Auto Lequilibrio bianco & impostato automaticamente per la corretta
bianco) riproduzione del colore
Daylight Impostazione manuale per situazioni all’aperto in pieno sole

(luce del giorno)

Lampadina Impostazione manuale per illuminazione d’interni al tungsteno
(lampadine)
Fluorescent Impostazione manuale per illuminazione d’interni al neon
(luci al neon)
Cloudy Impostazione manuale per situazioni all’aperto con cielo nuvoloso
(nuvoloso) o in ombra
EV -2.0 - +2.0 Permette di regolare manualmente la sottoesposizione o la sovraes-

posizione in valori di 0.5 EV. I valori negativi producono foto pilt
scure; quelli positivi, foto pit chiare.
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modalita video
Normal

(Risoluzione
¢ FPS

MODE Scene * (scena) | Programma Esposizione automatica standard per la maggior parte dei soggetti o scopi generali
Sport Usa le velocita piti alte dell’otturatore per aiutare a fermare il movimento
Landscape Zona di messa a fuoco pili profonda per accentuare la nitidezza dal primo piano allo sfondo.
(pacsaggio)
Portrait (ritratto) | Zona di messa a fuoco meno profonda per foto di persone; aiuta ad isolare il soggetto dallo sfondo.
Notte Lotturatore opera a velocita inferiori per migliorare 'esposizione in ambienti poco illuminati
Timer auto- Si/ No La foto scatta qualche secondo dopo la pressione del pulsante Snap.
matico
Sequenza * 3 05 foto- 3 0 5 fotogrammi presi in rapida sequenza quando si preme il pulsante Snap
grammi
SETUP Misura / Dimen- 3 scelte per le dimensioni delle immagini: L(2048x1536 pixel), M (1600x1200 pixel), o S
(Im- Qualita sioni immagine | (640x480 pixel) - le risoluzioni pilt elevate producono immagini pit nitide / pitt grandi ma
postazi- (Foto) (risoluzione) riducono lo spazio di memoria disponibile.. Le impostazioni pilt basse permettono di memorizzare
oni) pitt foto, e-mail, ecc. L=3.1MP / M=2.1MP / $=0.35MP
Qualita Imposta la compressione dei file jpg. Le impostazioni sono: Fine-FQ (compressione 1:4), Normal-
Indice di com- NQ (1:8) ed Economy-EQ (1:16). Questa impostazione pud essere usata indipendentemente da
pressione dei file gue]la di Image Size (Dimensioni Immagine) quando si preferisce memorizzare piti foto a scapito
(Qualita) ella qualica.
Solo in Qualita 640x480 pixel per fotogramma (risoluzione)> a 30 o 15 fotogrammi al secondo (frequenza foto-

grammi) 320x240 pixel per fotogramma >a 30 o 15 fotogrammi al secondo (Dopo aver scelto la
risoluzione, premete la freccia destra per selezionare la Frequenza fotogrammi (fps) desiderata).

Solo in
modalita video
Replay

Qualita
(Risoluzione
¢ FPS

640x480 pixel per fotogramma (risoluzione)> a 30 o 15 fotogrammi al secondo (Frequenza
fotogrammi) 320x240 pixel per fotogramma >a 30 o 15 forogrammi al secondo
Loop (ciclo) di 8, 15, 30 0 60 secondi a seconda della risoluzione/fps.
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Sistema menu Principale (segue)

Gruppo Voce Impostazioni || Descrizione
Data Setup, Permette di impostare la data e I'ora esatta in base al proprio fuso orario. Se selezionate “On”,
On / Off la data viene visualizzata sul display e viene stampata su ogni foto.
Storage Auto I file vengono memorizzati sulla scheda SD, se inserita, altrimenti sulla RAM interna.
(Memorizza-
zione)
SD I file vengono memorizzati solo sulla scheda SD (deve essere inserita).
Internal (Mem. I file vengono conservati nella memoria interna, mai sulla scheda.
interna)
Language 7 disponibili Questa voce permette di selezionare la lingua in cui si desidera visualizzare le schermate dei
(Lingua) menu sul display.
Rec View (Reg | Off/1-3 sec Permette di selezionare il limite di tempo desiderato per la visualizzazione automatica della foto
vista) sullo schermo dopo lo scatto.
File Name Reset/Series Imposta il sistema di numerazione dei file. Se si seleziona Reset (Azzera), dopo la cancellazione
(Nome file) (Azzera / serie) di tutti i file dalla memoria interna o dalla scheda, i numeri dei file delle foto nuove ricomincia-
no da “000”. Se selezionate Series (serie), la numerazione dei file delle foto nuove riprende dal
numero successivo all’ultimo utilizzato.
Beep (bip) On/ Off Attiva o disattiva 'avvisatore acustico.
All Reset (Re- Si/ No Se selezionate “Yes” (Si), il sistema ripristina tutti i valori originali di default (visualizzati in
setta tutto) grassetto)
FORMAT Format (For- Si/ No Formatta le schede per i file compatti dell'Instant Replay. Cancella tutto il contenuto
(formattazione) | matta)
EXIT (ESCI) Permette di uscire dal sistema dei menu e di tornare a visualizzare le immagini dal vivo.
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Le icone del display

# | Icona

Data della foto o del file video (la funzionalita della data deve essere impostata ¢ attivata)

Ubicazione dellattuale file di revisione (memoria interna o scheda SD)

Risoluzione dell’actuale file di revisione

Qualita (livello di compressione) dell'attuale file di revisione.

[N IS RSTH I SY

Numero attuale del file (numero sulla sinistra): Numero totale di file in memoria
(numero sulla destra)

6 | Indica la tipologia del file (foto, video normale, video replay)

7 | Indicatore della carica delle pile

Menuv di revisione

Visione e ¢ancellazione delle foto e dei video

Premete “LCD/Mode” (LCD, modalita) quando desiderate accedere alla modalita Review (Revisione). Per scorrere
le foto e i video memorizzati, premete le frecce sinistra/destra. Quando vi trovate in modalita di revisione, premete
il pulsante OK/Menu per accedere ai vari menu. Questi menu funzionano nel modo illustrato nelle istruzioni per
il sistema del menu Principale (usate le frecce del tastierino per navigare fino al gruppo dei menu desiderato, e poi
confermate ciascuna impostazione premendo OK). Unica differenza sono le voci seguenti:

Gruppo Voce Impostazioni | Descrizione
SLIDE Si/ No Se selezionate “Yes” (S), il sistema visualizza, a distanza di qualche
SHOW secondo I'una dall’altra, tutte le immagini presenti nella memoria

interna o sulla scheda.
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| menu di revisione - segve

Gruppo Voce Impostazioni || Descrizione

DELETE Delete Si/No Cancella dalla memoria la foto o il video visualizzato sul display.

(ELIMINA) | One Per trovare il file da cancellare, usate le frecce su/giti. Per cancellare,
(Cancella evidenziate I'icona “Cancella uno” e premete “OK”. Quindi, eviden-
uno) ziate “Yes” (S1) e premete “OK” per eliminare il file.

Delete Si/ No Cancella tutti i file memorizzati. Per eliminare tutti i file, (ad eccezi-
All one di quelli bloccati - come illustrato in seguito) evidenziate I'icona
(Cancella “Cancella tutti” e premete “OK”. Quindi, evidenziate “Yes” (Si) e
tutti) premete “OK” per eliminare tutti i file in memoria.

EDITOR Protect Lock / Unlock | Per evitare di eliminare per errore i file (di foto o video) potete bloc-
(Pro- (Blocca/ carli. Questa funzione pud essere usata insieme a “Cancella tutti”
teggi) Sblocca) quando si desidera eliminare tutte le foto, tranne una o due. Per

bloccare la foto o il video visualizzati sul display, evidenziate I'icona
“Lock” (Blocca) e premete “OK”. Se desiderate sbloccare un file
precedentemente bloccato, selezionatelo con le frecce su/gili, eviden-
ziate di nuovo I'icona “Lock” (Blocca) e premete “OK”.
Rotate -90 gradi o Ruota la visualizzazione dell'immagine a schermo di 90 gradi in
(Gira) +90 Degree ciascun senso.
EXIT Exit 1 sistema chiude il menu di revisione e visualizza I'ultima immagine
(ESCI) (Esci) selezionata per la revisione.
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Requisiti del sistema (Minimo)

Sistema operativo: Windows® 98/98SE/2000/ME/XP

CPU: MMX Pentium® 200MHZ, equivalente o pil veloce, (Pentium® IIT 500 MHz per PhotoSuite5™)
Memoria: almeno 32MB (si raccomandano 64MB per PhotoSuite)

scheda video SVGA con 2MB di VRAM, display schermo da 800x600, colori 16 bit

200 MB di memoria libera sul disco fisso (se si installa PhotoSuite)

Porta interna USB

Internal USB Port

Installazione del software

Se avete Windows 98 dovete installare gli appositi driver prima di collegare la macchina fotografica al PC. Inserite il
CD-ROM nell'unita CD del computer. Il CD viene letto automaticamente dal sistema che visualizza la schermata
con le istruzioni per l'installazione. Selezionate “Install Driver” (Installa i driver). Quindi, seguite le istruzioni

sullo schermo. Dopo I'installazione occorre riavviare il computer. Se avete Windows 2000, ME od XP non avete
bisogno di installare i driver in quanto la macchina fotografica utilizza lo standard USB di archiviazione di massa e,
di conseguenza, i file delle foto vengono letti come se fossero archiviati su un disco fisso esterno. Per tutti i sistemi
operativi Windows, se non disponete gia di un software per photo editing, potete installare Roxio PhotoSuite® dal
CD-ROM. Non dimenticate di leggere attentamente le “Informazioni sulle release” prendendo nota di eventuali
consigli o potenziali problemi riguardanti la configurazione del PC e il vostro sistema operativo in uso.

Istruzioni dettagliate per il trasferimento di foto e video sul PC

1. Gli utenti Windows 98/98SE devono, per prima cosa, assicurarsi che il driver sia installato.

2. Verificate che Instant Replay sia acceso, quindi collegate il cavo in dotazione alla porta USB della fotocamera
(aprite la copertura del connettore sul lato sinistro di Replay) e poi direttamente ad una porta USB principale del
computer. Non usate porte USB sul pannello frontale o sulla tastiera né gli “hub” non alimentati.

3. Il display LCD si spegne per risparmiare le pile, ed Instant Replay viene riconosciuto come dispositivo standard

di “memoria di massa USB”. Questo significa che i file della fotocamera possono essere facilmente visionati, modi-
ficati o copiati sul vostro disco fisso, come se fossero memorizzati su un disco fisso esterno o su un CD-ROM. 15
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Istruzioni dettagliate per il trasferimento di foto e video sul PC = segue

4. (Questa operazione non ¢ necessaria se avete Windows XP. In tal caso basta, infatti, usare le opzioni visualizzate
sullo schermo per vedere, copiare o modificare le foto). Aprite Risorse del computer o Windows Explorer. Il
sistema gestisce la macchina fotografica come se fosse un “Disco rimovibile” a cui & stata assegnata una lettera di
identificazione univoca, non assegnata ad altre unita. Fate doppio clic sull'icona di questo nuovo “Disco”, aprite la
cartella “DCIM”, quindi le cartelle al suo interno (“100BNxxx” ,ecc.). Le vostre foto e/o video sono i file conservati
all'interno delle cartelle: hanno il prefisso “PICT__” seguito da un numero, lo stesso numero visualizzato sul display
della fotocamera durante la visione delle foto. Se cliccate una volta su un qualsiasi file, il sistema ne visualizza una
piccola anteprima.

5. Cliccate su “Edit>Select All” (Modifica> Seleziona tutto) (oppure su una foto o usate la combinazione control+clic
se desiderate selezionarne diverse). Quindi, cliccate su “Edit>Copy to Folder” (Modifica>Copia nella cartella) (nei
menu di Windows). Selezionate una delle cartelle sul vostro disco fisso, ad esempio “Mie foto”, oppure create una
nuova cartella (ad es. “Vacanze alle Hawaii”, ecc.), e poi fate clic su “OK” per trasferire le copie dei file delle foto
desiderate.

6. Dopo il trasferimento delle foto sul disco fisso potete scollegare la fotocamera. Windows 2000 potrebbe visualizzare
un messaggio per avvertirvi che un dispositivo USB ¢ stato scollegato prima di fermare o espellere il “disco” (i file
delle foto non subiranno alcun danno). Nel caso, spuntate la casella che permette di aggiungere le icone sulla barra
delle applicazioni o delle attivita. La prossima volta che trasferite delle foto sul disco fisso, dopo il trasferimento
ricordatevi di cliccate sull’icona e di selezionate “Stop the USB Mass Storage Device” (Ferma il dispositivo USB di
archiviazione di massa) prima di scollegare la fotocamera.

Nota: se il PC non riproduce i file .avi dei video in Windows Media Player, puo darsi che dobbiate

scaricare una versione pii recente di Media Player o Direct X da Microsoft.com. I file dei film possono

essere riprodotti anche con QuickTime Player, che ¢ precaricato su una buona parte dei computer at-
116 tuali o puo essere scaricato gratuitamente da Apple.com.

Istruzioni dettagliate per il trasferimento di foto e video sul PC = segue

7. A questo punto potete aprire i file delle foto con un qualsiasi software di elaborazione delle immagini
fotografiche. Allo scopo basta selezionare File>Open (File>Apri) e quindi accedere alla cartella in cui avete
archiviato le foto. Se utilizzate PhotoSuite, selezionate File>Open Photo (File>Apri foto), e poi usate il menu a
tendina “Look in” (Guarda dentro), situato nella parte superiore della finestra intitolata Open (Apri), selezionate
“Risorse del computer”, selezionate il vostro disco fisso e poi cliccate due volte sulla foto desiderata nella cartella
in cui avete copiato i file dalla fotocamera. Potete anche aprire e lavorare direttamente sulle foto da Instant Replay
mentre ¢ ancora collegato. Se usate PhotoSuite, seguite innanzitutto i passi da 1 a 3, quindi aprite PhotoSuite,
selezionate File>Open Photo (File>Apri Foto) e usate il menu “Look in” (Cerca) per selezionare Risorse del
computer. Quindi, selezionate “Disco rimovibile” e aprite le cartelle fino a quando trovate i file JPEG delle foto.
Se scegliete di lavorare in questo modo, ciot con la fotocamera collegata, ricordatevi di salvare la foto (dopo aver
fatto le modifiche desiderate) sul vostro disco fisso e non nella memoria o sulla scheda della fotocamera. Per
effettuare questa operazione in PhotoSuite occorre, dopo aver cliccato su “Done” (Finito), rispondere “Yes” (S1)
alla domanda “Save Changes?” (Salva i cambiamenti?), e poi rispondere “No” alla domanda “Replace Existing
File”? (Sostituire il file esistente?). Usate la casella di dialogo “Save As” (Salva con nome) per salvare la foto
modificata in una cartella sul disco fisso (“Save In>Local Disk” (Salva su>Disco locale) , e non sul “Removable
Disk” (Disco rimovibile) (cioe la fotocamera).

8. Se non avete molta dimestichezza con le tecniche di ritocco delle foto su computer, consultate la Guida del
software (PhotoSuite dispone di una Guida molto approfondita) per consigli sull’applicazione delle sue funzioni.
Oltre a regolare la luminosit, il contrasto, la nitidezza e il colore delle foto, potete ridimensionare la foto in base
alla carta sulla quale la stamperete, oppure potete salvarne una versione a risoluzione minima, bassa, o media
quando desiderate allegare la foto ad un’e-mail o inserirla in un documento. Quando siete pronti a salvare il file
modificato, potete selezionare la voce “Salva con nome” e scegliere un nome pitt descrittivo di “I00BN___".
Un tale accorgimento consente, tra I'altro, di conservare il file originale come backup per eventuali modifiche
successive. Accertatevi di aver trasferito tutte le foto che desiderate salvare prima di selezionare, sulla fotocamera,
“Delete All” (Cancella tutto) per liberare dello spazio per le immagini nuove.
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Riferimenti capacit%l e memoria (capacita max +/- 2 foto)

Campo
(Dimensioni
dell'immagine)

Megapixel
(appross.)

Qualita *

Memoria
interna**

Scheda SD
da 64 MB

L 2048x1536

3.1

FQ

15 foto

60 foto

NQ

31

124

EQ

62

248

M 1600x1200

2.1

FQ

25

100

NQ

51

204

EQ

102

408

S 640x480

0.35

Q

160

640

NQ

321

1284

EQ

642

2568
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* Seleziona il grado di compres-
sione dei file (rapporto jpg)
(FQ=bassa/EQ=alta)

FQ: Qualita migliore (1:4)
NQ: Qualita normale (1:8)
EQ: Qualita economica (1:16)

**RAM interna disponibile per i
file delle foto: 16 MB

Per dimensioni dell’i immagine
si intendono le dimensioni in

ixel, ovvero la risoluzione, dei
gle digitali.

La capacita reale di archiviazione
varia in relazione al contenuto del
file di ciascuna foto. E possibile
che riusciate a scattare qualche
foto in pill, 0 in meno, rispetto
alla capacita media specificata.

Scegliete le impostazioni per
grandi dimensioni e alta qualita
quando prevedete di fare ingran-
dimenti o ritagli. All'occorrenza &

ossibile ridurre le dimensioni dei

le usando i software di gestione
delle foto. Scegliete le impostazi-
oni per piccole dimensioni e/o
bassa qualita quando prevedete
di inviare le foto per e-mail, o di
inserirle in documenti, stamparle
in formato piccolo e non volete
cambiare le dimensioni del file in
un secondo tempo.

GARANZIA LIMITATA PER DUE ANNI

Si garantisce che questo prodotto Bushnell® sara esente da difetti di materiale e
fabbricazione per due anni a decorrere dalla data di acquisto. In caso di difetto durante
il periodo di garanzia, a nostra discrezione ripareremo o sostituiremo il prodotto purché
sia restituito franco destinatario. Sono esclusi dalla garanzia eventuali danni causati da
abuso, maneggiamento improprio, installazione o manutenzione eseguiti da persone
non autorizzate dal servizio di assistenza Bushnell.

A un prodotto restituito e coperto da questa garanzia occorre allegare quanto segue.

1) Assegno/ordine di pagamento per I'importo di 10 $US per coprire i costi di
spedizione.

2) Nome e indirizzo da utilizzare per la restituzione del prodotto.

3)  Una spiegazione del difetto.

4)  Scontrino riportante la data di acquisto.

5) 1l prodotto deve essere imballato in una scatola robusta, per prevenire danni
durante il trasporto, e va spedito franco destinatario a uno dei seguenti
indirizzi.

Recapito negli Stati Uniti: Recapito in Canada:
Bushnell Performance Optics Bushnell Performance Optics

Attn.: Repairs Attn.: Repairs
8500 Marshall Drive 25A East Pearce Street, Unit 1
Lenexa, Kansas 66214 Richmond Hill, Ontario L4B 2M9

Per prodotti acquistati fuori degli Stati Uniti o del Canada, rivolgersi al rivenditore per le
clausole pertinenti della garanzia. In Europa si pud anche contartare la Bushnell a questo
numero: BUSHNELL Performance Optics Gmbh

European Service Centre

MORSESTRASSE 4
D- 50769 - Cologne
Germania

Tél: +49 (0) 221 709 939 3
Fax: +49 (0) 221 709 939 8

Questa garanzia da specifici diritti legali.
Eventuali altri diritti variano da una nazione all’altra.
©2005 Bushnell Performance Optics

Alfvtanuats-SearcAnd-Downtoad:

Dichiarazione relativa alla normativa FCC (Federal
C ications C ission)

In base alle prove eseguite su questo apparecchio, se
ne ¢ determinata la conformitd ai limiti relativi ai
dispositivi digitali di Classe B, secondo la Parte 15 delle
norme FCC. Tali limiti sono stati concepiti per fornire
una protezione adeguata da interferenze pericolose
in ambiente domestico. Questo apparecchio genera,
utilizza e pud irradiare energia a radiofrequenza e, se
non installato e utilizzato secondo le istruzioni, pud
causare interferenze dannose per le comunicazioni radio.
Tuttavia, non esiste alcuna garanzia che, in uno specifico
impianto, non si verificheranno interferenze. Se questo
apparecchio causasse interferenze dannose per la ricezione
dei segnali radio o televisivi, determinabili spegnendolo
e riaccendendolo, si consiglia di tentare di rimediare
all’interferenza con uno o pilt dei seguenti metodi.

- Cambiare [lorientamento dell’antenna ricevente o
spostarla.

- Aumentare la distanza tra 'apparecchio e il ricevitore.

- Collegare I'apparecchio a una presa inserita in un
circuito diverso da quello a cui ¢ collegaro il ricevitore.

- Rivolgersi al rivenditore o a un tecnico radio/TV
qualificato.

Per soddisfare la conformita di questo apparecchio ai
limiti relativi ai dispositivi digitali di Classe B, secondo la
Parte 15 delle norme FCC occorre adoperare con esso un
cavo di interfaccia schermato.

I dati tecnici e progettuali sono soggetti a modifiche senza

preavviso o obbligo da parte del produttore.
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Parabéns pela aquisicao de seu Bushnell® Compact Instant Replay™! O Compact Instant
Replay ¢ ideal para observagio de eventos esportivos e da natureza, pois combina um bindculo
compacto de alta qualidade e poténcia (8x) com uma cimara digital de 3.2 megapixels
apresentando excelente capacidade de video. Ele possui “funcao dupla’ ¢ capaz de tirar
fotografias still digitais de alta resolu¢do e filmar clipes de video que automaticamente iniciam
um novo “loop”, ou se renovam, a cada 8 a 60 segundos (dependendo das configuracoes de
qualidade). Isso garante que vocé sempre poderd captar o melhor da agdo! As fotografias e
videos sio automaticamente armazenados na memdria interna ou em um cartao SD (Secure
Digital) opcional e podem ser examinados instantaneamente no LCD giratério (flip-up),
reproduzidos no televisor, ou baixados para o computador sem necessidade de instalar
nenhum software especial (com os sistemas operacionais Windows 2000, XP ou Mac. E
fornecido o software para o Windows 98/98SE).

Antes de usar o Compact Instant Replay, leia as instrucoes contidas neste manual e dedique

algum tempo para familiarizar-se com a operagio da cAmara e seus muitos, excelentes
recursos.
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BUSHNELL COMPACT INSTANT REPLAY 11-8323

1

Instale as pilhas
e o cartio SD
(opcional)

Insira 2 pilhas de tamanho AAA (consulte as “Especificagdes”) no compartimento de pilhas, encontra-
do na parte inferior da drea da cAmara (observe a indicagao de polaridade no interior). Um cartao de
meméria SD (opcional) também pode ser instalado para aumentar a capacidade de armazenamento
de fotografias. O slot do cartdo fica localizado na parte posterior da drea da cAmara. (Puxe sua tampa
tampa de borracha para baixo.) Insira o cartdo com a etiqueta voltada para baixo até que clique e
recoloque a tampa de borracha).

Ligue a cAmara

Levante o display LCD usando a saliéncia na parte posterior. Aperte e solte o botio POWER (FORCA).
A tela inicial comecard a piscar, em seguida apagard, ¢ o LED de forca vermelho permanece aceso. Pres-
sione “LCD/Mode” (LCD/Modo) para religar o display — vocé verd uma imagem ao vivo da lente da
cAmara, localizada entre as lentes objetivas do binéculo. O display desligard automaticamente apés 2
minutos, para conservar a carga das pilhas quando a cimara estiver inativa. Pode-se desligar o display
manualmente pressionando o botao LCD/Mode — ele nao precisa estar ligado para tirar f%tograﬁas. A
cimara toda desligard automaticamente apds 5 minutos de inatividade (quando nenhum boto tiver
sido pressionado). Para desligd-la manualmente, pressione e solte 0 botaio POWER. Os ajustes padrio da
cédmara oferecerdo uma qualidade étima na maior parte das situagoes. Entretanto, recomendamos ler todo o
manual para tirar proveito das muitas op¢oes dispontveis nos diversos menus, para as diferentes condigoes ao
tirar as fotografias e suas preferéncias pessoais.

Formate o
cartao SD
(opcional)

Caso tenha previamente inserido um cartao SD, formate ele antes de usar a cAmara. Pressione o botao
Menu/OK no centro do teclado prata. Pressione a seta Para baixo 4 vezes para selecionar “Format”
(Formatar). Pressione a seta Para a direita e depois a seta Para a esquerda para selecionar “Yes”(Sim).
Pressione Menu/OK. Aparecerd uma adverténcia que todas as imagens serdo removidas. Selecione “Yes”
(Sim) e pressione OK novamente. Use a seta Para baixo para selecionar “Exit” (Sair) e pressione OK.

Configure a
éptica do bing-
culo para os seus
olhos

Se estiver usando 6culos, abaixe as viseiras de borracha. Ajsute o espagamento entre os tubos (esquerdo
e direito) do binéculo enquanto vocé observa por ele até enxergar uma tdnica imagem circular. Em
seguida, encontre um objeto com detalhes a distincia e ajuste o botao de foco central até que ele apareca
nitidamente pela ocular esquerda. Agora, olhe somente pela ocular direita. Se o objeto ndo estiver tao
nitido, gire a ocular direita (ajuste de dioptria) até que fique. Apés ajustado, nao serd mais necessdrio
mudar o ajuste de dioptria e o foco pode ser obtido usando apenas o botao de foco central.

;O
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GUIA DE CONSULTA RAPIDA: BUSHNELL COMPACT INSTANT REPLAY 11-8323

5

Tire uma
fotografia ou
filme um clipe
de video

Segure a cdmara firmemente com ambas as mios e pressione o botio SNAP para tirar uma fotografia
still. Vocé ouvird um “bipe” (que pode ser desligado), seguido de uma breve pausa (¢ exibido o icone
de arquivo) enquanto a cAmara armazena a fotografia na memdria. Para filmar um video, pressione
Menu/Ok uma vez e depois a seta Para a direita para ver o menu das opgoes de video da cAmara. Use
as setas Para cima e Para baixo para selecionar video Normal (continuo) ou Replay (loop) e pressione
Menu/OK. A cimara voltard ao display de visualizagao ao vivo e vocé pode comegar a filmar o video a
qualquer momento pressionando SNAP. Pressione SNAP novamente para interromper a gravagio. Leia
a se¢do “Modos de video” para obter uma explicacio mais detalbada das diferencas entre os modos Replay e
Normal, incluindo como é determinado o tempo de gravagio do video.

Visualize e
remova foto-
grafias/videos

Para visualizar ou reproduzir uma fotografia still ou video, pressione o botio LCD/Mode (pressione
duas vezes caso o display ainda ndo estiver ativado). Vocé verd a mais recente fotografia still ou video
(primeiro quadro). Para visualizar as fotografias ou videos anteriores, um(a) de cada vez, pressione a seta
Para a esquerda. O icone no canto inferior direito do display indicard se o arquivo visualizado ¢ uma
fotografia still, video normal ou “instant replay”. Os nimeros acima desse icone indicam o nidmero de
arquivos/total de arquivos atuais (2 de 3, etc.). Para reproduzir um video armazenado, pressione a Seta
para baixo (pressione novamente para interromper a reprodugio). Para ver imagens “reduzidas” de diver-
sas fotografias/videos armazenados de uma tnica vez, pressione a seta Para cima apés entrar no modo de
visualizagdo. Use as setas para selecionar um arquivo individual e pressione a seta para cima para vé-lo
na tela inteira. Para remover fotografias/videos, pressione Menu/OK e depois a seta Para baixo uma vez
(icone da lixeira). Presssione a seta Para a direita, selecione Remover um(a) ou Remover todos(as), pres-
sione a seta para a direita outra vez e selecione Yes (Sim). Retorne a coluna Menu, selecione Exit (Sair) e
pressione Menu/OK para voltar ao display de visualizagao.

Conecte a um
computador
e transfira as
fotografias

Se vocé usa o sistema operacional Windows 98/98SE, instale o driver do CD-ROM antes de conectar a
cimara. Instale também o PhotoSuite caso ndo possua um software de edigao de fotografias. Conecte o
cabo USB fornecido do soquete USB da cimara (na parte posterior da drea da cAmara) a porta USB no
PC. Se voct estiver rodando Windows XP, basta seguir as orientagoes/opgdes que aparecem automatica-
mente na tela. Se estiver rodando Windows 98 ou 2000, abra “Meu Computador” no PC. A cimara ¢
identificada como um “Removable Disk” (Disco removivel) — as fotografias se encontram nas pastas em
seu interior, basta arrastd-las ou copiar/colar em qualquer pasta no disco rigido. Consulte a segao “Como
transferir as fotografias” neste manual.
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Especificagoes técnicas

Ampliagio 8x Tamanho do arquivo da fotogra- 2048x1536, 1600x1200, 640x480
fia still (Resolugdo)

Diametro da lente 30 mm Taxa de compressio do arquivo 1:4 (FQ), 1:8 (NQ), 1:16 (EQ)

objetiva (qualidade)

Saida pupilar 3.75 Meméria interna Meméria Flash de 16MB

Campo de visio

320 pés a 1000 jardas
(9600 cm a 910 m)

Expansao da meméria

Cartio Secure Digital, capacidade de até 1 GB

Distancia olho-ocular

13mm

Formato do arquivo (still/video)

JPEG /MJPEG (.AVI)

Revestimento para
lentes

Totalmente revestido

Gerenciamento de arquivos

Formato FAT 16, DCF (versio 1.0)

Tipo de prisma

Roof, BaK-7

LCD

1.5” TFT, 120,480 pixels

Alcance de foco

18’(5,4 m) ~ infinito

Resolugao de video/Taxa de

620x480 ou 320x240 pixels por quadro / 30 ou 15 fps (pés por

(binéculo) quadro segundo). Duragio do loop do modo de Replay: 8/15/30/60
segundos (de acordo com a resolugao/fps selecionado)
Peso 14,3 ongas / 406,5 g Saida de video NTSC/PAL, através de porta USB de 8 pinos com cabo especial

(incluido)

Tipo de sensor

CMOS

Faixa de valor da exposicao

+/-2 EV em 0.5 etapas de EV/

Pixels efetivos

3,2 Megapixels

Opgaes de equilibrio de branco

Auto (Automético), Daylight (Luz do dia), Cloudy (Nublado),
Fluorescent (Fluorescente), Incandescent (Incandescente)

Cor

cor de 24 bits

Cenas pré-configuradas

Program (Programa), Sports (Esportes), Landscape (Paisagismo),
Portrait (Retrato), Night (Noite)

Shutter (obtu-
rador)

Eletronico, 1/16 a
1/1000 segundos

Idiomas do menu

inglés, espanhol, francés, alemao, italiano, portugués, japonés

Alcance de foco
(cAmara)

Fixo, aprox. 60°(18 m)

~ infinito

Desligamento automdtico da
forca (apés inatividade)

Display LCD: 2 Min. / Desligamento de toda forca: 5 Min.

Abertura da lente

/5.6

Alimentagio de forca

2 pilhas tamanho AAA — tipo alcalinas/litio/NiMh




Identificaciio das pecas
v v

Display LCD

Botao LCD/Mode

Teclado de 5
posicoes ¢/ botao

Menu/OK

Botao
Power

(forga)

dioptria

icones de display de visualizacio do LCD
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Display de visualizacao de fotografia still

Video normal
Display de filme (video)

. 7\’1’deo/replay

# | Icone # | Icone
1 | Indicador de carga das pilhas (mostrando 2/3 de carga) 1 | Indicador de carga das pilhas
— (completa)
2 | No. de fotografias restantes (baseando-se na memdria disponivel)
- 2 | Tempo total (em segundos)
3 [ Modo de forografia still de video disponivel (baseado
4 Qualidade (Compressio do arquivo) Fine/Normal/Economy (Superior/ na memdria dlSP onivel
NormallEconémica) 3 Modo de filme
Resolugio (Tamanh i Medi Il Médiol Pequeno,
5 esolugo (Tamanho do arquivo) La Simall (G quueno) 4 Resolucio (FQ=640x480/
6 Equih’biro de branco Nio ¢ exibido, exceto quando mudado do padrio NQ=320x2 40)
“Auto”(Automdtico)na Exposicio
S | Taxa de quadros (30 ou 15
7 Cena Nio é exibida, exceto quando mudado do padrio “Program’(Program) no Menu de Modo f;b s)
8 | Modo de disparo em seqiiéncia Nao ¢ exibido, exceto quand selecionado no 127
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Como carregar as pilhas

Vire o Compact Instant Replay e abra a tampa do compartimento de pilhas no
sentido indicado 4 direita. Insira 2 pilhas de litio ou alcalinas de tamanho AAA no
compartimento, no sentido indicado pelos diagramas internos. Depois, recoloque
a tampa de volta no lugar até ela clicar. Noza: As pilbas de NiMb tipo recarregdveis
também podem ser usadas, mas alguns modelos talvez nio fornecam a corrente
apropriada para abastecer o Instant Replay. Recomendam-se as pilhas de NimH
com classtficagio de corrente 2300 mAh ou superior.

Como inserir o cartio SD

A cAmara poderd armazenar de 15 a 642 fotografias na memdria interna de 16 MB,
dependendo das configuragdes de resolugio e qualidade (consulte o quadro no verso
deste manual). Para ampliar a quantidade de armazenamento disponivel, pode-se
adicionar um cartio de memdria Secure Digital (SD) opcional, com capacidade
de até 1 GB. O cartdo ¢ inserido no slot, na parte posterior da drea de cAmara,
como indicado no tltimo diagrama. Insira o cartio SD com a etiqueta voltada para
cima. Nota: néo esquega de verificar se a forga estd desligada antes de inserir
ou remover os cartoes a fim de evitar a possivel perda de arquivos ou danos no
cartio. Cartdes novos nio requerem formatagdo, mas um cartao previamente usado
em outros dispositivos deverd ser formatado pelo Compact Instant Replay antes
de armazenar as fotografias (Consulte 0 Menu de configuragio na préxima segdo).
Observe que isso apagard todos arquivos previamente armazenados no cartdo, entao
ndo esqueca de fazer o download ou cépia dos arquivos que vocé deseja manter.
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Tampa do compartimento

de pilhas

o=

Slot do cartio (levante
a tampa)

Configuraciio basica do hinoculo e ciimara

Antes de tirar fotografias ou filmar videos, dedique alguns momentos para configurar o Compact Instant Replay de acordo com sua
visdo e preferéncias individuais. Deixe as viseiras de borracha “para cima” se vocé nao estiver usando éculos, ou abaixe-as caso contrdrio.
Prenda os dois lados do binéculo e afaste ou aproxime-os enquanto vocé observa pelo binéculo, para ajustar o espagamento entre as
oculares até enxergar uma dnica imagem circular. Encontre um objeto distante com vdrios detalhes (como uma 4rvore, sinal, parede de
tijolos, etc.) e ajuste o botao de foco central até que o objeto pareca nitido ao ser observado apenas pela ocular esquerda do binéculo.
Em seguida, olhando o mesmo objeto apenas com o lado direito do binéculo, simplesmente gire a ocular direita até que a imagem fique
igualmente nitida para seu olho direito. Isso ¢ chamado de ajuste de dioptria e compensa por qualquer diferenca que possa haver na
visdo entre seus olhos esquerdo e direito. Apds a configuragao seguindo este procedimento inicial, ndo serd preciso mais se preocupar
com o ajuste de dioptria e pode-se apenas o botao do foco central para focalizar objetos a qualquer distincia pelo binéculo (a distincia
de foco minima ¢ aproximadamente 4,8 m).

Os videos e fotografias digitais no sdo afetados pelo botao de foco central, pois a lente da cAmara localizada entre as lentes objetivas
do bindculo nio requer focalizagao. Ela ¢ pré-configurada de forma que objetos de 18 m ao infinito estardo em foco. Observe que o
bindculo é capaz de focar objetos a menores distncias do que a cimara. Verifique a imagem ao vivo no display LCD para ter certeza de
que vocé estd suficientemente afastado para garantir fotografias nitidas. A lente da cAmara oferece uma ampliagdo de 8x, igual a éptica
do binéculo, e seu alinhamento € tal que um objeto centrado na imagem do binéculo estard também centrado nas fotografias ou videos.
Sendo assim, ndo ¢ necessério ligar ou mesmo levantar o LCD ao tirar fotografias ou filmar videos. Reduzir o uso do LCD aumentard
de maneira significante a vida ttil das pilhas.

Vocé talvez queira entrar no menu da cAmara e configurar a data correta antes de usd-la pela primeira vez. Levante o display LCD e
pressione o botdo Power . Apés acender a luz vermelha, pressione LCD/Mode para ligar o display. Pressione o botao Menu/OK no
centro do teclado e pressione a seta Para baixo 3 vezes para acessar o menu de “Setup” (Configuragao). Pressione a seta Para a direita
uma vez e depois a seta Para baixo para chegar 2 “Date” (Data). Em seguida, pressione a seta Para a direita duas vezes para entrar na
configuragdo da data. Use as sctas para a esquerda/direita para selecionar a parte da data a ser alterada e apés a seta Para cima ou Para
baixo para mudar. Para mudar o formato de data, de maneira que o més, dia e ano fiquem na ordem desejada, movimente o fcone “setas”
na parte superior esquerda do display da data e pressione as setas Para cima/para baixo. Ajuste a hora (no formato de 24 horas) com os
4 nimeros na parte inferior do display da data, de maneira que ela mudard automaticamente apés a meia-noite do local onde vocé se
encontra. Apés ajustar a data e hora, pressione o botio Menu/OK uma vez, e novamente para salvar a conﬁguragio e sair. Em seguida,
pode-se pressionar a seta Para baixo para que data aparega ou nao no display e nas fotografias (“Show Date On/Off” — Ligar/Desligar
indicacio da data). Mantenha a seta para a esquerda pressionada até retornar a “Setup” (Configuragao), v4 para baixo até “Exit” (Sair)
e pressione Menu/OK.
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Como tirar fotografias still

Apbs seguir a conﬁguragio inicial descrita nas pdginas anteriores, vocé jd estard pronto para tirar uma fotograﬁa:

1) Levante o LCD e pressione rapidamente o botao Power (o LED vermelho acende). Pressione o botao LCD/Mode para ligar o display
LCD caso deseje visualizar uma imagem ou verificar as configura¢ées do menu, condicdo das pilhas. etc.

2) O Compact Instant Replay apresentard as configuragées padrao de qualidade e alta resolugdo, assim como “tudo no automdtico”
quando ligado pela primeira vez, permitindo tirar fotografias excelentes imediatamente. Caso prefira configuragoes diferentes, consulte
a segao “Como usar o Menu Principal” a fim de obter orienta¢des de como encontrar e mudar as configuragoes, como resolugio e
exposi¢do, uso de pré-configuragdes de cenas para motivos comuns e outras opgoes.

3) Vocé pode tirar fotografias olhando apenas pelo bindculo (ndo hd necessidade do LCD estar ligado). Entretanto, para um enquadra-
mento mais preciso, recomenda-se verificar a imagem no LCD.

4) Nao esquega que vocé deve estar afastado no minimo 18 metros do objeto a ser fotografado. A éptica do bindculo poderd focar a
distancias menores, mas o foco da cimara estd pré-configurado para obter melhores resultado com objetos  distancia (a cAmara nao
necessita focalizar). O LCD pode ser usado para verificar se o objeto nao estd demasiadamente préximo para obter resultados nitidos.
5) Prenda a cimara com as duas maos para que fique o mais estdvel possivel e aperte lentamente o botio SNAP. O display ficard escuro
por alguns segundos enquanto o arquivo ¢ armazenado (o {cone da pasta ¢ exibido). Em seguida, vocé poderd tirar outra fotografia. O
contador no canto inferior direito mudard para exibir a capacidade de fotografias restantes, que depende da quantidade disponivel de
meméria interna ou no cartdo, assim como das configuragdes de qualidade e resolugdo (é possivel mudar para configuragdes inferiores
a qualquer momento, a fim de aumentar o nimero de fotografias que “cabem” na meméria restante). Nota: nem sempre o contador
abaixard apenas um niimero apds a fotografia ser tirada. Isso dependerd das configuracaes e do conteiido efetivo do arquivo por fotografia.
Quanto o contador atingir “000”, a cdmara estd sem memdria (espago para armazenamento) e vocé deve fazer o download das fotografias que
de_veja manter para que possam ser removidas, ou retirar e instalar um outro cartido SD.

6) Zoom digital de até 6x se encontra disponivel. Pressione a seta para a direita para “zoom in” (o resultado pode ser observado no
LCD). Pressione a seta para a esquerda para voltar a afastar (“zoom out”).

7) Pressione o botao LCD/Mode para examinar a fotografia apés tird-la e apds pressione ele novamente para retornar a visualizagao
ao vivo. Consulte a se¢do “Menu de visualizagao” para obter maiores informagdes sobre como visualizar e remover fotografias tiradas
anteriormente.
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Como filmar videos normais ou “Instant Replay”

1) Siga as etapas 1-4 na segao “Como tirar fotografias still”, na pdgina anterior

2) Pressione o botio Menu/OK para sair de fotografia still e passar para um dos modos de video. O primeiro grupo de menu ¢ “Ca-
mara’- pressione a seta Para a direita, apds use as setas Para cima ou Para baixo para selecionar o modo de video Normal ou Replay (a
cAmara retornarnd ao display de visualizagao ao vivo apés a sele¢io do modo de video, entdo estard pronta para filmar imediatamente).
Em qualquer um dos modos, pressione SNAP para iniciar a gravagio de um novo clipe de video. Para interrompé-la e armazenar o
video na meméria, pressione SNAP novamente. Eis as diferencas entre os dois modos de video:

O modo de video Normal filmard apenas um clipe de video continuo, comegando quando o botao Snap ¢ pressionado e terminando
ao pressiond-lo novamente. O tempo de gravagao fica limitado somente pela quantidade disponivel de meméria interna ou no cartao.
Pode-se gravar um tnico video de longa duragao até esgotar a meméria ou videos multiplos de pequena duragao, parando e comegando
a gravagio a qualquer momento pressionando-se o botdo Snap. Ao parar, o contador indica o tempo aproximado de gravagdo restante
disponivel (em segundos) e continua fazendo a contagem regressiva de tempo quando reinicia a gravagao de video Normal.

O modo de video Replay opera de uma forma distinta — ao final de um limite de tempo predeterminado (determinado pela configura-
¢a0 da taxa de quadros e resolugio de video no menu de configuragao), o clipe de video comega a realizar um “loop”, ou seja, regravar,
apagando e substituindo os eventos anteriores. Isso ¢ ideal para captar agdes esportivas, j4 que ¢ possivel iniciar a gravagdo a qualquer
instante e suspendé-la logo apéds o gol, “touchdown” ou qualquer outro momento de destaque. Vocé nao vai deixar de captar auge do
momento, ¢ também nao precisard procurar ou “rebobinar” um video anterior muitas e muitas vezes até encontrar o que descja ver. As
duragoes de loop disponiveis sao 8, 15, 30 ou 60 segundos. Quanto maior a resolugdo e nimero de quadros por segundo, mais curto
ele serd. No modo Replay (Reprodugdo) o contador indica o tempo de gravagio total disponivel (em segundos) ao ser parado, e conta
de zero até o final do limite de tempo do loop quando inicia a gravagao. No final do loop, quando reiniciar a gravagao, o contador
volta automaticamente ao zero e comega novamente. Observe que, se vocé interromper a gravagio durante um novo loop, o video
conterd parte do segmento do loop anterior e a primeira parte desse novo loop — a cimara sempre salvard os 8, 15, 30 ou 60 segundos
completos dos eventos mais recentes. Experimente e pratique um pouco o modo replay para ver COMO ele funciona antes de vocé
ir para aquele jogo tao importante!

3) Pressione o botao LCD/Mode caso queira verificar o video logo apés filmd-lo. Pressione a Seta para baixo para iniciar a reprodugao
e aperte-a uma segunda vez para interrompé-la. Pressione as setas Para a esquerda ou Para a direita para ver os arquivos anteriores de
fotografias still ou videos. Pressionar a seta no topo exibird uma imagem “reduzida” de arquivos multiplos — use as setas para destacar o
arquivo desejado e apds pressione Menu/OK para selecionar e ver esse arquivo. Pressione o botao LCD/Menu quando estiver pronto
para retornar ao display ao vivo e filmar outros videos (ou tirar fotografias).

4) Consulte a se¢io “Menu de visualizagdo” para obter maiores informagées sobre como visualizar e remover videos filmados anteri-
ormente.
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Como usar o Menu Principal

Como mencionado anteriormente neste manual, o Compact Instant Replay j4 vem configurado com as mais elevadas
resolugdo e qualidade disponiveis ao sair da caixa. A exposicdo, equilibrio de branco e outras varidveis sdo configuradas
automaticamente. Isso significa que vocé obterd bons resultados para a grande maioria dos objetos e condigoes de
iluminagio sem a necessidade de entrar em menus e de mudar configuragoes. Entretanto, recomendamos a familiar-
izagao com as opgdes disponiveis para melhorar a qualidade das fotografias. Por exemplo: se pensar que estdo muito
escuras (comum na maioria das cAmaras quando hd presenca de neve) ou muito verdes (sob luzes fluorescentes). O
menu principal, ou de gravagio, é organizado em seis grupos. Pressione o botdo “Menu/OK” para ver esses grupos.
Use as setas para cima e para baixo a fim de selecionar um grupo. Em seguida, use a seta para a direita e setas para
cima/para baixo para ver os itens ou opgdes disponiveis no interior do grupo. Eis uma descrigao geral dos grupos de
menu e de suas funcoes:

Como usar o Menu Principal

Grupo do menu | Icone Finalidade

Grupo do menu | Icone Finalidade

Permite selecionar fotografia still ou um dos dois modos de operagio de video
n (filme). As op¢des de menu sempre indicam os dois modos que nio estio em
uso no momento. Por exemplo: quando vocé estiver no modo de video “Re-
play”, as outras opgoes serdo exibidas no menu da cimara: modo de fotografia
@ still (icone da cAmara) ou modo de video normal (icone da cAmara de video
com seta reta).

Modo da cAmara

Setup (Configu- Oferece opgdes de configuragio para: resolugao (tamanho do arquivo), quali-
ragao) @ dade (compressao do arquivo), EV (valor da exposi¢ao), WB (equilibrio de
branco) e ISO (sensibilidade a luz).

Formatar Prepara o cartdo de meméria SD novo ou previamente usado para o uso.
Apaga (remove) todos os arquivos contidos no cartdo. Pode ser usado para
remover todo conteddo da memdria interna com rapidez, se um cartdo SD

nio tiver sido inserido.

Sair Sai do menu principal e retorna & imagem de visualizagao ao vivo.

Exposi¢ao Oferece opgdes para configuragap dp WB (Equilibrio de branco) e EV (Val-
| l:‘ or de exposi¢ao), melhorando a qualidade de cor e exposigao para diferentes

condig¢bes, quando as configuragdes automdticas nao produzirem a qualidade
ou resultados desejados.

Modo . . Permite selecionar “Cenas” pré-configuradas que otimizam os ajustes da cimara
,”:\ para fotoFraﬁas de agbes esportivas, paisagismo e outras. As opg¢oes de foto-
grafias still com seqiiéncia répida e auto-temporizador estdo também incluidas

B nesse menu.
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As préximas pdginas oferecem uma lista completa de todos os itens e configurages disponiveis nos grupos do Menu
Principal, incluindo as descri¢oes de suas fungdes. Siga os mesmos procedimentos usados no exemplo acima para se
movimentar pelas telas de menu a fim de destacar e mudar quaisquer configuragoes segundo suas preferéncias ou ne-
cessidades. O menu de visualizagao ¢ diferente, embora mais simples, contendo apenas quatro grupos (Show de slides,
Remover, Editor e Sair). Consulte a se¢do “Menu de visualizagio” encontrado nas préximas pdginas desse manual

para uma descrigio completa.
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Sistema do Menu Prlmlpul (As configuragdes padrao aparecem em Negrito)

Sistema do Menuv Principal continvacio

*As configuragoes de cenas e seqiiéncias no “Modo” nio se dispontveis quando a “eémara” estiver configurada no video Replay ou Normal.
Grupo Item Configuragdes Descrigao
CAMARA Fotografia still Icone da cimara Fotografa imagens de 3.2 megapixel
Clipe de video Video normal Filma um video contfnuo padrao, sendo que o tempo fica limitado apenas pela
(Icone filme com seta quantidade restante da meméria interna ou no cartao SD.
reta)
Video Replay (Icone de Filma “loops” de videos, regravando sobre o video anterior. Os loops tém
filme com seta circular) duragio fixa (de 8 a 60 segundos), variando de acordo com a taxa de quadros
(EPS) e resolugio do video.
EXPOSI(;AO WB (Equilibrio Auto (Automdtico) O White Balance (Equilibrio de Branco) ¢ configurado automaticamente para

de branco) a reprodugio correta das cores
Luz do dia Configuragao manual para ambientes ao ar livre, em dias ensolarados
Lampada Configuragdo manual para iluminagio interna de limpada com filamento de
tungsténio
Fluorescente Configuragao manual para iluminagio interna com limpadas fluorescentes
Nublado Configuragdo manual para condigoes externas nubladas ou com sombras
EV -2.0 - +2.0 Fornece ajuste manual de exposi¢ao insuficiente/excessiva em incrementos de

0.5 EV. Os valores negativos produzem fotografias mais escuras, os positivos
fotografias mais claras.
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Grupo || Item Configurages || Descrigao
MODO Cena * Programa Exposi¢ao automdtica padrao para fotografar/filmar a maioria dos objetos ou uso geral
Esportes Usa velocidades mais elevadas do obturador para ajudar a “congelar” o movimento
Paisagismo Zonas mais profundas de foco para nitidez superior do plano de frente ao plano de fundo
Retrato Zona de foco superficial para fotografias de pessoas — ajuda a isolar o elemento fotografado/filmado
do plano de fundo.
Noite Usa velocidades mais baixas do obturador para melhorar as exposicées em condiges de baixa luminosidade
Self Timer Yes (Sim) / No A fotografia ¢ tirada com um perfodo de atraso apés o botao Snap ser pressionado
(Auto-tempori- | (Nao)
zador)
Seqiiéncia * 3 ou 5 disparos | 3 ou 5 quadros tirados em uma seqiiéncia répida quando Snap ¢ pressionado
SETUP Tamanho/ Tamanho 3 opgoes de tamanho da imagem: L(2048x1536 pixels), M (1600x1200 pixels) ou S (640x480 pixels).
(CON- Qualidade da imagem As configuragoes de maior resolugao produzem impressoes maiores e mais nitidas, mas reduzem o
FIGURA- | (Fotografia (resolugao) espago de armazenamento total disponivel. Use as configura¢des menores para poder armazenar maior
CAO): still) quantidade de fotografias na memoria, ou para e-mails, etc. L=3.1MP / M=2.1MP / §=0.35MP
Qualidade Configura a quantidade de compressao do arquivo jpg. Configuragoes: Superior—FQ (compressao
(Taxa de 1:4), Normal-NQ (1:8) e Econémica—EQ (1:16) Isso pode ser usado independentemente do
compressio do tamanho da imagem para ajudar a armazenar maior nimero de fotografias, porém de qualidade
arquivo) um pouco inferior.
Apenas no Qualidade 640x480 pixels por quadro (Resolugao)> a 30 ou 15 quadros por segundo (Taxa de quadros)
modo de video | (Resolugio e 320x240 pixels por quadro >a 30 ou 15 quadros por slefundc (Depois de selecionar a resolugio,
Normal FPS) pressione a Seta para a direita a fim de selecionar a taxa de quadros (fps))
Apenas no Qualidade 640x480 pixels por quadro (Resolugao)> a 30 ou 15 quadros por segundo (Taxa de quadros)
modo de video | (Resolugao e 320x240 pixels por quadro >a 30 ou 15 quadros por segundo
Replay FPS) Loops com duragio de 8, 15, 30 ou 60 segundos dependendo da resolugao/fps
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Sistema do Menu Principal continvagio

Grupo Item Configuragdes | Descri¢cao
Data Setup (Configu- | Permite configurar a data/hora correta de sua drea. Se “On” (Ligado) estiver selecionado, a data
ragio), aparecerd no display e em todas as fotografias impressas.
On (Ligado) /
Off (Desligado)
Armaze- Auto (Au- Os arquivos sao armazenados no cartio SD, quando inserido, ou na RAM interna
namento tomadtico)
SD Os arquivos s3o armazenados somente no cartdo SD (deve estar inserido)
Interna Os arquivos sdo armazenados somente na meméria interna, nunca no cartio
Idioma H4 7 dis- Seleciona o idioma de sua preferéncia para todas as telas do display
poniveis
Tempo de Desligado/1-3 Seleciona o tempo limite de exibi¢ao automdtica apds ser tirada a fotografia
exibicao segundos
Nome do Restaurar/Série | Configura o sistema de numeragao de arquivos. Ao selecionar Reset (Restaurar), apés todos os
arquivo arquivos da memdria interna ou do cartao forem removidos, os ndmeros dos arquivos de novas
fotografias reiniciardo de “000”. Ao selecionar Series (Série), os nimeros dos arquivos para as
novas fotografias recomegario a partir do dltimo niimero usado para os arquivos anteriores.
Bipe On (Ligado) / Liga ou desliga o som de alerta do bipe
Off (Desligado)
Restaurar todos | Yes (Sim) / No Selecionar “Yes” (Sim) restaura todas as configuragdes ao seu padrio original (indicado em negrito)
0)
FORMAT Formatar Yes (Sim) / No Formata o cartao para os arquivos do Compact Instant Replay. Apaga todo seu contetido.
(FORMATAGAO) (Nio)
EXIT (SAIR) Sai do sistema de menu e retorna 2 visualizagio ao vivo
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Review Display Icons

# | Ieone

Data do arquivo de fotografia ou video (O recurso de data deve estar configurado ¢ ligado)

Local do arquivo que est sendo visualizado (memdria INterna ou cartio SD)

Resolugao do arquivo sendo visualizado

Qualidade (compressio) do arquivo sendo visualizado

Niimero do arquivo atual (numeral da esquerda): Arquivos totais na meméria (numeral da direita)

Indica o tipo de arquivo (Fotografia still, video normal, video replay)

BN RN U VS RSCR [NNEY

Indicador de carga das pilhas

Menvu de visvalizacéio
Como visualizar e remover fotografias e videos

Pressione “LCD/Mode” para entrar no modo Review (Visualizagao). Use as setas Para a esquerda/Para a direita para
passar pelas fotografias/videos armazenados. No modo visualizago, pressionar o botao Menu/OK acessard o con-
junto de menus de visualizagdo. Isso funciona da mesma forma descrita anteriormente nas instrugoes do sistema de
menu principal (use as teclas de setas para navegar ao grupo do menu opgoes desejado, pressione OK para confirmar
a configuragdo), porém com diferentes itens de menu, como indicado abaixo:

Grupo Item Configurages ‘ Descrigao

SHOW DE Yes (Sim) /| Selecionar “Yes” (Sim) comegard a mostrar todas as imagens

SLIDES No (Nio) atualmente armazenadas na meméria interna ou cartio, mudando
automaticamente para a préxima imagem a cada poucos segundos.
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Menv de visvalizac¢@io continvacio

Grupo Item Configuragdes Descri¢ao
DELETE Remover | Yes (Sim) / No | Remove da meméria a fotografia ou video atualmente exibido. Use as setas
(REMOVER) | um(a) (Nao) para cima/para baixo para encontrar o arquivo a ser removido. Para remover,
destaque o icone “Delete One” (Remover um(a)) e pressione “OK”. Em
seguida, destaque “Yes” (Sim) e pressione “OK” para remover o arquivo.
Remover Yes (Sim) / No Remove todos os arquivos armazenados. Para remover todos os arquivos (ex-
todos (as) | (Nao) ceto aqueles bloqueados — veja abaixo) destaque o icone “Delete All” (Remover
todos(as)) e pressione “OK”. Em seguida, destaque “Yes” (Sim) e pressione
“OK” para remover todos os arquivos atualmente armazenados na meméria.
EDITOR Proteger Bloquear / O bloqueio de uma fotografia ou video evita que seja apagado acidentalmente.
Desbloquear Isso pode ser usado com “Remover todos(as)” para rapidamente remover todas
as fotografias, exceto uma ou duas. Para bloquear a fotografia ou video atual-
mente exibido, destaque o icone “Lock” (Bloquear) e pressione “OK”. Para
desbloquear um arquivo previamente bloqueado, selecione o arquivo usando
as setas Para cima/Para baixo, destaque novamente o icone “Lock” (bloquear)
e pressione “OK”.
Girar -90 graus ou Gira a imagem atual em 90 graus, no sentido determinado.
+90 graus
EXIT (SAIR) | Sair Sai do menu e visualizagdo e retorna 2 dltima imagem selecionada para a
visualizago.

Requisitos do sistema (minimos)

Sistema operacional: Windows® 98/98SE/2000/ME/XP

Unidade Central de Processamento: Equivalente a0 MMX Pentium® 200MHZ ou mais répido (Pen-
tium® III 500 MHz para o PhotoSuite5™)

Meméria: minima de 32MB (recomenda-se 64MB para o PhotoSuite)

Placa de video SVGA ¢/2MB VRAM, tela de 800x600, cor de 16 bits, alta densidade

Espago disponivel no disco rigido 200 MB (no caso de instalagiao do PhotoSuite)

Porta USB interna

Instalaciio do Software

Se o seu computador estiver rodando o Windows 98, os drivers devem ser instalados antes de conectar a cAmara ao
PC. Insira 0 CD-ROM na unidade de CD do computador; ele executard automaticamente e a tela de instalagao
serd exibida. Selecione “Install Driver” (Instalar Driver) e siga as instrugdes. Reinicialize o computador apds a
instalagdo. Os sistemas operacionais Windows 2000, ME e XP nio requerem os drivers, pois a cAimara usa armaze-
namento de massa USB padrdo, permitindo acessar os arquivos de fotografias como se estivessem armazenados em
um disco rigido externo. Para qualquer sistema operacional Windows, se vocé ainda nio estiver usando um software
de edigdo de fotografias de sua preferéncia, é possivel instalar o Roxio PhotoSuite®, encontrado no CD-ROM.
Nao deixe de ler todas as “Notas de versdo” e observe todas as dicas ou possiveis problemas relevantes associados a
configuragao de seu PC e sistema operacional.

Como transferir fotografias e videos ao PC - Etapa por etapa

1. Nio esquega de instalar o driver antes, caso esteja rodando Windows 98/98SE.

2. Nio esquega de ligar o Instant Replay e conectar o cabo fornecido entre a porta USB da cAmara (abra a tampa
do conector no lado esquerdo do Replay) e diretamente na porta USB principal do computador — ndo use portas
USB do teclado/painel frontal ou “hubs” nao energizados.

3. O display LCD desligard para conservar a carga das pilhas e o Instant Replay serd reconhecido como um
dispositivo de “Armazenamento de Massa USB” padrio. Isso significa que os arquivos da cAmara podem ser
facilmente visualizados, editados ou copiados para o disco rigido, com se estivessem armazenados em uma unidade

rigida externa ou em CD-ROM.
139

Download from Www.Somanuals.com. All Manuals Search And Download.



Como transferir fotografias e videos ao PC - Etapa por etapa continvacio

4. (Essa etapa ndo ¢ necessdria com o Windows XP. Simplesmente use as opgoes que aparecem na tela para visualizar,
copiar ou editar suas fotografias). Abra 0 Meu Computador ou o Windows Explorer. A cimara aparecerd como
um novo “Removable Disk” (Disco Removivel), com uma letra de unidade previamente nio utilizada designada
a ela. Clique duas vezes neste novo fcone do “Disco”, abra a pasta “DCIM” e apés a(s) pasta(s) em seu interior
(“100BNxxx” ,etc). Suas fotografias/videos sdo os arquivos no interior — com o prefixo “PICT__” seguido de um
ntmero, da mesma forma como visto anteriormente no display da cimara durante a visualizagio de fotografias.
Clicar apenas uma vez em cada arquivo mostrard uma pequena imagem.

5. Clique em “Edit>Select All” (Editar>Selecionar Todas) (ou clique em uma fotografia, control+clique para selecionar
fotografias multiplas) e depois “Edit>Copy to Folder” (Editar>Copiar para Pasta) nos menus do Windows. Selecione
uma pasta existente no disco rigido, tal como “Minhas figuras” ou crie uma nova pasta (“Férias no Havai”, etc) e
clique em “OK” para transferir cépias dos arquivos de fotografias desejados.

6. A cAmara poderd ser desconectada depois que as fotografias estiverem transferidas para o disco rigido. O Windows
2000 poderd apresentar uma adverténcia na tela, caso um dispositivo USB tenha sido desconectado sem antes parar
ou ejetar o “disco” (os arquivos de fotografias nao serdo prejudicados). Neste caso, verifique a caixa que adiciona um
{cone para a barra de tarefas ou bandeja do sistema. A préxima vez que vocé concluir a transferéncia das fotografias,
poderd clicar neste {cone primeiro e “Parar o Dispositivo de Armazenamento de Massa USB” antes de desconectar

a cimara.
Nota: Caso o PC ndio reproduza arquivos de filmes .avi no Windows Media Player, vocé pode baixar
uma versio mais nova do Media Player ou Direct X em Microsoft.com. Os arquivos de filmes tam-
bém podem ser reproduzidos utilizando o QuickTime Player, incluido em muitos computadores, ou
dispontvel gratuitamente para download em Apple.com.
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Como transferir fotografias e videos ao PC - Etapa por etapa continvacio

7. Agora voct jd pode abrir os arquivos de fotografias em qualquer software de edigio apropriado. Basta usar
em Arquivo>Abrir e ir até a pasta onde suas fotografias foram previamente armazenadas. Caso esteja usando o
PhotoSuite, selecione Arquivo>Abrir Foto ¢ em seguida o menu suspenso “Examinar em” na parte superior da
janela aberta, selecione “Meu computador”, selecione seu disco rigido e clique duas vezes em qualquer fotografia
na pasta onde os arquivos da cimara foram copiados. Pode-se também abrir e trabalhar com as fotografias
diretamente do Instant Replay, enquanto ele estiver conectado. Para fazer isso com o PhotoSuite, primeiro
execute as ctapas 1 a 3, depois abra o PhotoSuite, selecione Arquivo>Abrir Fotografia e use o menu “Examinar
em” para selecionar Meu Computador, selecione “Disco Removivel” e abra as pastas até chegar nos arquivos
de fotografias JPEG. Se optar por trabalhar dessa forma, de uma cimara conectada, nao esqueca de salvar a
fotografia (ap6s concluir a edigdo) para o disco rigido e nao para a memdria da cAmara ou cartdo. Para fazer isso no
PhotoSuite, apds clicar em “Concluido”, responda “Yes” (Sim) & pergunta “Save Changes?” (Salvar alteragoes?),
mas “No” (Nao) a pergunta “Replace Existing File?” (Substituir arquivo existente?), e use a caixa de didlogo
“Salvar como” para salvar a fotografia editada em uma pasta no disco rigido (“Salvar em>Disco local”), ndo no
“Disco removivel” (cAmara).

8. Caso nio tenha muita experiéncia com edigio de fotografias no computador, consulte o menu de Ajuda do
software (o PhotoSuite conta com um abrangente recurso de Ajuda) para obter dicas sobre o uso de seus recursos.
Além do ajuste do brilho, contraste, nitidez e cor das fotografias, é possivel redimension4-las para que caibam no
papel usado para a impressao, ou salvar o arquivo em uma versao com resolugao menor para e-mail ou insergao
em documentos. Quando estiver pronto para salvar o arquivo editado, vocé pode usar “Salvar como” e atribuir
um nome mais descritivo do que “100BN___". Ao fazer isso, estard preservando o arquivo original como backup
para abrir e editar posteriormente. Certifique-se de que todas as fotografias desejadas foram transferidas com éxito
antes de usar “Deletar Todas” na cAmara para abrir espago para novas imagens.
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Tamanho da
imagem

Megapixels
(aprox.)

Quali-
dade*

Memdria
interna*™*

Cartao SD
de 64 MB

L 2048x1536

3.1

FQ

15 fotogra-
fias

60 fotogra-
fias

NQ

31

124

EQ

62

248

M 1600x1200

2.1

FQ

25

100

NQ

51

204

EQ

102

408

S 640x480

0.35

FQ

160

640

NQ

321

1284

EQ

642

2568
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Referéncia da capacidade de armazenamento de fotografias (capacidade mdxima, +/- 2 fotografias)

* Seleciona a quantidade de com-

pressao do arquivo (taxa ipg)
(FQ=baixa/EQ=alta)

FQ: Qualidade superior (1:4)

NQ: Qualidade normal (1:8)
EQ: Qualidade econdmica (1:16)

**RAM interno disponivel para
arquivos de fotografias: 16 MB

O tamanho da imagem se refere
as dimensoes (pixels) ou resolugao
do arquivo digital.

A capacidade efetiva de arma-
zenamento varia de acordo com

o contetido de cada arquivo

de fotografias. Talvez seja pos-
sivel tirar algumas fotos a mais ou
menos do que a capacidade média
relacionada.

Use configuragdes de maior
tamanho e alta qualidade para

as fotografias que vocé planeja
ampliar ou aparar. Se necessdrio,
elas poderdo ser reduzidas para
um tamanho menor de arquivo
usando seu software de fotografias.
Use tamanhos menores e/ou
configuragdes de qualidade mais
baixas se vocé planeja enviar por
e-mail, inserir em documentos ou
fazer impressées de pequenho ta-
manho e ndo deseja redimensionar
0 arquivo posteriormente.

Al

GARANTIA LIMITADA DE DOIS ANOS

Garantimos que seu produto Bushnell® estard isento de defeitos materiais e de
fabricagao. por dois anos apés a data de aquisi¢ao. Caso tenha algum um defeito sob esta
garantia, iremos a nossa opgao, consertar ou trocar este produto desde que o produto
seja devolvido com porte pago. Esta garantia nio abrange danos causados por uso
indevido, operagao, instalagdo, ou manutengao incorretas efetuadas a nao ser que seja
do Departamento do Servi¢o de Manutengio Autorizada da Bushnell.

Qualquer devolugio efetuada sob esta garantia deve incluir os itens relacionados a
Seguu’:

1) Um cheque/ordem de pagamento no montante de $10,00 para cobrir as
despesas de porte e gastos administrativos

2) Nomee en(ﬁrego para a devolugao do produto

3) Uma explicagio do defeito

4)  Comprovante da Data de Aquisicio

5) O produto deve ser cuidadosamente embalado, numa caixa de papelio
resistente para prevenir danos enquanto em trinsito ¢ enviado para os
enderecos indicados a seguir com porte de devolugio pago:

NOS EUA REMETER PARA: NO CANADA REMETER PARA:
Bushnell Performance Optics Bushnell Performance Optics
Attn.: Repairs Attn.: Repairs

8500 Marshall Drive 25A East Pearce Street, Unit 1
Lenexa, Kansas 66214 Richmond Hill, Ontario L4B 2M9

Para produtos adquiridos fora dos Estados Unidos ou do Canad4 favor contatar seu
revendedor local quanto a informag6es aplicdveis referentes a sua garantia. A Bushnell
também pode ser contatada na Europa pelo telefone:
BUSHNELL Performance Optics Gmbh

European Service Centre

MORSESTRASSE 4

D- 50769 KOLN

Alemanha

Tél: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

Esta garantia Ihe dd direitos legais especificos.
Poderd ter outros direitos que podem variar de pais para pafs.
©2005 Bushnell Performance Optics

“Vanuats-Searc And-Downtoad:

Nota da FCC:

Este equipamento foi testado e verificou-se que cumpre
com os limites para um dispositivo digital Classe B, de
acordo com a Parte 15 das regras da FCC. Esses limites
sao estabelecidos para oferecer protegdes adequadas
contra a interferéncia prejudicial em uma instalagio
residencial. Este equipamento gera, usa e pode irradiar
energia de radiofreqiiéncia e, se nao for instalado e usado
de acordo com as instrugtes, poderd causar interferéncia
prejudicial nas radiocomunicagées. Entretanto, nio hd
garantia de que nio ocorrerdo casos de interferéncia em
determinadas instalacGes. Se este equipamento causar
interferéncia prejudicial na recepgio de rédio ou televisao
(a qual poderd ser determinada ligando-se ¢ desligando-se
0 equipamento), tente corrigir o problema adotando uma
ou mais das medidas seguintes:

- Reoriente ou mude o lugar da antena receprora.

- Aumente a disténcia entre o equipamento e receptor.

- Conecte o equipamento em uma tomada que faga parte de
um circuito diferente daquele onde o receptor se encontra
conectado.

- Consulte um representante ou um técnico experiente em
rddio/televisio para auxilio.

O cabo de interferéncia blindado deve ser usado com
0 equipamento para cumprir os limites de dispositivo
digital segundo a Sub-parte B da Parte 15 das Regras da
FCC.

Projetos e especificades estao sujeitos a mudangas sem
aviso prévio ou obrigagio por parte do fabricante.

€
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